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Foreword

Landscape Architecture is in an age of enlightenment, and this is especially true with regards to modes and processes of communication. Digital tools have revolutionized landscape practice. They have provided designers with powerful new methodologies which are being used to analyze, to solve, and to express. In recent past, ‘toolkits’ included markers and colored pencils, and design process was a slave to the limitations of the orthographic. Today’s designers are still using analog tools as a primary methodological process. These tools are, of course, invaluable to support collaborative and exploratory techniques. They allow rapid exploration, and the development of multiple iterations at light speed; ‘hands and minds’ will always move much more quickly than a ‘mouse’. Often, analog and digital are combined and form a hybridized method, the use of digital mapping, aerials and analyses that inform markings made on trace paper. Yet this process is often subject to the limitations of the 2-D, and often has limited productivity and applicability to the shifting dynamics of the cities, infrastructures, and environments in which we operate.

In the past 10 years, we have witnessed an emergence of more synthetic methodological and representational processes. This revolution has been in full swing, inspired by an engagement with process-based thinking that has provided us with the digital diagram, the temporal index, mappings, and the ubiquitous Photoshop montage. Digital computation has provided us with tools and collaborative potentials to process, analyze, model, and even simulate the complex information available for a given site, region, or planet. We can bring our sketches and markings with ease into a 3-D program and we can extrude, spatialize, pre-visualize, animate, and measure. Landscape practice has broken through the confines of the orthographic and has entered into the realm of the cinematic and interactive. At present, the increasing use of parametric, building information modeling (BIM), mapping and spatial analysis (GIS), and sustainable site design software (Ecotect) will further revolutionize design practice, as it increases both our productivity and our relevance. Landscape architecture, in particular, engages with complex data and systems dynamics. Our medium grows, flows, erodes, breathes, and moves. Further, it is a practice that is uniquely poised to leverage the potentials of new forms of digital media to address the complexities of the landscape medium. This is also a challenging time, and in some regards, a time of representational and methodological crisis for the spatial disciplines. The rise of digital formalism, of complexity for complexity’s sake, and of the loss of authorship that is the consequence of allowing these tools to “use you”. This has lead to the ice cold and sanitary diagrams, the ‘any-town’/’any-ecology’ montage, the mind bending and meaningless vector fields, to name a few. For today’s spatial disciplines that are exploring digital computation, I believe that these are simply the growing pains. We are beginning to also see unique and experimental forms of expression, new identities are emerging which are taking digital media beyond the role of representation to that of generation and collaboration.

Our office uses different digital media and processes for different project types and scales. What is common to our design process is the initial search for the conceptual core of the given challenge. This search may begin with site analysis and context, but also can include history/ethics/emotion/pop culture/imagination.

This core concept is aggressively pursued, and is more often the product of discussion and debate, than drawing. Once a concept or direction is set, we use digital tools to develop and to test the idea and its associated spaces. In the past, the creation of 3-D modeling was more tied to persuasion, to sell an idea. Today, we use 3-D digital modeling in everything we do, to test ideas and spaces, and is therefore an integral part of the design process. Often, after the core concept has been established, we will establish narratives for the images that we create. What is that girl really doing in that scene? Why is that bird flying so close to that man’s head? Why is Kurt Cobain smashing that guitar? Are those sharks mating? Narrative and storytelling are two ways that we can infuse both reality and fantasy into image making. This has been one effective way to create images that are not generic, but have humor and speak to users in a meaningful way. We also think specifically about mood and atmosphere. Is it a scene at dusk, in autumn, is the sky heavy with water? Sometimes we search for representative images which convey the ‘mood’ or ‘emotion’ of the image we wish to create, these might be an album cover or a work of art. This can then establish a palette and graphic rule set to guide the work. It is important to be accurate in our representations, but not to be too overly determined or clinical. It is the clinical image, which is often subject to undue scrutiny; rather, we want to pull the viewer into the fantasy and to elevate the design from reality to some degree. It is interesting that with all of this analytical and generative potential, a project is often evaluated based on the perspectival ‘image’ or “money shot”. This has often been the irony of landscape representation, that something so dynamic and complex needs to be summarized spatially and singly for a lay-person be it a client, design jury, or government agency. That said, our audiences are becoming more digitally literate and more visually sophisticated. They are also becoming more demanding in terms of project performance, and more able to digest the complex representations that come with those demands.

This book is crucial introducing students and professionals to a wide range of technologies and methodologies for representing the natural and the built environment. More subtly, and when wielded with care, it can provide a basis for the development of new individual or collective forms of ‘expression’, of measurement, virtuosity, fantasy, and humor.

David Fletcher ASLA, RLA

Founding Principal

Fletcher Studio





Preface

Many approaches to modeling in architecture and landscape architecture assume that the landscape is an object and therefore something that we can give form to through the creation of surfaces. Modeling the Environment assumes we will need to model objects but focuses on the creation of virtual environments and the elements that allow us to perceive rich temporal and ephemeral spaces. The content has evolved over the past six years during my teaching and research at the Louisiana State University Robert Reich School of Landscape Architecture (RRSLA). Modeling the Environment examines our digital tools not only in terms of how we represent designed form but also in terms of how we perceive this information and how we allow others to understand our designed environments. 

Early stages of this book imagined presenting a wide variety of software and digital tools that would be used to model and/or represent a broad spectrum of environmental situations. Through several iterations, we determined that we would focus on a smaller set of software for clarity but make sure that we presented the same variety of environmental factors. We decided to examine techniques using tools that we are currently teaching at RRSLA: Autodesk 3ds Max, Autodesk Composite, Autodesk AutoCAD, and Adobe Photoshop. Autodesk 3ds Max is the primary tool used within this book because of its ability to accomplish nearly every task—modeling, materials, lighting, dynamics, and animation. There are very few software packages that can accomplish as much as 3ds Max; the only rivals are Autodesk Softimage, Autodesk Maya, and, possibly, NewTek LightWave.

The full suite of tools available in high-end modeling software is necessary as we begin to explore the possibilities available to model, render, and animate complex environments. To explore this area of representation, we must dedicate ourselves to understanding software that provides tools to animate temporal phenomena or simulate physical processes. Autodesk 3ds Max is exceptional in nearly all of these areas and is a tool that is perfectly suited for integration into a typical office work flow. 

There are many different types of modeling software that attempt to fill voids in niches of the design market. Google SketchUp is a fantastic conceptual modeler that has very quickly become the predominant tool in many design offices. SketchUp is cheap (it’s hard to argue with a free version), and facility with the modeling of basic surfaces and forms is easily achieved. The software is readily accessible, and it is understandable why so many firms are using it on a daily basis. McNeel Rhinoceros is another software package that fits into this category, although Rhino is a much more powerful modeler than Google SketchUp. Rhino is possibly a better modeler than many other, more powerful software packages such as 3ds Max and Maya; however, it lacks the full tool set needed to create physical materials, lighting, animation, or dynamics. The pros and cons can be debated infinitely without clear winners, and this is why the field of choices is so broad. 

Modeling the Environment attempts to fill a void in current representation texts by concentrating on modeling and animation tools solely for the creation of environments. This is accomplished through six distinct modes of thinking that focus on scene, object, terrain, environment/atmosphere, time/dynamics, and the composite. The organization of this book implies that environments are temporal and atmospheric, and that they are composed of objects within surfaces; thus, to understand them, we must develop our scenes through composite methods. The complexity of environments often asks that we render the unknown and shift between modes that allow us to render high-fidelity and low-fidelity systems simultaneously. The sections are intended to build upon one another to enable an understanding of the environment as a composite representation of multiple systems interacting. 

Part 1 of Modeling the Environment introduces readers to the breadth and scope of environmental representation beyond landscape architecture and site planning. This includes the film and special effects industries, graphic design, and illustration. The purpose is to situate landscape or environmental representation within a larger context of work that focuses on building a coherent landscape narrative through visual media. From this discussion, we expand the theoretical framework by introducing concepts surrounding new media, including the purpose of craft in virtual workspaces and how they pertain to design heuristics. This sets the stage for discussing the differences among illustration, representation, and simulation, and how each is used in current design practice.

Understanding that the scene is a composition of views and/or staging of the “set” introduces readers to digital landscape representation and the virtual workspace. Part 2 focuses on the significance of the camera in modeling and illustrating environments, both as a passive viewport and as an actor that moves through the landscape. Readers are introduced to basic photographic and film principles, including shot types, camera movements, and lenses. 

The object or device in the landscape represents a broad group of elements present in nearly every rendering. Part 3 discusses methods of modeling objects in the landscape and may include architecture, site features, or other elements not specifically constituting the environment. The object is separated from the surface and atmosphere in order to delineate the role of each. This section also introduces a range of typologies and how they may be represented. The categorization looks at how we model complex vegetation as well as constructed elements such as walls and site furnishings. Beyond understanding how objects are represented, we stress that the object’s representation is successful when it has an appropriate relationship to the environment (shadows, intersections, etc.). Readers are introduced to methods of modeling such as polygon and NURBS modeling and how each creates specific models and surfaces. This section also focuses on using sketches and/or images as a method to begin the creation of objects that will populate an environment. 

The environment typically contains a large, continuous surface that may be biotic or abiotic and is described as a vertical or horizontal datum that represents earth, terrain, and/or topography. Part 4 defines surface types and terrain typologies, as well as discussing methods of creation. This includes the construction of terrain models, particularly surface, TIN, and mesh models in 3ds Max. Terrain models are discussed as a representation of data and how that data can be manipulated to illustrate the surface and its constituent properties: slope, aspect, hydrology, and strata. This is the landscape architect and site planner’s equivalent of BIM (building information modeling); the data model is constructed and then examined to query the needed illustrative or analytical information. Readers are introduced to the concept of data as a representation and analysis framework. This part also discusses materials as a method to illustrate surface, as well as techniques to distribute objects across surfaces to represent vegetation (grasses) and other details. 

Atmosphere affects our perception of objects and surfaces and can be used to represent a sequence or moment in time, weather, and/or context. It is necessary to explain how color and lighting are used to generate mood and introduce similar methods in film. Readers are introduced to concepts of depth and how atmosphere can enhance this illusion. Part 5 examines basic and new methods to accurately represent lighting conditions and weather in 3ds Max. We also explore how animated atmospheres can be used to illustrate the passage of time.

Current software creates a mixture of representative and simulated elements that verge on real-world modeling and illustration. Part 6 concerns animation and dynamics, exploring the current state of software and how it rests between these two realms (illustration and simulation). We highlight animation tools and how these tools are used to convey motion, change, and ephemeral atmospheric phenomena. This part looks at multiple methods used to create rigid- and soft-body simulations, particle systems, and fluid dynamics. 

Part 7 deals with the composite environment by examining the tools that can be employed to develop a variety of illustrations and/or animations. This discussion of composites combines each of the previous chapters to create compelling representations that convey environments as spaces we can experience or illustrations that communicate dynamic processes. 

Modeling the Environment expresses a view of digital tools that is unique to the site planning and landscape architecture professions. Because of the complexity of the material in many cases, it is possible only to scratch the surface. The text highlights a clear methodology, and the tutorials are intended to then allow designers to quickly accomplish basic modeling, rendering, or animation techniques directly related to the environment.

This book is intended to be understood in a linear sequence, but more advanced users may find that they jump between chapters. The content gives an overview of 3d modeling tools but does assume some basic knowledge of digital tools, particularly CAD and image-editing software. Modeling the Environment should be used in conjunction with a basic text on Autodesk 3ds Max, as there are many very basic functions that are not discussed in this book. Modeling the Environment is not intended as a primer on digital media but instead is a framework for understanding how digital modeling can be used to further investigate and represent projects in site planning and landscape architecture. 

We look forward to seeing how the ideas in this book evolve and are expanded upon within the profession. Ideally, the content will enable many designers to jump-start their digital modeling skills and to understand how new media, particularly modeling and animation, can be harnessed to create richer virtual environments.
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Part 1

Introduction





Chapter 1

Overview of Media

Current Methods and Work Flows

The transition between analog and digital media has occurred within a tension that pushes and pulls against engrained knowledge and advances in technology or technique. The engrained knowledge is situated within known drawing types, rendering or modeling methods, and aesthetic preferences. Because each of these areas is an acquired set of knowledge, the ability for individuals or groups to move beyond the known becomes very difficult. Not only does it take a new investment in training and techniques, it also requires a readjustment of perceived and developed aesthetics. 

Currently, we are situated within a transitional state with digital tools taking the forefront in most offices. With this fact, it is also necessary for designers to have the ability to express their ideas fluidly using their respective medium. This puts practitioners in a precarious position, where they must understand both the technical skills of drawing and design computing while also grasping the aesthetic consequences of decisions in both. It is no longer efficient or smart to develop borders between media; we must be able to navigate the analog and the digital concurrently. These modes of design inquiry force us to contemplate the efficacy of each representation decision, and, therefore, design representation education becomes only partially about technical skills (analog and digital) but holistically about design heuristics. (See Fig. 1.1.)


Figure 1-1. A range of analog and digital drawings.
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So what choices do we have at this juncture? There are two ends to this spectrum where designers may choose to pull themselves into the digital media or into the “hand drawing” camp, setting up an either/or situation. This singular mode of thinking does not allow us to adopt new modes of inquiry, nor does it allow for the opportunity to use the best tools for the job at hand. Our current predicament situates designers along a tightrope and does not allow us to hold on to the supremacy of a single medium. Rather than relegating specific media to discrete tasks, it is important to more fully understand the underlying theory that allows for success in a broad range of visual media. Conceptually, this requires knowledge of the image-making process and how all the components come together to create a composite view of the environment. 

Pulling together a fluid work flow is a complex undertaking and requires an understanding of more than the superficial treatment of images. Designers are tasked with speculating upon and designing the construction of environments, landscapes, and structures that will transform the world we live in. This responsibility requires a series of representational tools that can be employed across a wide variety of situations, from concept generation to precise drafting to simulations to evaluate performance. These tools reside in a wide variety of analog tools, software, and digital fabrication techniques; therefore, it is necessary to construct a design work flow that builds on the strength of each tool. (See Fig. 1.2.)


Figure 1-2. Development of design concept with a composite of CAD and analog sketching.
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The content presented in this book intends to introduce designers to a methodology for landscape representation that is unique to the tools being discussed. This does not mean it is completely software specific but instead focuses techniques on image editing, drafting, and modeling. The techniques discussed primarily use software that is currently in design offices, such as AutoCAD, 3ds Max, and Photoshop. While the book requires the content to focus on software in order to present techniques that can be reproduced by the reader, the information is transferable to other drafting, image editing, and digital modeling software. Techniques may vary slightly, but the concentration remains on the way each step relates to the design process and the visualization or testing of design ideas. 

Adoption

Analog tools of precision drafting have slowly given way to digital tools that excel in editability, replication, and mobility. This process of change occurs through a series of factors: cost, reliability, ubiquity, and facility. These factors drive the acceptance of technologies into the design professions. While some firms will always be on the bleeding edge and others will lag behind, it is important to understand that a vast number of firms are driven by the practical necessity of accomplishing day-to-day tasks and that these four factors are key to the decisions they make when implementing new technologies. This does not take anything away from what these firms are accomplishing; on the contrary, it reinforces that their primary objective is to design and build environments. If the tools do not facilitate this objective, then they are not implemented or are phased out of design practice. 

The cost of technology typically drops over time until it becomes affordable to implement. This implementation takes place through direct costs to a firm or from billing the client for specific tasks that may require atypical technology support. It is important to understand this relationship between cost and technology: While a technology could or can accomplish tasks for a designer, if the technologies are not affordable, the application becomes limited. Typically, the highest costs have been associated with hardware; however, as computers are on the desks of nearly every profession, not just those of designers, the price of computer hardware has dropped tremendously. The largest expense for many firms comes in the form of software and specialized hardware such as input/output devices or plotters. (See Fig. 1.3.)


Figure 1-3. HOK Hong Kong, design office.
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Digital media are the de facto tool for representing the environment we live in and the world we fantasize or idealize. The past two decades have seen a shift from the dominance of analog media to the prevalence of computing to capture or illustrate ideas. While digital media are unrivaled in the production of illustrative imagery, there is a continuing discussion regarding our facility with digital and analog tools and how they affect our design methodologies. The ability to generate design solutions with digital tools is a perceived weakness that comes from a series of factors dealing primarily with the re-creation of analog processes in digital environments. 

The term “digital media” has slowly evolved into an antiquated description of contemporary illustration, animation, and simulation methods. In order to develop a work flow that facilitates the ability to generate design solutions with digital tools, it is necessary to understand how design drawings function within the overall process. Then, through understanding of the process and functions of design drawings, we can reexamine how digital media can support design methodologies beyond final representation. 

Reliance on Design Drawings

Design drawings, such as the plan, section, and constructed perspective, are the basis that we use to mediate between the physical world and measured, represented environments. This experience relies on the convention of a mediated method of drawing called an orthographic projection. The orthographic projection does not attempt to realistically represent the world around us but instead uses a drawing standard that focuses on precision when translating the representation to physical construction. While evocative, the orthographic plan and section require a level of training and exposure to understand and relate to the world we live in. (See Fig. 1.4.)


Figure 1-4. Louis Gateway Arch Grounds Proposal, St. Louis, MO; site plan.
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The constructed virtual world holds many of the same conventions, although reprojected within an interactive, real-time space. Digital modeling relies on the Cartesian grid and projects each axis (X, Y, Z) using coordinates to place elements within the 3D space. This convention is partially mathematical and representational to allow designers to have measurable spaces that relate directly back to the orthographic drawings from which this work has evolved. This evolution is necessary but also relegates new modes of thinking to current methodologies, often hobbling advancements that are introduced in the form of new tools. 

When working with design drawings, we typically rely on them to perform a documentational, supportive, persuasive, or discovery role within the design process. Ideally, these roles complement and extend one another, although in many aspects the drawings may serve a singular purpose within a larger design process. Each of these roles typically becomes blurred within a fluid design exploration, and there is often crossover, whereby a drawing that documents a construction technique may also be used as a way to illustrate experience or support a conceptual narrative. In either case, it is important to maximize efficiency across representation methods and to have a clear idea about how drawings or models evolve throughout the design process. 

“Design process” is an ambiguous term that requires some definition in order to explain the relationship between representation or simulation and each stage of design thinking. Generally, we are discussing a process and mode of thinking that attempts to synthesize a problem and provide a proposal that discovers and or addresses stated needs. For architects and landscape architects, the process usually consists of inventory, analysis, concept generation, schematic design, design development, and varying methods of construction documentation and administration. The design process is not a rule, and many designers have their own methods for approaching a design problem. While the process is often personal, it is almost always a methodology that progresses from being an undefined to a defined proposal. This goes beyond representation and is dependent on budgeting, consultant interaction, and client financing (economics); therefore, most design representation necessarily works toward further refining the design proposal in order to communicate clearly with everyone involved.

Understanding the design process requires some specific methods for working with representation. In the first stages of the design process, designers often use methods and processes that favor speed and variability. It is necessary to develop multiple possibilities that express a broad range of solutions in an attempt to home in on a single proposal. Conceptually, it will be necessary to use tools that favor precision and specificity the further a designer goes in the design process. While precision and stability define the later stages of the design process, there are always moments at which it is necessary to continually test and conceptualize the design at hand. It becomes a process of give-and-take in order to create an efficient work flow. Understanding different representation modes is important because they contain similar thought processes but may be implemented at early or late stages in the design process. (See Fig. 1.5.)


Figure 1-5. Brooklyn Bridge Park grading plan.
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Testing, prototyping, and conceptual development are key areas of the design process for generating ideas and verifying hypotheses. This mode of thinking is iterative and requires methods that are fast and accurate, depending on the problem at hand. Prototyping requires a high level of fidelity or accuracy in order to properly simulate or represent the design ideas under review. This form of conceptual development is a process of discovery whereby the designers choose the correct tools and methods to enlighten themselves and understand the solutions that may lie before them. These solutions are then tested iteratively to generate an understanding of the limits of the proposal. This can be expressed in a variety of ways but is usually accomplished through sketching, diagramming, and modeling and occurs in the medium in which the designer is most facile. 

Persuasive or experiential representation is often used to communicate ideas and can be developed in a broad range of drawing or modeling types. Characteristically, these drawings appeal to the senses and are illustrative, attempting to evoke a sensual representation of the environment. This form of representation is primarily visual and tends to be a truer representation of how we perceive the world around us. The most typical form of persuasive or experiential representation is the perspective image or animation. The point of view instantly creates an image that is from an understandable vantage point that may be from the human eye or even from an aerial perspective. Rather than attempting to test or hypothesize about a design method, the experiential or persuasive representation focuses on defining a space and communicating qualities of texture, atmosphere, and the defining activity or program. (See Fig. 1.6.)


Figure 1-6. Lower Ninth Ward, New Orleans, LA; perspective illustration.
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All design projects require a method of documentation to accurately communicate the mediated world of representation with the physically constructed world we reside within. This process requires the utmost precision to minimize the interpretation of a drawing. Documentation typically uses standards of symbology and notation that are nontransferable and have clear uses and conventions associated with them. In most design professions, the process of documentation is a legally binding contract among client, designer, and contractor. 

The idea that representation is supportive is an important modality to consider because it infers that drawing and modeling require a greater process that they are attached to. Design drawings require ideas, proposals, analysis, and expressions and cannot exist as ends in themselves. It is important to understand this point and not lose sight of the fact that the idea is more important than the image. Appropriate design drawings are supportive; they frame an idea or express a new mode of exploration. 

Digital media constitute a partner in all of these modes of representation and have slowly evolved as a facile method of creating inventories, analyzing conditions, conceptualizing ideas, documenting proposals, and visualizing experience. The documentation process is the most highly developed mode that digital media have enveloped. As digital design media have evolved and adopted methods from other professions, we see digital methods used to create persuasive or experiential representation and as tools to generate conceptual ideas. 





Chapter 2

Digital Media Industries

Many of the pioneering digital media industries have been grounded in commercial entertainment and media. These pioneering industries are centered primarily around film, visual effects, video games, and interactive media, which typically cater to consumer demands or visually rich experiences. This has led to a revolution in digital imagery that, until recent times, has been relegated to the persuasive, communicative role and not fully utilized throughout the design process. The design process is typically used to produce imagery that is of a high caliber and tends to represent realistic environments or stylized narratives. Therefore, these industries produce the image itself rather than using the image or representation to design or visualize physical environments. Although these industries contribute to the perception that it’s the image that is of primary importance, in most cases they provide methods and processes that, upon reexamination, can be integrated into design thinking, providing a more heuristic use of digital tools and incorporating their use into a more diverse range of roles throughout the process.

Film . Video

Film and video have an established tradition from which to draw an understanding of how constructed views and other narrative strategies can be used to convey a message. Film increasingly refers to digital techniques that create moving pictures for movies, TV, commercials, and a broad array of other uses. Film influences design representation in four specific ways: narrative, experience, point of view, and time. This influence stems directly from a historical change in the way we perceive the moving image and experience storytelling. 

Film is particularly suited to creating complex narratives from multiple points of view over time that frame an experience. When developing design representations, it is important that each of these factors is carefully considered. Narrative is addressed through examining the intent of a single image, a series of images, or an animation, and how this addresses a specific agenda. It is also possible to illustrate experiences or the experiential quality of space through film. This can be accomplished through sensorial qualities, typically visual, but it may also be accomplished through aural or other cues. (See Fig. 2.1.)


Figure 2-1. Image still from Home by Matt Faust.
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CG and Visual Effects

Computer graphics (CG) and visual effects are common elements of the media we currently consume. Visual effects are used to alter and refine video and to produce epic scenes that could never be accomplished using physical sets. CG is ubiquitous in current media and in most instances we are no longer aware of the borders between the physical and the digital in video and imagery. CG is the tool used to build the stage sets within which actors are composited, creating worlds that are hybrids of the physical and the digital. A common computer graphic methodology is the concept of matte painting, which has been carried over from set design and film stages. Digital matte painters create vast worlds that serve as the context for action that is filmed in the foreground. (See Fig. 2.2.)


Figure 2-2. Dylan Cole matte painting.
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The methods of compositing are an effective tool for creating rich, layered worlds wherein the physical and the digital seemingly interact with one another. This space allows scenes to be overlapping areas with static and dynamic components that can illustrate subtle or epic narratives. Visual effects use a broad range of CG methods that rely on concepts of illustration and simulation. This combination of methodologies augments weaknesses apparent in each approach, effectively creating methods that lie between science and art. (See Fig. 2.3.)


Figure 2-3. Sequence from Home by Matt Faust.
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Video Games

Video games have evolved tremendously over the past 30 years from pre-scripted adventures to real-time worlds that closely resemble the world we perceive through film or video. There is a vast variety of genres in gaming that allow individuals to interact with media and seemingly guide or explore the progression of the narrative. This interaction, whether it is from a first-person perspective or an overview, is the key component of the gaming experience. Players take on a role in video games, and they interact with the environment, creating a dialog between the player and the content or narrative. This relationship differs from the experience of video itself because a portion of the scripting is given to the player, and, therefore, the story or narrative often unfolds in new ways. Video games have fundamentally changed the way we expect to interact with virtual worlds, and they have ushered in the hardware necessary for individuals to be able to do digital modeling on their personal computers. 

Current generations of design professionals have had the opportunity to be exposed to real-time virtual worlds. This exposure, even for those who do not participate in gaming, creates a familiarity with the paradigms present in interfaces that allow us to explore information in a three-dimensional space. We have become accustomed to moving through worlds such as Google Earth as a result of our increased familiarity with gaming. Not only does this alter our expectations for navigating information, but it also changes how we begin to edit and transform data. (See Fig. 2.4.)


Figure 2-4. Crysis by Crytek.
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Digital modeling and animation software has started to incorporate editing methods that are similar to those used in video game environments. This is possible because of advancements in hardware and software as well as expectations of users. One of the most time-consuming aspects of working with digital models is the disconnection between the real-time view and the final rendered product. The ability to interact directly with a fully textured, lit, and rendered model similar to the way we interact with video game worlds is slowly becoming the direction that software developers are pushing for, with help from video hardware manufacturers. (See Fig. 2.5.)


Figure 2-5. CryEngine 3 sandbox editor.
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Interactive Media

Similar to computer graphics, interactive media encompass a wide variety of projects. Several types of media fall within this category, from responsive installations to video art to user interfaces. The capability for individuals to directly manipulate information or influence its presentation is critical in creating interactive media. 

Interactive methods of entertainment have been available throughout history in the form of performances or devices but have come to the forefront in the past decade primarily through digital systems and sensing devices. Many designers and artists have developed methods for participants to interact with environmental phenomena, to interact with other users, or even to transform spatial relationships. This has created rich physical spaces that are driven by digital interpretations of the analog environment. (See Fig. 2.6.)


Figure 2-6. Thresholds Interactive installation.
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Chapter 3

Digital Media

“Digital media” is an ambiguous term that has become a catchall phrase for a broad range of media techniques. In actuality, the term “digital media” describes many of the current forms of media we use on a daily basis and is merely employed as a way to differentiate them from traditional media such as print and film. Web pages, video games, and interactive experiences are all forms of digital media, and they have taken over the way in which we consume information. We read the news, watch films, and do everyday administrative tasks through digital forms of media. 

Digital or analog and traditional or new media are very similar dichotomies, but there are specific ideas surrounding user modes that must be addressed when considering the possibilities new media possess. While many issues arise with digital media, some of the most prevalent come in the form of new modes of participation, issues of craft, processes of automation or repetition, and mediated environments. These constitute the majority of methods that currently alter the way in which media affect the design process when working in digital environments. (See Fig. 3.1.)


Figure 3-1. Design drawings and model.
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New Modes of Participation

Digital media open up a range of possibilities that allow for collaborative environments and replication of data among contributors. Speaking generally about networked and participatory media, there are a range of technologies that fit into this category, including blogs, social media, and collaborative workspaces, to name a few. Nearly every website or application is contemplating methods to integrate user-generated content, feedback, support, and social networks. In our everyday lives, we are accustomed to the modalities of social networking such as Facebook or professional networking sites such as LinkedIn. In both cases, users and all of their subsequent connections become the focus, allowing individuals to connect through similar interests, shared experiences, friends, or even location. 

The possible ways in which this affects design practice are important to understand, and there are several current efforts that begin to examine how we might take advantage of these new modes of participation. Many designers share documents through a complex process of transmittals that specify what information was sent to which collaborator. This process records how information moves among the project team, but it is often slow and repetitive. In the simplest sense, networked media provide possibilities for collaborative virtual spaces where documents, drawings, and models are continually synced between the computers of the individuals involved. Depending on the needs, digital solutions may also have built-in systems that control file versions and record access and changes over time. 

In the simpler sense, “networked media” can refer to solutions such as folder-syncing software or shared local network volumes. Neither is a new phenomenon, and both have been in use for the past two decades. They have transformed the way we view information. The ability to have documents in a central location that can be accessed in varying degrees by all participating parties allows for very efficient means of team document creation. This can be seen in typical office processes in which each phase of a design project may share similar base drawings that are used with linked files for different modes of representation. 

It is also possible to implement complex project management software such as Autodesk Buzzsaw, which is built as a scalable collaborative environment to control all phases of the design and construction process. While project management software does not create anything per se, it is a system that manages the vast array of documents or images created and the collaborators that may be editing these documents or images. Whether implemented as a turnkey solution such as Autodesk Buzzsaw or created as a series of protocols for working with synced digital volumes within the office, these methods of collaboration have expanded the possibilities for working with collaborators in a synchronous manner.

Although these modes are built around a known team of collaborators, it is also possible to begin establishing new networks for designers. Social networks help to develop relationships between individuals that may share similar interests. Two social networks, land8lounge and Architizer, have changed ways that information is shared for landscape architects and architects. These websites function as virtual meeting spaces where individuals can display their current work, share their profile, and participate in discussions about current topics in the professions. Land8lounge has made a name for itself by creating active forums where users share current ideas and discuss professional concerns. While the profession is relatively small, the ability to interact with landscape architects across the world provides a resource that is hard to quantify. Architizer plays a similar role for architects but has also integrated firms as a way to organize individuals as well as creating a project archive built by users.


Figure 3-2. Jefferson Parish Greenway; aerial perspective.
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Craft

The term craft holds many connotations, typically referring to the work of a highly skilled individual. We may presume that in order to craft something we must put our hands on the thing in an attempt to directly alter the subject. This seems like a truism, but we can also assume that “this touch can be indirect—indeed no glassblower lays a hand on molten material—but it must be physical and continual and provide continuous control of whole processes” (McCullough 10). This can be extrapolated to other creation methods that tend to favor mediation but require a continuous hand to develop virtual imagery or documents. 

When working with digital media, it is important to understand the designer’s role as he or she crafts images, models, and animations. This comes in the form of the continuous, purposed hand that must be employed to create beautiful and relevant representations. Some believe that digital media allow an individual who cannot create illustrations to create amazing works by means of the computer. This idea negates the importance of craft in the representation process. Designers must understand the underlying conventions that are used to create rich imagery and continually manipulate their tools in order to achieve great results. (See Fig. 3.3.)


Figure 3-3. Terrabank; perspective image.
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Repetition and Recursion

Digital media provide the user with the ability to very easily copy existing information and reuse it in new instances. It is also possible to repeat procedures through scripting or recording and playback. This is a huge advantage over other forms of media—repetition can be achieved with high levels of precision, and not only are objects copied, but they can be derived from single instances, making them updatable across an entire drawing. 

Repetition is a computer’s talent; it is specifically designed to iterate similar tasks over and over again. Designers can take advantage of this ability to automate tedious, repetitive tasks within the design process. It is also possible, through scripting, to use computing to iteratively explore a range of design prototypes through either simulation or form finding.

Repetition in digital media is a blessing, but it must be utilized appropriately within the design process. If an action is repeated, the result is multiple operations or virtual objects that are exact clones of one another. Repetition is a tool that works well in the forms of art and film but often leads to lifeless environments; therefore, it requires that designers address these issues by applying randomness or variation. (See Fig. 3.4.)


Figure 3-4. Vegetation modeled with scattered meshes.
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Mediated Environments

The use of digital media is inherently a mediated experience that requires a translation from tangible inputs to virtual space. This connection is very important and has many differing modes that designers use to interface with their software and hardware. The mouse and keyboard are mediators between designers and the image or model they are attempting to develop. These tools have not been developed specifically for design purposes, but they are the common interface that must be reconciled to manipulate digital information. 

For many designers, the learned routines of holding a pen or pencil and drawing on a medium goes from a highly mediated experience to a tangible method of expression. It is important to prioritize the interface between the users and the information they are designing with, which includes developing consistent input methods and similar work flows.


Figure 3-5. Shift Boston; aerial perspective.
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Chapter 4

Representation, Illustration, and Simulation

Definitions

Art, design, and science use representation as a tool to visually communicate nonverbal ideas from producer to viewer. Representation in this sense is any likeness, from abstract to realistic, that is produced to interpret an idea. As a general term and container, “representation” can refer to a drawing, sketch, photograph, painting, sculpture, model, digital rendering, animation, or any visual aid that conveys an interpretation (see Fig. 4.1). Abstraction plays a large role in representation and can convey latitudes of meaning when working with an image or model. Determining the level of abstraction is an important aspect when considering how a project will be represented.


Figure 4-1. St. Louis Gateway Arch Grounds; perspective drawing.
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“Illustration,” as we use the term throughout the book, is defined as a representation that, through intent, strives to illuminate or explain a set of ideas and is not produced solely as celebratory likeness. Illustrations include measured drawings, diagrams, mappings, and even pictorial imagery that help make something more clear, to either the producer or the viewer (or both). The ability to convey empirical or narrative information is an important aspect of design representation and is at the heart of illustration. (See Fig. 4.2.)


Figure 4-2. This elevation/perspective conveys a variety of information to the viewer.
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Simulation is a technique of imitating behavior or process. Digital simulation usually refers to either visual enactments of environmental processes or actions/reactions of physical properties. Simulation is, therefore, a representation of a process and uses illustration to convey that information to either the user or an external audience. Simulation is an important aspect of design and requires ranges of fidelity and operation to accomplish its goals. (See Fig. 4.3.) 


Figure 4-3. Simulation exploring the path of water flowing through obstacles.
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Roles

Illustrations and simulations are used to explain details and convey information. This can be measurements, relationships, processes, comparisons, causality, function, and operation. Both can be used in the design process to help the designer visualize ideas and predict results, or they can be used as presentation artifacts to relay information to the viewer. Environment illustration provides context and a sense of time. Environment simulation (animation) allows us to experience change over time.

Simulation is used for multiple reasons by different industries. One of the most powerful reasons to use simulation is to convey change over time. Whereas a two-dimensional image can convey only a single moment, simulation can express multiples. This allows simulation to be useful for exploring physical properties and processes, interaction between processes and objects, and change as each of these interacts. Using simulation, we can diagram process, communicate experience, and investigate possible iterations. (See Fig. 4.4.)


Figure 4-4. These renderings explore possible scenarios through periods of dry and wet.
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In engineering and the sciences, simulation is used primarily as a means of investigating and testing. Simulations tend to be highly technical and unavailable to the general public. They are used to explore structural or relational phenomena and to refine or test ideas.

In design, digital representation usually plays a supportive role. Sections and plans are constructed in sketch first and then embellished. Perspectives are constructed after the design has been solidified to support the ideas and convey a sense of experience to an audience. Animations/simulations are used in ways similar to perspectives, usually constructed after most of the design is solidified. Sketching is usually done by analog means, leaving the digital to the finishing stages.





Chapter 5

Design Practice

Current Practice

Current landscape architectural design practices use a variety of digital tools to explore and represent design ideas. It isn’t possible to outline a single work flow that is all-encompassing, but we can make some general assumptions about practice for the purpose of this discussion. In the most general sense, design goes through a process in which a question is proposed and then a response is given. Many design processes involve posing a question, research, refinement, prototyping, and evaluation, resulting in the implementation of a product. Landscape design follows many of these steps but, similar to architecture, suffers from an inability to have wholesale prototyping for proposed conditions. This lack of prototyping requires environmental designers (architects and landscape architects) to understand representation in much finer detail. (See Fig. 5.1.)


Figure 5-1. Arid Urbanism; illustration + annotated diagram.
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Any discussion of current practice requires a careful examination of tools available to designers to represent, simulate, or illustrate design proposals. Rather than discussing a typical office sequence of schematic design, design development, and construction documentation, it is worthwhile to more broadly define processes of analysis, design iteration, and documentation.

Design projects may begin in a multitude of ways, but oftentimes they begin around processes that rely on design analysis and research. Research and/or inventory is typically necessary to understand or document the issues that come to bear on a site or design problem. In terms of representation, this work transitions from written documentation to visual representations of information that can be used in future phases of design thinking. This requires a careful translation and distillation of complex ideas into digestible and mutable research representation. (See Fig. 5.2.)


Figure 5-2. Brooklyn Academy of Music; perspective illustration.

[image: 902943c05f002.tif]


Iteration is the process of successive repetition that is moving toward a desired goal, typically a design solution or the generation of a conceptual framework. Iteration frequently uses the result of one exploration to feed the exploration of the next. Design iteration is an integral component of design exploration and prototyping that builds upon each step of the design process. This is important in digital media because it asserts that no single product exists in isolation and each must be used in successive iterations.

Nearly every design project must be visualized in some form. This is necessary in order to be able to discuss intent internally with project contributors or externally with clients and community groups. The visualization process begins in the early stages of design, where it is necessary to explain conceptual ideas through sketches or schematic diagrams, and progresses to high-end illustrations that may be used to explain, sell, or market a project. The concept of visualization is at the heart of representation and drives not only how we imagine our work but also how a design team contributes to the work. The importance of accurate and meaningful visualizations cannot be stressed enough. This does not mean that every detail is included, but it does mean that every aspect of the illustration is considered when creating the rendering. (See Fig. 5.3.)


Figure 5-3. St. Louis Gateway Arch grounds; perspective drawing.
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The other phase of the design process is the documentation of the proposal through design drawings—typically, plans, sections, and details. Although this is changing through the integration of new modeling tools, it is typical that construction documents are created for the proposal to communicate to craftsmen, contractors, and builders. This documentation is the conduit between the designer’s intent and the built form and must accurately and comprehensively describe the proposal. 

Design Process: Heuristics

Representation, simulation, and modeling are mediators of our thought processes, inevitably advancing our ability to propose a solution or to construct our environment. The typical modes of design are facilitated by a defined tool set that may be representational, analytical, or simply inspirational. This tool set is defined by the implements at hand and often revolves around the items with which we have the greatest facility. (See Fig. 5.4.)


Figure 5-4. New Orleans Park infrastructure; perspective illustration.
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The implementation of the tools varies throughout stages of the design process. In early phases, it may be necessary to use highly analytical tools to inventory and map sites. This information may be gathered through remote sensing, as built surveys, photo inventories, or any number of methods. The analysis of the gathered information may occur through geographic information system (GIS) queries, overlays, or surveyed data. This measured or precise base information is the foundation for the first stages of the design process and guides future explorations. The early tools tend to favor precision to create high-fidelity base maps, and any failure at this stage is magnified in later stages of the design process.

Often, design iteration is a process of sketching or schematic modeling to test a variety of ideas very quickly. This process creates a series of products that build upon one another through either digital modeling or the refinement of simulations. In digital modeling, this may be as simple as creating iterations that are transformed from the previous file or transformed at a specific stage of the construction. (See Fig. 5.5.) It is important to understand that the iterations are tools for learning about the design proposition, and each transformation must be observed or documented carefully to understand the change. This analysis, which may be implied or implicit, is necessary to fully comprehend the iterative process. 


Figure 5-5. Chattanooga Riverfront; aerial perspective.
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Our tools can also teach us about the design proposal through the refinement necessary to create measured drawings. The transfer of schematic, sketch, or gestural representations to precise measured drawings often leads to a dialog between design intent and construction implementation. This is an opportunity to allow the translation to lead to a further evolution of the design proposal rather than a one-to-one transfer of information.

Possibilities and Futures

Digital representation is quickly advancing in several areas that are influenced from media industries, hardware advancements, and design professions. The combination of these factors is leading to design tools that are capable of visualizing and manipulating models of increasing complexity and realism. Currently, there is a trade-off between the complexity of the data set and the ability to manipulate the data in real time. This trade-off is particularly true in terms of real-time visualization and simulation, creating a mediated, liminal zone between what is seen in the modeling software and the final rendered product. This is changing very quickly, and software such as Autodesk 3ds Max (and others) is integrating real-time graphic technologies directly into the modeling process. 

There are also advancements in the areas of simulation in materials, lighting, and dynamic systems and how these systems interact with the virtual environment. In the past, setting up a dynamic simulation was extremely difficult and required a significant understanding of how to get the most out of clunky, tech-heavy interfaces. Software advancements are currently linking materials, lighting, and simulation in order to allow all of the systems to interact and drive one another. This allows a designer to create a daylight system, at a geographic location that will then behave like the world it is emulating. This environment creates a lighting simulation and weather, as well as interacting with the materials applied to the objects. The materials then define the dynamic physical properties of the objects, allowing a metal object to have not only a specific look but also a weight that interacts with environmental gravity. 

Our modeling software currently offers this type of working environment but not in a comprehensive package. Features are available in multiple pieces of software or plug-ins, and the ability to interact with all features at once does not exist. The better modeling software becomes at simulating the world we live in, the more closely it will be able to create one-to-one mediations between what we envision, what we model, and what we construct.


Figure 5-6. Jefferson Parish canals; aerial perspective presentation boards.
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Chapter 6

Diorama: Setting the Stage

Taming Infinite Worlds: Limiting the Workspace

The technique of diorama provides an accessible method with which to begin modeling environments in three-dimensional space and visualizing change over time. Diorama includes the composition of focal objects, the arrangement of objects within a context, the composition of views, and a manipulation of the viewer’s experience through an established narrative. Through use of these elements, we can create 3D worlds with relative ease by using imagery and simple geometry. 

Prior to his contributions to refining the first widely used method of photography, Louis Daguerre introduced the diorama. Daguerre’s diorama technique employs a combination of ideas from landscape painting and theater/stage, where the contextual information establishes the mood, time, and place, and the composition of objects establishes relationships between those objects and the context. An early form of virtual reality, the Daguerre technique simulates movement and the passage of time through manipulation of lighting and visual cues.

The modern form of diorama, such as those used in natural history museums or scale models, also uses composition and visual cues to manipulate a viewer’s perception of space; however, the emphasis is focused more on the illusion of depth perception, creating the sense of a larger space within a smaller area. Both Daguerre’s and the modern form of diorama provide methods that can be employed in digital environment modeling.

Most design drawings, as discussed in Chapter 1, rely on orthogonal projection. Three-dimensional modeling allows us to utilize the precision of scale and placement using the Cartesian grid and orthogonal views; however, we are also able to take advantage of perspective projection and the fixed view of a camera that is more closely related to the way a person interprets real-life scenes. The ability to use perspective projection, or a fixed view, can allow us to compress our workspace and employ known methods to create the illusion of greater space. (See Fig. 6.1.)


Figure 6-1. Orthogonal and perspective projection comparison.
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To employ methods of diorama, it is necessary to understand the different components and how each one functions, contributing to the three-dimensional environment. First, the viewer is the medium through which all information is processed. At a fixed position, the viewer sees the scene and the brain interprets the relationships through input from the two eyes. The difference in position of each eye creates a slightly different view of the scene, giving us important cues about the placement of objects in relation to the viewer and to each other.

In a static perspective, overlapping, size, detail, and color provide strong cues about the placement of objects. If one object overlaps another, we deduce that the overlapping object is in front of the overlapped object. If there are two similar objects, however, and one appears larger than the other, we deduce that the larger one is closer to us than the smaller. Similarly, an object that appears more in focus seems to be closer than an object that is blurry. Color and shadows tell us that the brighter part of an object (or the brighter object) is closest to the light source. Surveying the entire scene, we can determine the light source and interpret the relationships between objects and their parts. (See Fig. 6.2.)


Figure 6-2. Overlapping, size, blur, and lighting.
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Parallax is the term used to define the difference, or displacement, in the way an object is perceived from two different lenses, as with human eyesight. The farther an object is from the viewer, the less the displacement. As a result, when the viewer moves, objects in the background appear to move more slowly than those that are closer to the viewer. This phenomenon contributes directly to how we perceive depth and can be used to expand the simulated environment. If an object or background appears to remain stationary whereas another object appears to be shifting, we perceive the shifting object as closer to us. With animation, we can use this phenomenon to give cues about depth, either by simply placing objects in relation to the camera (viewer), thereby creating that displacement when using a camera in motion, or by amplifying the displacement by animating the objects themselves, thereby tricking the eye into seeing more depth than actually exists. (See Fig. 6.3.)


Figure 6-3. Parallax and stereopsis.
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The model space within a 3D environment is essentially limitless. Diorama provides us a way to limit this seemingly infinite workspace by enabling us to use imagery and visual manipulation to trick the eye into seeing a larger space. (See Fig. 6.4.) We can take images that are the same size and manipulate their relationship to each other through their arrangement and placement in the world, without even changing their actual size. This allows us to manipulate not only objects but also the context, to enable a small space to portray a larger, infinite world. Expanding upon the concepts previously mentioned, this means that the infinitely complex world can be represented in diminishing levels of detail, relying on the known perceptions and interpretations of the human brain. (See Fig. 6.5.)


Figure 6-4. Examples of diorama.
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Figure 6-5. Definition of context within infinite virtual space.
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Working in Measured Space

Within a 3D program, there are several tools that are designed to aid in the creation of this simulated world. Some of the most useful are simply measuring tools: the ability to work in measured units, grids, and snaps and scaling and transform commands. While we have the ability to set up our model space in whatever units we choose (even generic), it is essential to understand that, within the program itself, we can employ illusion as well as real-world relationships to simulate three-dimensional space. In order to do this, however, it is necessary to understand the role of perception, the relationships we create with respect to measured space, and the composition of a scene.

Before starting a new project in any 3D animation program, it is important to set up the workspace prior to starting to model. Each piece of software might be slightly different, so the software documentation should be consulted for detailed instruction. Since we will be using 3ds Max, the following instructions show the process for this software and can be used to determine likely steps necessary for different programs. These instructions provide a base from which to start modeling and can be tuned as necessary.



Tutorial 6.1 Setup: Units

First, establish the base units so that objects and images can be scaled accurately. When working with CAD linework, as we will cover in future sections, you can use the units from the original files as your base. When working from images, as we will be in these first sections, you will need to establish a scale that can help you determine an object’s size regardless of image size. In 3ds Max there are two customization areas that need to be adjusted: the individual project units and the system units.


1. To set up the project units, in 3ds Max, open the Customize menu and select Units Setup (see Fig. 6.6).


Figure 6-6. Units Setup dialog access.

[image: 902943c06f006.tif]


2. Select the units that will give you the greatest functionality for your project. This may be Feet w/Decimal Inches or Meters, depending on what you are most familiar with (see Fig. 6.7).


Figure 6-7. Units Setup dialog.

[image: 902943c06f007.tif]


3. The system units must match the project units; otherwise, you might get errors in rendering calculations. Open the System Unit Setup dialog to make sure that the units match (see Fig. 6.8). In other words, if you chose Feet w/Decimal Inches, the system units should be set to inches. 




Figure 6-8. System Units Setup dialog.

[image: 902943c06f008.tif]






Tutorial 6.2 Setup: Grids

The next tool that should be set up before you begin to model is the Home Grid configuration. The Home Grid is a system of arrays whose spacing you can adjust so that you can visualize, align, and reference specific distances during the modeling process. The Home Grid can be adjusted as needed throughout the process to help with object creation and manipulation. In the beginning, it is helpful to set up the Home Grid with spacing that corresponds to the units you will be using in the 3D scene.


1. Open the Grids and Snaps dialog by either choosing it under the Tools menu or right-clicking on any Snaps button (see Fig. 6.9).


Figure 6-9. Tools ⇒ Grids and Snaps ⇒ Grid and Snap Settings.

[image: 902943c06f009.tif]


2. Choose Grid and Snap Settings (see Fig. 6.10).


Figure 6-10. Grids and Snaps dialog.

[image: 902943c06f010.tif]


3. Choose the Home Grid tab.

4. Adjust the grid spacing to inches (or the smallest increment of units that you would like to use).

5. Adjust the major grid divisions to make it easy to read groups of grid lines (see Fig. 6.11).


Figure 6-11. Grid divisions adjusted.

[image: 902943c06f011.tif]


6. User Grids can also be adjusted here for more complex uses than we will cover at this point (see Fig. 6.12). They can be useful, however, and should be noted.




Figure 6-12. User Grids dialog.
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Tutorial 6.3 Setup: Real-World Mapping

Another feature in 3ds Max that needs to be noted is Real-World Mapping. Real-World Mapping establishes how a material is mapped to geometry. If Real-World Mapping is turned on, textures can be given a scale relative to how they would appear in relation to real-world sizes. When you map the textures to an object, the texture is automatically adjusted to the scale of the object. (See Fig. 6.13.) Since we will be using imagery that is not necessarily at real-world scale, we will turn off Real-World Mapping. Note that this feature can be turned on and off globally, or it can be turned on and off locally, depending upon the object. 


Figure 6-13. Real-World Texture Coordinates setting in the Preference Settings dialog.

[image: 902943c06f013.tif]



1. Open the Customize menu > Preference Settings and choose the General tab.

2. Uncheck the box next to Use Real-World Texture Coordinates to turn off Real-World Mapping globally.



In upcoming chapters, we will use the Real-World Mapping feature with 1:1 scale models and textures.




Composition: Foreground/Middleground/Background

Depth perception is influenced largely by ordering and preferential attention to objects. This ordering is achieved through use of foreground, middleground, and background. The foreground consists of the elements that are positioned closest to the viewer and hold some amount of importance.

The background, as opposed to the foreground, consists of the elements farthest away from the viewer. The background provides context and creates the spatial boundaries of the composition.

Separating the foreground from the background is the middleground, which both supports the context and spatial experience and, in some instances, can contain focal elements. (See Fig. 6.14.)


Figure 6-14. Foreground, middleground, background.
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Composition: Ground/Horizon/Sky

The horizon is a perceptual line where land or water meets the sky. The horizon line in drawing is relative to the viewer’s eye level. It separates a 2D image into two regions: ground and sky. The horizon, therefore, guides our perception of gravity and allows us to determine where objects are stationed in the world or the vantage point of the viewer (see Fig. 6.15). This relationship is important in establishing the view but also in understanding how objects may be arranged. Fundamentally, the ground, horizon, and sky are the framework that establishes a perspectival image (see Fig. 6.16).


Figure 6-15. Panorama showing ground, horizon, sky.

[image: 902943c06f015.tif]



Figure 6-16. Perspective setup.

[image: 902943c06f016.tif]


Modeling Strategy: Narrative

All design drawings should have a story to tell. They relate to the viewer in what ways the design will change and shape the site space, not only over the course of construction and into the climax of the project but also as time and environment meet the design beyond the construction completion. Environment modeling does not just stop where the design is built but seeks to explore and expand on how a design can change over time. In addition to composition, diorama should employ a form of narrative, filtering the information by the artist to simulate experience and give an illusion of being in the space.

Diorama can be useful throughout the design process to both set up static perspective imagery and create experiential animations that move a viewer through the space of a design. Especially when first getting used to the workspace of a 3D program, it is beneficial to map out, or storyboard, the intent of the scene. This helps you plan the setup of the model, allows you to define key moments such as those used to create perspective drawings, and facilitates the development of time sequencing for animations. (See Fig. 6.17.)


Figure 6-17. Storyboarding establishes key moments, tone, and progression.

[image: 902943c06f017.tif]


In the beginning, identifying the key points about the design will help to identify which imagery is needed and which pieces may need to be modeled in the future. These key points can then be transformed into sequence for animation.





Chapter 7

Arranging the Elements

Positioning Elements in 3D Space

The previous chapter introduced the concept of working within a measured space in a 3D program and ideas of composition that influence how we perceive dimensional space. In the following chapters, we will look at how to take the techniques of diorama and combine them with camera techniques to set up a work flow for 3D modeling that can be both complex and yet quickly manipulated. This chapter looks more closely at bringing methods of diorama to 3D modeling, while the following chapters focus more on the role of the viewer and the camera.

As discussed previously, we have many options to consider when it comes to arranging the elements within the 3D space. After identifying a basic narrative to create the design space, we can begin to set up the diorama in a 3D program. Before we start to place the actual imagery, this chapter will discuss simple manipulations. One of the simplest methods of arrangement is the ability to modify parameters and transform individual objects, allowing us to move, scale, and rotate objects in relation to each other. We can use real-world spatial measurements to set up these relationships; however, we can also employ our knowledge of human perception and composition to force or expand a perspective to render a faux space.



Tutorial 7.1 Editing Object Parameters


1. Throughout the diorama section, we will be using planes mapped with imagery. To create a plane, in the Command panel, click on the Create tab ⇒ Geometry: Standard Primitives ⇒ Plane and either drag within the model space or use keyboard entry to create a plane (see Fig. 7.1). Note that the following editing and transformations can be used on other geometry as well.


Figure 7-1. Create a plane using the Command Panel.
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2. If you want to change an object’s parameters, select the object either by clicking on the object or hit the H key to bring up the Select From Scene dialog (see Fig. 7.2) and choose the object from the list ⇒ OK. 


Figure 7-2. Select from Scene Dialog.

[image: 902943c07f002.tif]


3. Click on the Modify panel and change the parameters in the Parameters rollout to the desired value, either by clicking and dragging the spinner arrows or via keyboard entry. You can also add more segments to your object here. (See Fig. 7.3.)




Figure 7-3. Use the Modify Tab to change object parameters after creation.
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Tutorial 7.2 Transforming Objects Using the Gizmo


1. Select an object to transform by clicking the Transform icons or using the following shortcut keys:

W to move

E to rotate

R to scale

2. A helpful tool, called the Gizmo, will appear. When hovering over the Gizmo, the different axes, planes, or the entire Gizmo will be highlighted, indicating on which axis the transformation will occur. Between the axes are planes, which you can use to transform the object on more than one axis. When the entire Gizmo is highlighted, the transformation will occur on all axes. (See Fig. 7.4.)




Figure 7-4. Transformations.
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Tutorial 7.3 Transforming an Object Using Keyboard Entry


1. Select the object and the transformation mode (Move, Rotate, Scale).

2. Find the keyboard entry option at the bottom of the screen just under the time slider. Alternatively, you can push the F12? button or right-click on the desired transform tool.

3. Type in the value for the transformation you want to achieve on each axis (x, y, z) (Fig. 7.5). 


Figure 7-5. Transform type-in dialog.
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4. You can also find a variation of the transform type-in under Edit a Transform Toolbox. (See Fig. 7.6.)




Figure 7-6. Transform Toolbox.

[image: 902943c07f006.tif]


By modifying and transforming objects, we can position and scale them as they would actually occur in measured, real-world space. Additionally, if we employ the methods of diorama, we can create a “false” perspective, enabling us to limit our workspace and expand the capabilities of illusion. (See Fig. 7.7.)


Figure 7-7. Image created through use of diorama. The imagery is positioned to give the illusion of greater space.

[image: 902943c07f007.tif]





Setting Up a 3D Diorama

The basic idea behind the method of 3D diorama is to map images onto two-dimensional planes and arrange the planes in three-dimensional space to form the illusion of 3D objects in space. In addition to transforming geometry, we must employ methods of composition, as discussed in the previous chapters. It is also sometimes necessary to make certain parts of the mapped images transparent, isolating one object in the image. The technique can be used alone to create an entire scene, or it can be used to supplement a more complex scene. (See Fig. 7.8.)


Figure 7-8. Imagery of different scales and viewpoints comes together to create a scene.

[image: 902943c07f008.tif]


In these next tutorials, we will go through the steps to prepare imagery, map the images to planes in 3ds Max, mask portions of the images by using material maps, and position the images in a scene. In Chapter 8, we will discuss methods of composition and interaction in the modeled environment. 

Note that it is possible to use imagery from multiple sources, including original site photography, found images, manipulated images, drawings, and sketches. As with any interpretive drawings and sketches, the diorama is limited only by imagination.



Tutorial 7.4 Diorama: Preparing the Imagery


1. From any digital sources, choose images to use in your scene. Be sure to choose images with medium or high resolution (depending on the intended use). For instance, your images should have enough resolution that the details are not blurry when rendered, but remain aware that larger files take up more memory and space. (See Fig. 7.9.) It is recommended that at the beginning, you try mapping one plane with imagery and rendering the scene, to become familiar with degrees of resolution.


Figure 7-9. Image swatches.
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2. Prepare your images in Photoshop or a similar image editor, cropping out extraneous borders and making any desired adjustments such as color adjustments or stylizations. Save your image(s) as a JPEG file with resolution similar to that of the original. Be sure to save your changes as a new file so that you keep the original intact.

3. While still in Photoshop, create the mask image that will be used in Tutorial 7.6. Select the part of the image that you wish to be visible. Create a new layer and fill your selection with white. Create a new layer behind this one and fill the entire layer with black. (See Fig. 7.10.)


Figure 7-10. Example of an image to be mapped to a plane and an opacity mask used to hide all but one tree.

[image: 902943c07f010.tif]


4. Save the black-and-white image as a new JPEG. Be sure to “save as”, so you don’t write over your original image. The new image will be used later as a mask to tell 3ds Max which parts of your plane should be transparent.







Tutorial 7.5 Diorama: Mapping Images to Planes


1. In 3ds Max, create a plane sized so the aspect ratio is equivalent to your image. In other words, if your image is 300 x 400 pixels, your plane could be 300" x 400", 6' x 8', or any other equivalent size.

2. Press M to open the material editor. (There are two modes in which to view the material editor. We will be showing the Slate Material Editor mode; however, the operations can also be accomplished in Compact mode. See Fig. 7.11.)


Figure 7-11. Material editor dialog.
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3. Create a new standard material by double-clicking on the Standard material under the Standard category, in the material browser on the left-hand side of the material editor.

4. Select your plane in the scene. In the material editor, select the new standard material and hit the Assign Material to Selection button on the toolbar at the top. You should also enable Show Standard Map in Viewport at the top of the material editor. (See Fig. 7.12.)


Figure 7-12. Assign material to plane and show in viewport.

[image: 902943c07f012.tif]


5. Double-click on the bubble next to Diffuse Color. This brings up the Material/Map Browser. Choose Bitmap ⇒ OK. Browse to and select the image you want to apply to the plane. You can also drag your original image into the material editor, which creates a new map for that image. (See Fig. 7.13.) In this case, you would then need to drag a wire from the small dot on the right side of the map to the diffuse node of your material. The Controller Bezier Float maps are created automatically. 


Figure 7-13. Add image as a diffuse map in the material editor.
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6. You should now see your image on the plane. If it is oriented incorrectly, double-click on the image map and change the U, V, or W values under Angle until it is oriented correctly (see Fig. 7.14). If it is sized incorrectly, try turning on or off Use Real-World Scale, and adjust the size appropriately.




Figure 7-14. Change coordinate values to orient image on plane.
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Tutorial 7.6 Diorama: Masking the Imagery


1. Repeating the process just completed, drag your black-and-white image into the material editor to create a map. Drag a wire from the new map to the opacity node of your material. (See Fig. 7.15.)


Figure 7-15. Add the black-and-white image to the opacity map channel.

[image: 902943c07f015.tif]


2. The title of the right-hand window of the editor should correspond to the map of the black-and-white mask. Make sure that the Show Standard Map in Viewport toggle is on. Where there is white, the image should show; where there is black, the plane should be transparent. You should now see only the desired portion of the image on the plane. If you changed the orientation of your diffuse map, change the opacity map to match it. Also, if the plane does not appear to be affected by the opacity map, you may need to double-click on the main material panel and click the Show Standard Map in Viewport toggle again. 







Tutorial 7.7 Diorama: Positioning Imagery


1. Position and rotate the plane, according to how it will be used. On the toolbar, you can enable Angle Snap Toggle to limit rotation to 5-degree intervals. (You can change this interval by right-clicking on the button.)

2. Using the tool, select the appropriate axis, and rotate your plane.

3. Position the plane using the Move transform tool.

4. Repeat this process to create and place all of the elements of your scene. (See Fig. 7.16.)




Figure 7-16. Planes mapped with images are transformed and placed in relation to each other to create the illusion of space.
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Proposed and Contextual

One of the most beneficial aspects of using diorama as a modeling method is the ability to quickly and accurately represent an expansive environment. We can then simulate the experience of being within a space and develop design responses that relate and respond to the existing context. Instead of 3D models and animations staying relegated to the endgame of the design process in their usual persuasive, final role, we can now use the digital model from the beginning as part of the discovery, analysis, and development phases.

By quickly modeling the surrounding context, we can plug in design responses to test the effects and make adjustments. We can easily augment proposed design interventions by altering photographs or incorporating sketches into the 3D diorama. Not only does the digital become more integrated into the design process as a way of sketching, it also allows us an increasing number of ways in which to incorporate the human experience into our design drawings. (See Fig. 7.17.)


Figure 7-17. Perspective illustration created by incorporating 3D modeling with contextual imagery.
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Dynamic Elements

The diorama typically relies on static imagery to form an environment, but it is also possible to create imagery that relates a dynamic or temporal narrative. This requires working with imagery that may evolve over time and/or expresses movement within the constructed world. Two methods can be used to accomplish this: The planes can be animated to move or a sequence of images can be mapped to the planes. Animating a plane is similar to animating a camera using keyframe animation, which will be discussed in future chapters. 

An image sequence can be mapped to a plane in the same way that a single static image can be mapped. If a folder contains a sequence of images that are named with sequential numbering, it is possible to select the first image and to then make sure that the sequence box is checked in the file browser (see Fig. 7.18). There are options that allow you to choose the number of frames in the sequence, the looping behavior, and the speed. When adding a sequence, a text file is created in the same directory as the sequence using the .ifl format. This file holds the settings for how the image sequence behaves when added as a bitmap in the material editor. (See Fig. 7.19.)


Figure 7-18. Sequence check box.
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Figure 7-19. Image file control list properties.
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Chapter 8

Composition and Views

The Camera

The objects and imagery that make up the environment contain a variety of shapes, patterns, and textures that can provide us with information and visual cues. The camera is the interface between the viewer and this simulated environment. With the camera, we can direct attention, set up a hierarchy of importance, contextualize, and simulate experience within the environment. 

Composing a scene, through the arrangement of the scene itself and through the view of the camera, sets up expectations for the viewer. The camera becomes the narrator, and we can use known methods of storytelling to construct the experience of the viewer. Since photography and film have been incorporated into the fabric of everyday life, we are used to, and can read meaning into the conventions and techniques used by these mediums. These techniques of composition, views, and movement communicate experience and help the viewer construct meaning. (See Fig. 8.1.)


Figure 8-1. St. Louis Gateway Arch grounds, MVVA; perspective illustration.
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As we discussed earlier in this section, composition of the objects within a scene give us cues to the relationships between the objects. When setting up a camera as the interface between the simulated world and the viewer, we have to keep in mind not only the composition of objects themselves but also the framing of those objects by the camera view, which relays information about the relationship of the viewer to the environment.

In this chapter, we discuss methods of composing static imagery, such as that used to create a single perspective or orthographic drawing. In the following chapter, we expand upon these methods to include camera motion and animation. The tutorials demonstrate how to set up compositions in 3ds Max and/or Maya, but the principles can be implemented in all 3D modeling software, including Google SketchUp.

Framing the Composition

Our perception of space relies on the ordinal placement of objects as well as on how we interpret the context outside of our central gaze. In photography, one of the first lessons of composition generally taught is the rule of thirds, which guides how a subject is positioned within the frame (see Fig. 8.2). Based on the idea that a viewer’s eye naturally flows to certain points of interest, the image frame is divided equally by two horizontal and two vertical lines. The points at which these lines intersect are generally points of interest. Placing the subject of the image at these points creates a balance between the subject and the context, can allude to motion by emphasizing the direction of motion, and can emphasize distance, therefore relaying more information overall to the viewer.


Figure 8-2. Rule of thirds diagram and image.
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View Perspective

Framing establishes the viewer as either a participant within or an observer of the scene. Imagery taken from a human vantage point has the ability to involve the viewer within the environment and suggest the existence of space beyond the picture frame. As a participant in the scene, the viewer can construct relationships among self, subject, and context (see Fig. 8.3). In contrast, imagery that establishes the viewer as an uninvolved observer, such as aerial or worm’s-eye views, can allow a more expansive or detailed vision of the subject.


Figure 8-3. An aerial view typically gives a more expansive impression of subject within surrounding context. A view captured from the vantage of the human eye suggests a greater expanse outside of the picture frame and places the viewer amid the scene.

[image: 902943c08f003.tif]


In a perspective view (as through the lens of a camera), lines that are parallel to the ground appear to converge at the horizon. If eye level and the horizon line are equal, then the viewer has a sense of experiencing the scene from a first-person viewpoint or as a character within the scene. All of the imagery within the scene, therefore, has a relationship with the viewer, and judgments about scale and distance can be based on this relationship. 

If eye level and the horizon do not match, it creates a different sense of perception. Compositionally, if the horizon line is located toward the top of the image, it gives the sense that the viewer is looking down on the scene from a bird’s-eye or aerial viewpoint. Bird’s-eye view is commonly used to give a larger, or contextual, picture of the entire scene. If the horizon line is located at the bottom of the image, it gives the sense of looking up at the image from a worm’s-eye view. Often a worm’s-eye view is used to emphasize importance or size of the main focal object. Both of these views are typically used to portray a third-person viewpoint or that of one uninvolved in the action of the scene. (See Fig. 8.4.)


Figure 8-4. The position of the horizon line within an image determines the view perspective.
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Focal/Peripheral

Outside of the eye’s focus range, our peripheral vision helps us interpret the broad spatial scene. Framing directs viewer attention and can create balances and tensions. Focal objects attract attention and hold some amount of importance, while peripheral objects provide information to supplement this. 

At any given time, our gaze shifts and wanders between focal objects and points. Just as in the manual setup of a perspective drawing, the eyes see within a limited cone that projects from the eye at about 90 degrees. Within this cone, 60 degrees contain focal objects, and the leftovers around the edges are what we consider our peripheral vision. As the focus of our attention gets farther away, the middleground and background become more expansive. Therefore, the more distant the focal point, the more information we take in and the more information there is in our peripheral range.

Peripheral vision creates the context on the edges of the frame, and, typically, elements within this area that may be in the foreground help to frame the subject. This framing can help define context through foreground and middleground objects and allows for the introduction of new spatial constructs moving from the focal to the peripheral. (See Fig. 8.5.)


Figure 8-5. Peripheral and focal points.
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The camera simulates the cone of vision through the use of field of view (FOV), lens sizing, focal depth, and target distance. Unlike our eyes, we, as designers, can adjust these parameters; therefore, we have additional control of how the scene appears to a viewer. 

Next, we will explore basic image shots using common film techniques. The tutorials following will then expand on how to set up and adjust the parameters of a camera within a 3D program to simulate these shots.

Major Film Shots

A film shot is differentiated by the field of view or by how wide an area the camera views and the distance between the camera and the subject or target. The FOV is determined by the camera position and the focal length; it is measured in degrees. There are three categories of camera views or film shots: the long shot, the medium shot, and the close-up. Through use of these views, we can frame the scene, designate focal objects, and limit the interaction of the viewer.

The long shot is typically taken from a faraway vantage point with a wider field of view (see Fig. 8.6). It includes the entire subject of observation within the full context of the environment. In film, we typically see two types of long shot: The wide-view long shot establishes an expanse of a landscape, and an establishing long shot defines the locale in which the action takes place.


Figure 8-6. The long shot shows the subject amid context.
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The medium shot typically contains part of the subject and part of the context, allowing the viewer to infer the larger scene (see Fig. 8.7). Long shot and medium shot tend to elicit an expectation from the viewer that there will be larger-scale action.


Figure 8-7. The medium shot typically shows most of the subject, with some immediate context.
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The close-up, taken with the camera close to the subject and using a narrow field of view, shows details of the subject usually devoid of context (see Fig. 8.8). The close-up is used to focus on particular features, moments, or smaller-scale actions.


Figure 8-8. The close-up shows details of the subject, mostly devoid of context.
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Tutorial 8.1 Creating Film Shots in 3ds Max

There are two types of cameras in 3ds Max: a free camera and a target camera. As suggested by the name, the free camera does not base its view on a target but depends solely on the direction of the camera and adjustment of parameters. A target camera allows for greater control, as both the camera position and the target can be manipulated independently. Field of view, lens size, focal length, and target distance can be adjusted similarly for both types. For our purposes, we will be using a target camera throughout most of the tutorials in this book, since it allows for more maneuverability. 


1. Set up a scene from which to create imagery. This can be either a continuation of diorama using the planes mapped with imagery from previous tutorials or it can be used with more complex models.

2. Create a camera. There are several ways to create a camera in 3ds Max. The easiest method is to position the view in the Perspective viewport as desired for the final image and use the shortcut Ctrl+C to create a target camera from the current view. If the shortcut key is not enabled, you can also use Views Menu ⇒ Create Camera From View. The program automatically places the camera and target at the appropriate point in space

 and distance to set up the view. (See Fig. 8.9.) Notice that the viewport automatically switches to camera view.


Figure 8-9. Create a camera by using either method.
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Additionally, you can create a camera by clicking either Create Menu ⇒ Cameras ⇒ Target Camera or Create Panel ⇒ Camera submenu ⇒ Target. If using the latter method, you would need to click and hold a point in the viewport to position the camera; drag and release to set the target. Typically, this method is easier to accomplish using a side or top view.

3. Once the camera is created, the option to switch between camera view and the other standard views in the viewport becomes available. To refine the camera and target positions, select the camera or target. Using the transform tools in one of the standard views, make adjustments to camera position and target to refine the position if necessary. 

4. The viewport window is not necessarily the same size as the image that will be rendered later. To view the area of the screen that will be rendered, turn on Show Safe Frames (Shift+F or right-click on General Viewport label and select Show Safe Frames or Views Menu ⇒ Viewport Configuration ⇒ Safe Frames tab). 

5. With the camera selected, the Modify tab in the command panel contains parameters to adjust FOV, lens size, and focal length. Adjust the camera to set up a Long Shot. The greater the degree angle or the smaller the lens, the greater the area within the field of view. The smaller the angle or the wider the lens, the closer the subject appears. (See Fig. 8.10.)


Figure 8-10. Select camera, turn on safe frames, and adjust parameters.
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6. Render and Save Image using the steps that follow.

7. Repeat for Medium Shot and Close Up. (See Fig. 8.11.)




Figure 8-11. Adjust FOV to create different shots.
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Tutorial 8.2 Rendering: Basic Single Image


1. Check the render setup. The default settings should allow you to quickly render an adequate image; however, you may want to adjust the output size for higher quality. Rendering ⇒ Render Set Up. Under the Common tab ⇒ Common Parameters, select Time Output = Single; Area to Render = View. Choose or specify desired output size. Under Render Output, uncheck the box next to Save File. (See Fig. 8.12.)


Figure 8-12. Render commands and Setup dialog.
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2. At the bottom of the dialog, make sure View = Camera01 (or the name given to the camera).

3. Click the Render button. Once the Render Setup is configured, you can click the Render Production/Quick Render button on the ribbon or Rendering ⇒ Render or Shift+Q.

4. Once rendering is finished, save the image by clicking the Save button on the render window. Browse to the folder and type in the name; choose the desired file format. Click Save. Make any image control selections on the next screen; click OK when finished. (See Fig. 8.13.)




Figure 8-13. Save button and JPEG Image Control dialog.
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Chapter 9

Movement in the Environment

Camera and Movement

Chapter 8 discussed methods of composing individual static images, or shots. We can build upon this knowledge of single shots and, using techniques from photography and cinema, compose sequences that relay change over time. Using the diorama as base and cinematography as method, this chapter explores how to animate the camera to create movement within a simulated environment.

Passive versus Active Participant

The camera, acting as narrator to the viewer, can be either a passive or an active participant within the constructed scene. As a passive participant, the camera stays in a single position, recording and relaying images from a single vantage point. Static camera positions are useful for constructing single orthogonal or perspective drawings and illustrations. In the traditional sense of diorama, the objects within the scene are static; however, atmospheric conditions such as lighting or weather may change. In sequence, a passive view, therefore, can demonstrate change over time taken from the same observer point. (See Fig. 9.1.)


Figure 9-1. Sequential imagery, static camera, and atmosphere changes.

[image: 902943c09f001.tif]


By constructing a three-dimensional scene and, therefore, space to maneuver within, animation functions of many 3D programs allow us to add movement to the camera. As an active participant in the scene, we can create motion through a space and generate new meanings through those sequential relationships. Not only can we experience change over time, we can also simulate movement through a constructed environment.

Camera Movement in Film

Camera movement in film establishes the narrative relayed to the viewer. The following basic movements can be replicated in animation programs and are created by animating the camera, the camera target, or both. Adjusting the distance between the camera and target, as well as horizontal, vertical, or pivotal movements, creates the motions. (See Figs. 9.2 and 9.3.) Combinations of these movements, along with composition and timing, merge to create the narrative whole of an animation.


Figure 9-2. Diagram of horizontal components.

[image: 902943c09f002.tif]



Figure 9-3. Diagram of vertical components.

[image: 902943c09f003.tif]


Zoom


Figure 9-4. The zoom movement can be achieved in 3ds Max by adjusting the field-of-view (FOV) parameter or changing the lens focal length of the camera.
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The camera and camera target are stationary, however the field-of-view angle is adjusted to vary the area seen by the camera. This is the same as adjusting the focal length on a camera lens. In sequential imagery, this gives the illusion of zooming toward or away from the stationary target. (See Fig. 9.4.) Widening the FOV angle or shortening the focal length gives the impression of zooming out from the target. Narrowing the FOV angle or lengthening the focal length gives the impression of zooming in. (See Fig. 9.5.)


Figure 9-5. The zoom motion is created solely through adjustment of the focal length. The camera and camera target remain static.

[image: 902943c09f005.tif]


Pan

The camera pivots horizontally, moving the target parallel to the horizon. (See Fig. 9.6.) This movement is typically used to show more than can fit within a single frame or as a transition between shots. 


Figure 9-6. Pan.
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Tilt 

Similar to panning, the camera pivots vertically, moving the target perpendicular to the horizon. (See Fig. 9.7.)


Figure 9-7. Tilt.
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Dolly or Track 

The camera and target move perpendicular to the camera lens axis at a constant distance. (See Fig. 9.8.) The appearance of this shot is similar to that of a zoom; however, the field of view remains constant while the camera physically moves.


Figure 9-8. Dolly or track.
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Crab or Truck

Similar to the dolly movement, both the camera and the target move parallel to the camera lens axis at a constant distance. (See Fig. 9.9.)


Figure 9-9. Crab or truck.
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Pedestal, Crane, or Boom

The camera and target move perpendicular to the horizon at a constant distance. (See Fig. 9.10.)


Figure 9-10. Pedestal, crane, or boom.
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Follow

The camera and target follow an object at a constant distance. (See Fig. 9.11.)


Figure 9-11. Follow.
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These are the basic camera movements that can be reproduced in most 3D programs. More sophisticated sequences combine movements—for example, arcing, which is the combination of tilting while panning, and dolly zoom.

Animating the Camera

Most any entities in 3D software can be animated in a variety of ways. Until now, we have been concerned only with placement and adjustment of objects. As an introduction to animating, we will look at two methods that can be used to achieve camera movements such as those used in film: key-framing and using a path constraint. These two methods are not exclusive to cameras and can be used to animate other objects, as we will see in future chapters. Also, these methods can be used simultaneously to achieve more complex movements.

Keyframes tell an object where or how to be at a certain point in the timeline. Between keyframes, the program automatically transforms (moves, scales, rotates, etc.) the object from one state to another specified state. Two important commands/buttons are the Set Key button and the Auto Key button (see Fig. 9.12.). Clicking the Set Key button immediately creates a keyframe for the object selected at the point on the timeline where the slider is located. Clicking and highlighting the Auto Key button creates a keyframe for the selected object at points as the object is moved and the time slider is adjusted.


Figure 9-12. The Set Key and Auto Key buttons.
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Instead of manually adjusting the movement of objects, a path constraint can be used to configure more complex and smoother movements. Using created linework, such as a line, arc, or Bezier line, as a guide for the path of movement, the camera and/or target is positioned using points along the line. Path constraints can also be combined with key-framing.



Tutorial 9.1 Using a Path Constraint to Control a Camera


1. Create a scene with a camera. Create a spline that outlines the path for your camera (see Fig. 9.13). The first endpoint is the beginning position (0% of the path) and the last endpoint is the end position (100% of the path). 


Figure 9-13. Create a spline.
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2. Select the camera (or other object) you would like to place on the path. In the Modify panel, choose the Motion Control tab. Expand the Assign Controller rollout and click the Assign Controller button (see Fig. 9.14).


Figure 9-14. Select object ⇒ Motion Control tab ⇒ Expand Assign Controller rollout ⇒ Click Assign Controller button.

[image: 902943c09f014.tif]


3. In the dialog box that appears, select Path Constraint and OK (see Fig. 9.15).

4. Expand the Path Parameters rollout and click Add Path. Choose the spline created to control the camera (see Fig. 9.16). Notice that the camera will move to the path (if the time slider is at 0, the camera will move to the first endpoint).


Figure 9-15. Select Path Constraint.
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Figure 9-16. Choose the spline to control the camera.
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5. Under Path Parameters, there are several options for controlling the motion of the object. Of particular interest is the % Along Path feature, which you can use along with keyframes to control how far along the path your camera will travel (as well as controlling how fast it travels over time). (See Fig. 9.17.)




Figure 9-17. Path parameters: % Along Path and KeyFrames.
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In this section, we only discussed animating the camera body; however, any object can be transformed using similar methods. Also, note that the camera target can be animated using these methods as well.

Pacing and Motion

One of the most difficult concepts with animation is learning how to time motion within the constraints of the program and rendering so that the final animation is convincing and masterful. Beginning the animation process with a storyboard can help us pinpoint key moments and establish distance traveled and time necessary to move between these key moments. If the narrative is attempting to convey human experience within an environment, it is important to understand the timing of human movements. For instance, if the camera is tilting to imitate the motion of a shifting glance and the camera moves too fast or too slow, then a viewer’s attention will be focused on the awkward movement, and the subtleties that connect our sense of what a glance is are lost, possibly confused with another reaction. 

Often, beginning animators overestimate how much motion can take place within a certain length of time, creating unusually fast-paced and spasmodic sequences. In order to become familiar with timing, it is advisable to experiment abundantly with simple scenes and periodically test the animation while working to ensure the desired effect. 

As timing and pace become more familiar, they can be used to manipulate the experience of a constructed environment’s space and time. Faster and slower speeds can be used to contract or extend spatial boundaries. Pacing can also be used to convey emotion or gestures. For example, slow motion can be used to convey a sense of ease, frustration, meditation, or anguish. It can also be used to emphasize the impact of the image subject. 

Additionally, the direction of motion can manipulate the viewer’s experience and relationships with the modeled environment. Most often, we progress through an environment with forward motion in the first person, reflecting the sequential relationships one would experience if encountering the scene in real life. Reverse or sideways motion is less pervasive; however, it can be used to establish a different relationship between the scene and the viewer or to emphasize relationships between subjects within the construction.

Once the animation is complete, the scene can be rendered into sequential imagery and a movie file. Refer to Section 6, Chapter 26, Tutorials 26.3 and 26.4 for instruction on rendering and saving a movie file.





Part 3

Object





Chapter 10

Object

Typologies

Consider the elements found in a typical landscape. The terrain serves as a spatial base for the landscape; however, it is the objects that sit in, on, or above the terrain that visually diversify and characterize human intervention and activity on the site. The same is true of virtual landscapes. The objects in a scene not only populate the terrain but form spaces and create the scene’s unique visual character. They determine what events can take place in a scene and define the type of landscape being represented.

The object, or device, typically falls into one of several categories. The most basic division is between synthetic elements created by human agency and natural elements such as rocks and vegetation. Synthetic elements generally have repetitive and/or simple geometries as a function of their manufacturing and can be modeled fairly easily. These elements can be further broken down into localized site elements of human scale and larger infrastructural systems. Natural elements are generally more geometrically complex and variable, requiring a different approach to their creation.

Both types of objects require planning and decisions to be made regarding the detail and precision of modeling, depending on the anticipated use of the 3D environment. Correctly modeling and determining the necessary fidelity of the elements in each category are essential to create a scene that is accurate and convincing. (See Fig. 10.1.)


Figure 10-1. Vancouver Land Bridge; polygon model.
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Site Elements

Most designed landscapes are intended to be visited, inhabited, or otherwise used by humans. As a result, they often contain objects designed to facilitate our activities and satisfy our needs. These localized, human-scale site elements come in a variety of forms and are important for providing the designed experience, not only aesthetically but also physically. (See Fig. 10.2.)


Figure 10-2. Turk Street Housing; axon.
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Some site elements are built to provide support and shelter for the human body. These include benches, chairs, stairs, ramps, and railings, as well as pergolas and other shade structures. Others are designed to accommodate our various activities. Some examples are playground and workout equipment at city parks, and tables and garbage receptacles at picnic areas. Other objects, such as informational signs and kiosks along nature trails, and built-in binoculars and periscopes at scenic overlooks and wetland boardwalks, allow people to engage with and learn about the landscape.

Other site elements include devices that provide form and structure for natural elements such as vegetation and soil. Short walls are built to form planting beds, while pots and other constructed planters allow temporary and portable planting solutions. Lattices that are attached to walls and fences, or that are built to be freestanding, allow vegetation to grow into green walls. Similarly, arbors and trellises allow climbing plants to grow into arches and covered walkways.

Also included in this range of human-scale site elements are a variety of features such as fountains, sculptures, and statues that may be purely ornamental or provide ambience. 

We can model site elements through a variety of methods that include building the geometries from scratch, using sketches or drawings as a template, and extruding elements from CAD details. (See Fig. 10.3.) Often, the construction documents and details we create throughout the design process provide the basis of these models. Conversely, it is also possible to use modeling in the early stages to revise and refine ideas as the basis for our design details.


Figure 10-3. Jacmel Haiti, streetscape water cleaning; axon.
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Infrastructural

Distinct from the aforementioned site elements are the large-scale constructed systems that constitute the infrastructure of human society. Whether these infrastructural elements serve a given site or merely pass through it, they have a profound effect on the landscape. They often form linear, networked, or gridded relationships, and extend beyond the boundaries of a site. Infrastructural elements can be conceived as the web that holds an environment together and may be biotic or abiotic. (See Fig. 10.4.)


Figure 10-4. Drain inlet model.
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Infrastructural systems in the landscape include essential frameworks that transmit people and goods, energy, information, and water. Transportation networks include roads of all sizes, from alleyways to streets with bike and bus lanes or from rural back roads to interstate highways. Other networks include railways, light rails, sidewalks, bike paths, and hiking trails. Oil and gas pipelines, as well as power and telecommunications lines, both elevated and buried, structure the landscape with their geometric grids. Water conveyance elements include drinking water pipes, irrigation systems, and sewage networks. Stormwater conveyance systems are composed of aboveground and underground drainage canals, catch basins, and drainage pipes.

As with site elements, we can create infrastructural elements from CAD linework and details or by modeling the geometry. For these larger elements we might also use GIS data. As we explored in the section on diorama, we may find that modeling the exact geometries is overly time consuming or unnecessary for the intended use and opt for using image-based replicas instead. The scale of the infrastructure, desired amount of detail relative to the use of the model, and placement in the model will determine the best method. 

Depending on the focus of the project, infrastructure may serve as the context or subject of illustration. As the subject, infrastructure must be modeled with relevant details and requires more complex modeling. The scope of infrastructural elements is often very large and therefore requires these details to be modeled judiciously in order to keep the model efficient and relevant throughout the design process. (See Fig. 10.5.)


Figure 10-5. Terrabank; perspective illustration and diagram.
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Vegetation

The Importance of Modeling Vegetation

Vegetation is one of the dominant elements of almost any landscape. It distinguishes one habitat type from another, defines spaces, and creates sensory complexity. Vegetation may be a discrete formal element or the ambient backdrop that defines an ecosystem. Vegetation creates visual texture and rhythm, defines boundaries, and provides shelter from sun, wind, and noise.

Modeling vegetation properly can make or break a drawing or animation. Though it is not always necessary that plants be modeled as accurately as possible, it is essential that they be modeled in a way that conveys both the complexity of form and the potential dynamic qualities intended. Because of this complexity, vegetation can be difficult to model successfully.

The Challenges of Modeling Vegetation

Vegetation has a structural complexity that is often more intricate than man-made site elements and architecture (see Fig. 10.6). Furthermore, no two plants are exactly alike, even within a species. When modeling landscapes with a high degree of realism, you must be able to generate multiple versions of a plant that are sufficiently similar in form yet still not identical. Models of even moderately sized landscapes often contain hundreds of plants that necessitate an extremely large amount of geometry.


Figure 10-6. Cypress tree model.
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Plants are dynamic and constantly in flux. Their structure changes in very specific ways as they grow larger and more complex. They produce flowers and fruit, and change with the seasons. All of these changes are unique to each plant species. When a landscape is represented across different phases of implementation, or in different seasons, these differences must be illustrated.

Plants are also affected by natural forces such as wind; thus, they change visibly in real time. Reproducing this complex movement can make a real-time animation extremely convincing. It is very difficult to achieve, however, and coordinating this movement among hundreds of plants adds to the complexity.

Tools

Modeling vegetation has always been one of the most difficult aspects of 3D landscape representation. Luckily, there are now several tools available that allow designers to create and animate plants within their 3D models.

Since 3D modeling of plants is time consuming, using premade plants is often preferred over creating new models for each plant needed on a project. Plant models are often included, either for free or for a fee, in many online databases of 3D models such as Autodesk Seek, Google Warehouse, and TurboSquid. Collections that bundle multiple plants created by the same designer or that have the same parameters are available. This ensures that all of the plants in a project will be about the same size and complexity, and will have a similar degree of realism.

Plant models acquired from these methods typically work very well when you are creating still images from models with a small number of plants. When they are used in larger scenes and animations, however, their shortcomings become apparent. The Vue software package, produced by E-On Software, is designed to help users overcome these problems. Vue is available as a stand-alone application or as a third-party plug-in to popular modeling applications like 3ds Max.

One shortcoming of using individual plant models is the difficulty of distributing and managing all of the necessary plants over a larger site, which might entail hundreds or thousands of plant models. To circumvent this, Vue offers the EcoPainter. With the Eco Painter, a user may create a custom mixture of plants and “paint” them over the landscape, controlling the size and distribution of the plants. 

Due to a lack of movement, digitally modeled plants often look artificial in animations. Animating plants to look as if they are moving in the wind adds an increased sense of realism to animations but can be time consuming. Vue allows users to create and customize the parameters of wind in a scene and to define how plants react to it. 


Figure 10-7. Turk Street Housing; concept model developed during schematic design phase.
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Object in Context

As touched on previously, how you model site elements and objects depends not only on the intended use of the model throughout the design process but also upon how much detail is needed, how the object affects the entire scene, and whether the object is dynamic or static. Objects that provide context and are not specifically in the main field of view can often be modeled with less detail and precision by employing imagery to fill in portions, or even all, of the model. (See Fig. 10.8.)


Figure 10-8. Gateshead Millennium Bridge model.
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Employing methods similar to those used with diorama, we can use simple geometry with images mapped as their materials to create background and peripheral objects. These objects would generally be used solely to provide contextual information and not for interaction, detail complexity, or dynamic changes. Examples of this are a background plane mapped with an image of a distant city, interstate, or forest. It provides us with cues about the setting; however, if viewed from close up, the model would remain flat. (See Fig. 10.9.)


Figure 10-9. Brooklyn Academy of Music; section illustration.
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Chapter 11

Modeling Overview

Components of Polygons

Polygons are the basic building blocks of 3D models. They are geometric units used to form surfaces, which in turn are combined to form 3D objects.

Every polygon is made up of several components, or subobjects. A polygon is made up of a two-dimensional plane (face) bound by a closed circuit of a finite number of straight-line segments (edges) that meet at shared endpoints (vertices). The most basic polygon is a triangle, which has three edges and three vertices. (See Fig. 11.1.)


Figure 11-1. A polygon composed of three vertices, three edges, and a face.
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In computer-based 3D modeling, polygons are linked together, sharing edges and vertices, to form meshes. Polygonal meshes are used to approximate more complex two-dimensional and three-dimensional surfaces. They are combined to form the outer surfaces of three-dimensional forms and can represent either hollow or solid objects. Because objects are an aggregate of these building blocks, they can be manipulated at various subobject levels: vertices, edges, faces, polygons, or elements.

When approximating a given shape or object, polygonal meshes with varying numbers of polygons can be used. Similar to the resolution of an image, the polygon count of a mesh determines how accurately it approximates a surface or object. (See Fig. 11.2.)


Figure 11-2. The smoother polygonal mesh on the right is composed of a greater number of polygons.
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Generally, meshes with a high number of smaller polygons are more accurate than meshes with fewer, larger polygons. This higher polygon count results in a mesh that contains more information and, thus, requires more time to be processed by the computer.

Successful 3D modeling entails creating meshes that are complex enough to represent surfaces to a sufficient degree of accuracy, but are simple enough to avoid unnecessary processing.

In addition to their geometric information, polygons have a value, called the surface normal, which is used to calculate how light affects a surface. The surface normal is a vector that is perpendicular to a surface and that points in the direction in which the surface is facing (see Fig. 11.3). A polygon surface has no thickness and renders only on the normal side, for efficiency. 


Figure 11-3. Surface normals.
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Operations

Polygonal meshes, such as Editable Polys, can be edited at any of the subobject levels: vertex, edge, border, polygon, and element. There are many modifications called operations, which can be performed on these subobjects. Following are some of the most common subobject operations. These operations are available in the Graphite Modeling Tools ribbon. The operations displayed in the ribbon depend on the subobject mode selected.

Modify Selection

Grow expands the selection area by selecting one additional subobject in all directions.

Shrink contracts the selection area by deselecting the outermost subobject in all directions.

Loop selects a horizontal band of subobjects around the object based on the vertical position and height of the current selection.

Ring selects a vertical band of subobjects around the object based on the horizontal position and width of the current selection.

Edit Geometry

Create inserts new vertices or edges into a mesh.

Remove deletes selected vertices and combines polygons.

Slice cuts a mesh into two parts, creating new vertices as necessary to close all polygons.

Slice Plane cuts the mesh based on the position of a movable plane.

Edge Loop (Autodesk calls it Swift Loop) inserts a new horizontal or vertical edge into the mesh around the outside of an object.

Cut inserts a new edge into a polygon from any two points along the polygon’s edges, splitting it into two new polygons.

Relax moves each vertex in a selection to be at an average distance from its neighbors.

Collapse reduces multiple subobjects to one at the group’s center.

Detach removes selected subobjects from the mesh, creating a new object.

Cap creates new polygons based on the current selection to fill holes in the mesh.

Quadrify removes edges to combine triangular polygons into four-sided polygons.

Extrude manually or mathematically projects selected subobjects along their normals.

Weld collapses selected vertices within a given threshold distance into a single vertex.

Chamfer chops off selected vertices or edges, creating a new face that connects the visible edges of the originally selected subobject.

Bridge creates a straight-line connection between two polygons or polygon selections on an object with a new polygon.

Spin changes the direction of a selected edge (or edges) in a polygon by spinning them either clockwise or counterclockwise.

Subdivision and Smoothing

MeshSmooth creates more segments in a mesh and relaxes the vertices to make the mesh appear smoother.

Tesselate creates more segments in a mesh to provide greater detail to a surface.

Modeling from Primitives

The most basic form of modeling can be accomplished by constructing an object through the combination of simple primitives. In Tutorial 11.1, we will build a trellis by constructing three simple boxes, then cloning, and positioning. All we need for this tutorial are the measurements of each piece and the proper position of each in relation to the others.



Tutorial 11.1 Modeling a Trellis from Primitives

The trellis will have three distinct parts: the main posts are 6" wide × 6" long × 8'0" high, the crossbeams are 6" wide × 37'6" long × 6" high, and the rafters are 8'0" wide × 2" long × 2" high. (See Fig. 11.4.) The tutorial specifies the placement of each piece. 


Figure 11-4. Finished trellis image (diagrammatic with measurements).
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1. Set units. Go to Customize ⇒ Units Setup. Set units to US Standard, Feet w/ Decimal Inches (see Fig. 11.5). Click OK.


Figure 11-5. Set Units and Customize Home Grid.
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2. Customize the Home Grid. Right-click on the Snaps Toggle to open Grid and Snap Settings. Click on the Home Grid tab. Set Grid Spacing to 6.0" with Major Lines every 2nd Grid Line and Perspective View Grid Extent = 50. Close Grid and Snap Settings.

3. Create a box. In the Create panel, click the Box button under Standard Primitives in the Geometry menu (see Fig. 11.6). Expand the Keyboard Entry rollout. Enter X coordinate = –18'9", Y = –3'3". Enter Length = 6.0", Width = 6.0", Height = 8'0". Click Create.


Figure 11-6. Create a box and rename it Post001.
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4. Rename the box Post001. 

5. Clone the post as an instance. Right-click on Post001 ⇒ Clone (see Fig. 11.7). Choose to clone as an Instance. Click OK. An instanced copy named Post002 is created.


Figure 11-7. Clone Post001 and move the new post into position.
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6. With Post002 selected, reposition the post using Move and the Transform type-in box. Be sure the Move transform Gizmo is active (press the W key) and change the absolute coordinate Y position to 6'0". (You can also use offset mode by specifying X = –18'9", Y = 2'9", Z = 0'0".)

7. Create the crossbeams (see Fig. 11.8). Create panel ⇒ Box ⇒ Keyboard Entry rollout: Length = 0'6", Width = 37'6", Height = 0'6". The coordinates are not important, as we will use the Align tool to position the crossbeams. Rename the box Crossbeam001.


Figure 11-8. Create the crossbeam.
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8. Position the crossbeam using the Align tool. With Crossbeam001 selected, click the Align tool and select Post001 as the target object. The Align dialog box appears (see Fig. 11.9). Click the box next to X Position (leave the others unchecked for now). Current Object = Minimum; Target Object = Minimum. Click Apply. This moves the crossbeam to align in the X coordinate with the post. Next, align the crossbeam on the Y axis. Check the box next to the Y Position. Current Object = Center; Target Object = Center. Click Apply. Finally, align the crossbeam on the Z axis. Check the box next to Z Position. Current Object = Minimum; Target Object = Maximum. Click Apply. Click OK.


Figure 11-9. Align type-in.
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9. The crossbeam needs to be moved slightly to overhang the post. With Crossbeam001 selected with the Move Gizmo, use the Transform type-in box to shift the crossbeam –1'6" on the X axis. (See Fig. 11.10.)


Figure 11-10. Move the crossbeam into place.
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10. Clone Crossbeam001 as an instance. Align Crossbeam002 to Post002 using the Align tool (you should need to align only on the Y axis). Y Position, Current Object = Minimum; Target Object = Minimum. (See Fig. 11.11.) 


Figure 11-11. Cloned crossbeam.
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11. Copy the posts along the length of the crossbeams by using the Array tool (see Fig. 11.12). Select Post001 and Post002 by holding the control key. Tools ⇒ Array. Under Array Transformation, set the X value to 8'6". Under Array Dimensions, set the 1D count to 5. Click OK. (See Fig. 11.13.)

12. Now create the rafters (see Fig. 11.14). Create panel ⇒ Box. Expand the Keyboard Entry rollout: Length = 8.0', Width = 2.0", Height = 2.0". Click Create. Rename the box Rafter001.


Figure 11-12. Array the posts.
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Figure 11-13. Crossbeams and posts.
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Figure 11-14. Create the rafters.

[image: 902943c11f014.tif]


13. Again using the Align tool, position the rafter. With Rafter001 selected, click the Align tool and select Crossbeam001 as the target object. X Position and Y Position: Current Object = Minimum, Target Object = Minimum ⇒ Apply. Z Position: Current Object = Minimum, Target Object = Maximum ⇒ Apply. Click OK. Move the beam –0'9" on the Y axis so that it overhangs both crossbeams evenly (see Fig. 11.15). Use Top and/or Left Views to ensure placement.


Figure 11-15. Move the rafter into place.
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14. Copy the rafter using the Array tool (see Fig. 11.16). Select Rafter001 ⇒ Tools ⇒ Array. Under Array Dimensions, set the 1D count to 75. Click the ⇒ next to Move under Array Transformation. (This allows you to specify how far the array spreads from the original selection.) Enter X = 37'10", Y = 0'0", Z = 0'0". Click OK.


Figure 11-16. Clone the rafter using the Array command.
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15. The modeling portion of the tutorial is complete (see Fig. 11.17). To make it easier to export, you may want to group similar parts and/or the entire object. Press the H key to bring up the Select From Scene dialog. Choose all of the rafters by holding down Control while selecting from the list. Click OK. Group ⇒ Group, then name the group: Rafters. Do the same for the Posts and the Crossbeams. Select the Rafters, Crossbeams, and Posts groups. Group ⇒ Group, then name the group: Trellis. 




Figure 11-17. Completed trellis.
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Chapter 12

Using CAD Linework

There are times when we already have detail drawings for complex objects or it might be easier to draft the linework in CAD to establish the component relationships. This chapter looks at the process of using drafted AutoCAD linework as a basis for 3D modeling in 3ds Max. We will take two-dimensional construction drawings for a bench (see Fig. 12.1) and use extrusions to build a digital model.


Figure 12-1. Bench construction drawing.
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Refining and Importing

Refinement of CAD Linework

AutoCAD linework can be imported directly into 3ds Max. To minimize errors and effort, there are steps we take before importing the linework to ensure proper setup.

Working with a copy to avoid harming the original file, ensure that all linework not needed in the modeling process is deleted or moved to a separate layer and hidden in AutoCAD. For all linework that will be used, properly separate components into layers. The bench has four groups of components: steel frames, wooden planks, steel end plates, and screws. The linework for each of these groups is placed on its own layer. If a line in a two-dimensional drawing is shared with more than one component, it must be copied to the layer of each component.

Additionally, each component should be made of one or more closed polylines. In the bench linework, the cross section of each plank is a closed polyline, as are the inside and outside of the frame pieces. The inside polyline of the frame has been copied to the steel plate layer to serve as the cross section of the plates as well.

Note that both AutoCAD and 3ds Max use coordinates to position objects in the world. The position of the linework in AutoCAD will also be transferred to 3ds Max. This is important to note for two reasons. First, if the linework is positioned far from the origin, it may initially be difficult to locate in 3ds Max; however, it can be found by selecting a component or piece of a component and pressing Z to zoom in to the selection. Second, if you have multiple objects and separate them into distinct files or import each separately, their spatial relationships will remain the same. 

When imported linework is very far away from the origin, 3ds Max can have problems properly displaying or navigating around the linework. This often happens with site linework that might have come from a survey, and it may be necessary to reposition the linework so that it is near the origin in 3ds Max. (See Fig. 12.2.)


Figure 12-2. Separated AutoCAD linework.
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Tutorial 12.1 Importing and Orienting CAD Linework


1. Open 3ds Max and select Customize ⇒ Units Setup. (See Fig. 12.3.) Make sure the units are set to match the units of your AutoCAD file. In this case, we are using US Standard, Feet w/Decimal Inches.


Figure 12-3. Units setup.
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2. Select File ⇒ Import, navigate to your AutoCAD file, and select Open. The AutoCAD DWG/DXF Import Options dialog appears. In the Geometry tab, Derive AutoCAD Primitives by ⇒ Layer. This converts each layer to an object in 3ds Max, since each layer contains a single component. For other projects, it may be more appropriate to have the primitives defined more narrowly by entity or some other parameter. In the Geometry Options, we leave the default settings as they are; however, “Weld nearby vertices” should be noted. With more complex linework, welding the vertices can create problems where pieces overlap or lines are very close together. With simpler linework or with linework in which the lines do not cross, such as contour linework, “Weld nearby vertices” can help create single polylines if they are unknowingly broken.

In the Layers tab, uncheck all layers that will not be used. 

In the Spline Rendering tab, make sure Enable in Renderer and Enable in Viewport are both unchecked. We will use the linework to generate geometry and do not want the linework itself to render or display with any thickness. Click OK. The AutoCAD polylines have been imported as 3ds Max splines. (See Fig. 12.4.)


Figure 12-4. DWG import dialog boxes.
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3. Navigate to the imported linework in the perspective viewport. Notice that it is oriented horizontally on the X-Y plane. Select all of the linework. Right-click the Rotate button to activate the Rotate transform type-In dialog. Under Offset: World, enter 90 for X and hit Enter to rotate the linework 90 degrees. (See Fig. 12.5.)




Figure 12-5. Imported linework before and after rotating.
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Extruding CAD Linework



Tutorial 12.2 Modeling a Bench Using Extrusion

The bench geometry will be extruded from the imported cross-section linework, while a longitudinal section will be used to understand placement and spacing information (see Fig. 12.6).


Figure 12-6. The longitudinal section used for reference.
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1. Start with the planks. Select all the plank linework. In the Modify panel, select Extrude from the modifier list. For Amount, enter 4'0". It might be easier to hide this piece while working with the other geometry. To hide, with the planks selected right-click and select Hide Selection. To unhide, right-click in the viewport, select Unhide by Name, and select the planks.

2. Now we will extrude the frame pieces. We know from the longitudinal section that there are three 4"-wide frame pieces. Select the frame. Apply the Extrude modifier with an Amount of 0'4". 

3. We can also see from the longitudinal section that the first frame piece begins 6" in from the ends of the planks. Right-click the Move button to bring up the Move transform type-In. Under Offset: Screen, enter a Y value of –6" to move the frame.

4. We know the frame pieces are 16" at their centerlines. To create the second and third frame pieces, go to Tools ⇒ Array. Under Incremental ⇒ Move, enter a Y value of –16". (See Fig. 12.7.) Note that the dialog automatically converts –16" to –1'4". For Array dimensions, choose 1D and a count of 3. (See Fig. 12.8.)


Figure 12-7. Array dialog box.
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Figure 12-8. Bench with frame pieces in place.
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5. Next we will create the steel end plates. Select the end plate spline and extrude it 3/16". (Note that even if 3ds Max shows measurements in decimal inches, you can enter 3/16" and it will be converted to the standard unit.) Right-click the Snaps button and set Snaps to Vertex Only. If not in Wireframe mode, use F3 to enter Wireframe mode. Select the newly extruded plate, use L to change to Left View, then use zoom or Z to center the plate in the viewport.

6. Turn on Snaps. Use the Move tool W to move the plate so that it sits directly against the outside of the first frame piece, snapping the corner of the plate to the corner of the frame. (See Fig. 12.9.) The cursor changes to perpendicular arrows when hovered over the vertex, to allow you to move the component.


Figure 12-9. Moving the plate into place.
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7. Select the Move tool and copy the steel plate by holding down Shift and dragging the tool along the Y axis with the Gizmo. When the Clone Options dialog appears, be sure Copy is selected under Object. Position the second plate at the other end of the bench, using the same method as the first.

8. Use F3 if necessary to view the bench in Smooth + Highlights mode. It is apparent that the screws shown in the construction documents would not be significantly visible in the 3D model, so it is unnecessary to model them. Hide the screw linework by selecting that layer, right-clicking, and selecting Hide. (See Fig. 12.10.)


Figure 12-10. A completed bench module.
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9. Designed to be used in a series, the finished bench will include several modules abutted to each other. Select all the components and click Group ⇒ Group. Enter “bench module” for the name.

10. To copy successive bench modules, select the group and go to Tools ⇒ Array. Each module section is 4' long. Under Incremental ⇒ Move, enter a Y value of 4'. For Array dimensions, choose 1D and the desired count. Click OK. The bench is complete. (See Fig. 12.11.)




Figure 12-11. The completed bench.
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Chapter 13

Polygon Modeling

The preceding tutorials are more suitable for creating synthetic site objects that are combinations of simple and repetitive geometries. With vegetation and other natural forms, we rarely have CAD details that can be imported to model from with any success. This chapter looks at the process of using reference images as a basis for 3D modeling in 3ds Max. We will use a photograph of a tree branch and make a polygonal mesh to model the branch. (See Fig. 13.1.)


Figure 13-1. The completed branch model.
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Image Planes

Similar to the methods used in the diorama examples, an image mapped to a plane can provide a reference for digital “drawing” within the modeling program. We can use any image, such as a photograph, drawing, or sketch, and trace around it to create original geometry. The process is similar to copying a two-dimensional image with tracing paper, but it occurs in three-dimensional space.

The image gives us information regarding two dimensions (in this case, the X and Y dimensions). One possible way of working is to use two photos of the same object in the same position but taken from two different angles. For the tree branch, we will first build the model around a two-dimensional plane and then move parts of the model on the Z axis to mimic a real branch. 

Selecting and Preparing the Photo

It is important to choose a photo that accurately portrays the object to be modeled. Since we are using a photo to reference two dimensions, it should be taken from an angle that is perpendicular to those dimensions and parallel to the third dimension. This typically means that the photo should be taken from an angle perpendicular to the largest or most important face or axis of the object. In the case of the branch, this means a photo perpendicular to the long axis of the branch. This minimizes the effect of perspective, by which the parts of the object farther from the camera appear smaller.

To make the tracing work more easily, the photo should isolate the object to be modeled as much as possible. If possible, the object should be photographed with a plain, flat backdrop, such as a white sheet. If the photo includes other objects or surfaces, you may remove these parts of the image using Photoshop or other image-editing software. (See Fig. 13.2.) Crop the photo so that the object occupies as much of the photo as possible.


Figure 13-2. The photo of the branch with the background removed.
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Tutorial 13.1 Positioning a Photo in 3ds Max

To display the photograph in our digital world, we will create a material that projects the photo onto a plane, similar to the process used in the diorama section.


1. Open 3ds Max and go to Customize ⇒ Units Setup. Select the system of units you would like to use. If you know the dimensions of your object or one of its parts, use the units of those dimensions. We know the branch is XX feet long, so we will select US Standard, Feet w/Decimal Inches. (See Fig. 13.3.)


Figure 13-3. Units setup.
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2. In the Create panel, select Plane. Expand the keyboard entry rollout. We know the branch is roughly 6' in total length by 2' in total width. The branch stretches nearly from one end of the photo to the other, so we will make the plane 6' by 2'. Enter the correct dimensions and click Create. (See Fig. 13.4.) We use the actual dimensions of the branch so that we can begin modeling the branch in real-world units. It would also be possible to create the plane using the known pixel dimensions of the image and then scale the plane up to real-world size.


Figure 13-4. Creating the plane.
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3. Press M to open the material editor. We will be using the Slate Material Editor. If the material editor does not say “Slate Material Editor,” go to Modes and select it. Find the Standard Materials rollout in the Material/Map Browser on the left-hand side of the window. Drag the material button labeled Standard into the View1 materials viewport.

4. In Windows, open the folder that contains your photo. Drag the photo from the folder into the material editor viewport. You can see that the photo is now shown as a map. Assign the map to the Diffuse Color channel of the material by clicking and dragging from the Connection socket of the map to the Diffuse Color socket of the material.

Instead of dragging the image from the folder, note that it is also possible to browse to it by double-clicking on Diffuse Color in the material. This opens up the Material Parameter Editor. Under the Blinn Basic Parameters rollout, next to the Diffuse Color rectangle, there is a smaller box, which, when clicked, opens up the Material/Map Browser. Select Bitmap ⇒ OK, browse to the image, and click OK. The small box will now display an M to indicate that the Diffuse Color channel is mapped to an image. (See Fig. 13.5.)


Figure 13-5. Creating the material.
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5. If necessary, position and resize the material editor so that you can see the plane you created in your scene. To assign the material you created to the plane, click and drag from the Output socket on the right-hand side of the material to your plane. 

In some instances a scene might be too crowded to drag and drop accurately. With the plane selected in the scene, you can also click the Assign Material to Selection button under the menu commands.

Figure 13-6. 

6. With the material still selected, click on Show Standard Map in Viewport in the toolbar at the top of the material editor. You should now see the photo mapped onto the surface of the plane.

7. Depending on the dimensions of your photo and the dimensions of the plane you created, it may be necessary to resize or rotate the image map to ensure that it is displayed correctly. Double-click on the Map #1 title bar in View1. In the Material Parameter Editor on the right-hand side under the Coordinates rollout, the map has Tiling checked and set to 1.0, and Use Real-World Scale is turned off. This means that the photo will automatically be stretched to fit our plane. However, if the orientation of the material is incorrect, under Angle, enter a rotation angle of 90 degrees for the W dimension, and click Rotate. (See Fig. 13.6.)




Figure 13-6. The plane before and after rotating the image map.
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Tutorial 13.2 Modeling with Editable Poly

Now that the photograph is correctly displayed on the plane in the viewport, we can begin modeling the branch. We will start with a cylinder and convert it to an editable poly—a type of polygonal mesh—which we will then sculpt into the form of the branch.


1. Select Cylinder from the Create Panel. Click and drag in the viewport to create a cylinder at the center of the base end of the branch. The cylinder’s radius should be the same as that of the branch. Press F4 to turn on Edged Faces and increase the number of sides of the cylinder until it looks sufficiently round.

2. Press the A key to turn on the Angle Snaps Toggle. Press E to select the Rotate tool. Click and drag on the appropriate axis of the Gizmo to rotate the cylinder 90 degrees to be in the same orientation as the branch in the photo. (See Fig. 13.7.) If the branch is not parallel to the cylinder at this point, you need to rotate the cylinder on the X-Y plane.


Figure 13-7. The cylinder before and after rotation.
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3. With the cylinder selected, right-click in the viewport and select Convert To: ⇒ Editable Poly. Expand the Graphite Modeling Tools ribbon above the viewport. Click the Polygon button to enter the polygon subobject level. (See Fig. 13.8.)


Figure 13-8. The Polygon button within the Graphite Modeling Tools.
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4. In the Polygons section of the Graphite Modeling Tools, click the Extrude button. Click and drag to extrude the top end of the cylinder (now a polygonal mesh) an inch or two along the length of the branch. This creates a new polygon as the new face at the end of the mesh. If necessary, with this polygon still selected, use the Move tool to center the polygon on the branch. If, at this point along the branch, it is running in a different direction from the end of the mesh, use the Rotate tool E to rotate the polygon accordingly. (See Fig. 13.9.)


Figure 13-9. The newly extruded polygon after adjustment.
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5. Continue repeating the process of extruding the polygon at the end of the mesh, centering it on the branch, and rotating it to the proper orientation. As the branch tapers off, it will be necessary to shrink the polygon. At the first point at which the polygon is noticeably larger than the branch, use the Scale tool R to shrink it to the correct size. When the branch splits, follow the path of the largest branch section.

6. Once you’ve reached the end of the branch, click the Polygon button to exit the polygon subobject level. Go back to the first point at which a branch segment branches off from the main structure. Just as before, create a new cylinder of the proper size, about an inch along the branch segment. Rotate the cylinder to the proper orientation. (See Fig. 13.10.) For now, we will leave this new segment unattached to the main branch, so that we can reposition the segment later.


Figure 13-10. Beginning the new branch segment.
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7. Convert the cylinder to an Editable Poly. Using the same process as before, model this segment of the branch.

8. Exit the polygon subobject level. Go to the Hierarchy panel and select Affect Pivot Only. Press T to switch to Top view and pan to the base of the branch segment. Use the Move tool to move the pivot point of the branch segment straight into the middle of the main branch. Use the Rotate tool to rotate the pivot point until the X axis is parallel to the branch segment. Turn off Affect Pivot Only. This ensures that the branch segment will rotate properly around the branch. (See Figs. 13.11 and 13.12.)


Figure 13-11. The pivot point before.
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Figure 13-12. The pivot point after.
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9. Press P to return to Perspective view. Use the Rotate tool to reposition the branch segment. After it is in the desired position, enter the polygon subobject level and extrude the base polygon of the segment into the main branch. (See Figs. 13.13 and 13.14.)


Figure 13-13. The segment before rotating.
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Figure 13-14. The segment after rotating.
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10. With the segment selected, go to the Create panel and select Compound Objects from the drop-down list. Select Boolean. Under Operation, select Union. Click the Pick Operand B button, then select the main branch. This fuses the two editable polys together into one object. Right-click and convert the new Boolean object back into an editable poly.

11. The branch segment is now rotated in the Z dimension, but it is likely that the segment would curve in the Z dimension as well. With the branch selected, click the Vertex button to enter the vertex subobject level. Select a ring of vertices where you would like the branch segment to bend.

12. Click the Soft Selection button, located beneath the subobject buttons. Soft Selection selects vertices to decreasing degrees the farther they are from the selected vertices. When the vertices are modified, those originally selected will be affected the most, while the vertices at the edge of the soft selection will be affected the least. You can choose which pixels are selected and to what degree by the color gradient applied.

13. Move the selected pixels on the Z axis. If too many or too few vertices were selected, undo the move Ctrl+Z and change the Falloff value in the Soft Selection section of the Modify panel, then try again. (Figs. 13.15 and 13.16) You can also adjust the Pinch and Bubble parameters in the Soft Selection menu to change the way the pixels are selected.


Figure 13-15. The unbent branch with a vertex soft selection.
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Figure 13-16. The branch segment after moving vertices.
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14. Repeat these steps to model the remaining branch segments, rotate and position them, connect them to the main branch, and bend them along the Z axis. (See Fig. 13.17.)




Figure 13-17. The final branch model before and after adding texture.
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Chapter 14

Spline Modeling

The previous chapters in this section explored modeling by combining primitives, extruding from primitives, or extruding from created shapes or linework imported from CAD. Occasionally, some of the objects that populate the environment require a more complex surface, especially if they contain surfaces that are curved or organic. Spline modeling and NURBS surfaces offer a more free-form method of creating these complex surfaces. In this chapter, we look at how to model a complex surface building from linework drawn in the 3D program to which a surface can then be applied, creating atypical geometries. (See Fig. 14.1.)


Figure 14-1. View of housing buffer; section perspective.
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Components of Splines

All shapes are composed of lines and curves defined by mathematical equations. A spline is a piece of a shape, often referring to a smooth curve that is defined by the position and tolerance of the vertices, or control points. (See Fig. 14.2.) A spline can be two-dimensional, with all its vertices on a single plane, or three-dimensional. Splines allow the user to intuitively create curved lines with high precision.


Figure 14-2. Example of three different splines, defined by their relationships to vertices.
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Changing the positions of vertices and tolerance controls a spline’s shape, making it more or less curved. Additionally, 3D modeling programs typically allow the creation of several vertex types. In 3ds Max, we have the option to create splines using four different types of vertices: corner vertices create a sharp point with the spline linear to both sides of the vertex, smooth vertices create a nonadjustable curve that depends on the spacing of the other vertices, Bezier vertices create an adjustable curve, and Bezier corner vertices create a spline with an adjustable curve on one side and a straight line on the other. (See Fig. 14.3.) Initially, a single spline is created with only one type; however, after creation, each vertex can be changed to a different type. This enables the user to change the underlying mathematical relationship between the vertices and, thus, the way in which the spline is formed in relation to its vertices.


Figure 14-3. The spline on the top is defined by corner vertices; the spline on the bottom uses smooth vertices.
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Splines are useful in environment modeling because they allow us to create complex linework containing smooth curves that can be manipulated and refined. They are also useful for drawing an underlying framework around which a surface can be curved. This is especially useful for objects that are composed either entirely or partially of an organic, curvy surface, including both constructed and natural forms. Instead of creating the object from an assembly of primitive geometries, we can use splines to draw an atypical framework and then employ one of several operations to create the surface, depending on complexity. 

What Are NURBS?

NURBS, which stands for Non-Uniform Rational Basis Spline, refers to a special type of spline that is particularly useful in 3D modeling. NURBS, also called NURBS curves, can be used to form NURBS surfaces. NURBS surfaces can be tailored to form an extremely broad array of geometries with a high degree of accuracy. NURBS can be used to model both standard geometries and free-form geometries; however, unlike faceted models generated through use of polygons and meshes, the amount of information required is smaller; thus, NURBS can be processed more quickly.

Similar to other splines, NURBS are partially defined by the position of their control points. NURBS have additional features, however, that make them more controllable and, thus, more accurate. These include elements called knots, a property called degree, and an evaluation rule. Knots are the values that designate the extent of a control vertex’s influence over the curve of the spline. Degree refers to the amount of curvature of the spline with a degree of 1 being a line or polyline, 2 a circle, and free-form curves somewhere between 3 and 5. The evaluation rule is the equation that contains all the parameters of the control points, degree, and knots and is used to compute the curve. 

In 3D modeling it is possible to start out modeling with a traditional spline and then convert it to a NURBS object, allowing for the ease of drawing with Bezier vertices and then adding the flexibility of the NURBS features.

Operations

Lathe

One of the easiest methods for constructing an object normally made from an assembly of complex geometries is using a single spline to draw the partial outline and then applying a lathe modifier, which rotates the curve about an axis, creating a surface (see Fig. 14.4). The object can then be converted to an editable form for further refinement. This method works best on an object that is symmetrical or mostly symmetrical.


Figure 14-4. Using a spline to draw a partial outline of a birdbath, a lathe modifier is then applied to complete the form.
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Loft

Lofting combines two splines, two shapes, or a spline and a shape to form a 3D object. The first spline, known as the shape, is extended along the second spline, known as the path. The shape is essentially repeated, perpendicular to the path, at every point along the path. This results in the shape being extruded continuously along the path. The ULoft and UVLoft functions similarly use splines to create a complex surface; however, they allow the use of multiple shapes along the path. (See Fig. 14.5.)


Figure 14-5. The pipe is created with two attached circles, or a shape, lofted along an arc. The glass is formed using the ULoft function, creating a surface between multiple circles.

[image: 902943c14f005.tif]


Spline Cage 

One method of using splines is to build a spline cage—a network of splines connected through their shared vertices. It is formed to approximate the shape of a desired object. A surface is then applied, guided by the spline cage, to create the appearance of a solid object. (See Fig. 14.6.) In 3ds Max, this can be accomplished by drafting a series of splines, connecting the vertices using the connect/refine function, and then applying a surface modifier.


Figure 14-6. A spline cage and the surface formed from it.
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Technique



Tutorial 14.1 Creating a Road Profile Using Loft

The following tutorial demonstrates using lofted splines to create a road profile with curbs and sidewalks (see Fig. 14.7). It is possible to draft the linework in AutoCAD, import the linework, and create the profile using Loft without drafting in 3ds Max; however, this tutorial shows the creation of the entire profile in 3ds Max. When creating the linework through either method, it is important that the shapes created be closed splines; therefore, border segments between shapes will overlap.


Figure 14-7. Road profile and dimensions.
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1. Set units. Go to Customize ⇒ Units Setup. Set units to US Standard, Feet w/Decimal Inches. Click OK.

2. Set grid. Right-click on the Snaps Toggle to open Grid and Snap Settings dialog. Click on the Home Grid tab. Set Grid Spacing to 1.0" with Major Lines every 12th Grid Line. Adjust the Perspective View Grid Extent as needed (we will be drafting from Top view, so the grid will show in this view no matter what extent is set).

3. Set Snaps. Click on the Snaps tab. Make sure only Grid Points and Vertex are selected. Close Grid and Snap Settings. Throughout the exercise, you may press G to toggle the grid on and off as needed.

4. Prepare to draw the road surface profile. Press T to enter Top view. Turn on Snaps. Create panel ⇒ Shapes ⇒ Splines. Click on Line. Under Creation Method, make sure Corner is selected for Initial Type.

5. Using Grid Snaps, keyboard entry function, or other tools such as Mirror, draw the road surface profile centered on the Y axis (see Fig. 14.8). Name the shape “road profile 001.” Be sure that the shape is a closed spline.


Figure 14-8. Road profile created by drawing a line.
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6. Draw the initial curb profile shapes. At first, draw these with 90-degree angles in place of curves. Name the shapes “curb profile left” and “curb profile right.”

7. Refine the curves of the curb profiles. With the left curb shape selected, enter Vertex subobject mode by pressing 1 or clicking the Vertex button under the Selection rollout. Select the vertex at the lower edge of the curb wall. In the Modify panel ⇒ Geometry rollout, find the Fillet button and value field. Enter a value of 0'1" and click the Fillet button. Select the top corner of the curb wall; Fillet = 0'3". (See Fig. 14.9.) Repeat this process with the right curb. (Note that instead of drafting two shapes, the Mirror tool can be used to clone one.)


Figure 14-9. Curb profile before and after fillet.
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8. Draw the sidewalk profiles. Name the shapes “sidewalk profile left” and “sidewalk profile right.”

9. Draw the road base profile. The top edges of the road base profile will overlap and be colinear with the bottom edges of the road profile, curb profile, and sidewalk profile. Name the shape “road base profile.” You should now have six shapes: two curb profiles, two sidewalk profiles, one road surface profile, and one road base profile. (See Fig. 14.10.)


Figure 14-10. Completed road profile shapes.
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10. When we loft the shapes, we want all of the pieces to maintain their relationship to each other. To maintain consistency, reset the pivot point of each shape to the same point by selecting the shape, then, in the Hierarchy panel, click the Affect Pivot Only button. Press W to select the Move transform. In the transform type-in, enter 0 for each axis and press Enter. (See Fig. 14.11.) Repeat the process for all shapes. When finished, click to deselect the Affect Pivot Only button.


Figure 14-11. Reposition the pivot points of each shape to maintain consistency while lofting.
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11. Continuing in Top view, draw a single line on the ground plane to define the path of the road. (See Fig. 14.12.) Name the line “road path.”


Figure 14-12. A path is used to guide the road shapes using loft creation.
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12. Loft the road surface shape along the path. Select the path. Under Create panel ⇒ Geometry ⇒ Compound Objects, locate the Loft button. In the Creation Method rollout, make sure Instance is selected. Click the Get Shape button and select the road base profile shape. The shape should now be lofted along the path to form a three-dimensional road surface.

13. Repeat the lofting procedure with the road base, both curbs, and both sidewalks. After all the pieces are lofted, the path can be adjusted and modified as needed. The lofts will transform according to the adjustments made to the path. (See Fig. 14.13.)




Figure 14-13. Completed road profile.
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Chapter 15

Materiality

In the real world, objects are physically composed of materials, from organic tissue and natural elements to steel and plastic. Materials affect the appearance of an object, as well as define the object’s form, convey its structural stability, and influence our perception of the object and context surrounding it. (See Fig. 15.1.)


Figure 15-1. Material imagery samples.
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Virtual objects differ in that materials do not structurally define them. Although still informed by the underlying material, designers create forms through a variety of methods, including those discussed in previous chapters. However, virtual materials still play a crucial role in 3D modeling. Similar to physical materials, they define the appearance of objects and affect the viewer’s perception not only of the object but also of the entirety of the space. The proper creation and application of materials is essential to making beautiful renderings and animations, crafting convincing spaces, and conveying compelling experience.

In 3D modeling, a material is a collection of properties that is applied to the surface of an object. Materials define the way in which virtual light affects the surface, and, thus, how the surface appears when rendered. Materials determine the perceived color, texture, reflectivity, translucency, and other properties of a surface. The application of material to surface also relays cues about size, structural capacity, weight, and orientation of the object to which it is applied.

Material Types

Through rendering, 3D modeling programs are capable of using a variety of processes for translating images through the geometry, lighting, and materials of a scene. These processes are managed through the use of tools called renderers. Since different renderers are made to respond to the properties of materials in different ways, certain materials work better with some renderers than with others. Knowing which renderer will be used in a project is crucial for the proper selection of materials. Material selection and renderer selection depend not only upon each other but also upon the demands of the resulting imagery.

Standard Materials

Scanline rendering is a process that creates images one horizontal row of pixels at a time by processing only the geometry that intersects that line. Scanline renderers have been used for decades and are included as the standard renderers in many modeling applications. The default scanline renderer will produce a sufficient image in generally a shorter amount of time; however, it will not usually be as convincing as an image from a more robust renderer.

In 3ds Max, standard materials are available for use with the scanline renderer (see Fig. 15.2). These materials have several definable attributes, which produce a uniform color over a surface, and their parameters can be adjusted to reflect different types of materials such as metals or glass.


Figure 15-2. Standard Materials in 3ds Max Slate Editor.
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The basic attributes that define a standard material are diffuse color, ambient color, specular color, and opacity. Diffuse color is what we typically think of when we speak of an object’s main color. It is the hue of the object generated by diffuse reflection—when light bounces off the object’s surface at multiple angles. 

Ambient color is the color of a material when lit only by ambient, or indirect, light. In other words, it is the color of the material where it is in shadow. A material’s ambient color should typically be darker than its diffuse color and is often more blue, but this can vary depending on the light source used. 

A material’s specular color affects where light bounces off of a surface in a uniform direction. This is the type of reflection seen in mirrors and also generates highlights or glare on other smooth surfaces. Typically, a material’s specular color is white, or the color of the light source. For softer, less shiny materials, a specular color closer to the object’s diffuse color might be used.

In standard materials, the shader used determines how these three colors are combined on the surface of the object. A shader is an algorithm used to calculate the rendering of a surface, and each model is usually developed to serve a particular purpose. Many shader models are available. The Blinn shader, for instance, is a general-purpose shader, while the Metal and Translucent shaders specialize in metallic and translucent materials, respectively.

Opacity or translucence determines how much light is able to pass through the object. A thin piece of glass would be almost completely translucent, while a sheet of steel would be completely opaque.

See Fig. 15.3 for a rendered scene showing these different properties.


Figure 15-3. Rendered scene diagramming different properties.
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In addition to the previously mentioned attributes, there can be levels of refinement of each, depending on the shader. Materials also contain the ability to assign maps, or image files, to use with these attributes. This means that each attribute can be assigned an image file that blends with the basic parameter to enhance its appearance. For instance, a map can be assigned to the specular color, and wherever that color would appear on the object, the map would appear. A use for this might be to fake a reflection or to add variation in the color. 

Another use of maps in materials is found with bump mapping and displacement. Materials can use a bump map to create the appearance of an irregular surface; places in the map that are white appear to be raised, while places that are black appear lower. Similarly, a displacement map changes the geometry of the surface, actually raising areas mapped to whiter areas. Maps are added to the material using a process similar to that described in the diorama section.



Tutorial 15.1 Creating a Standard Material in 3ds Max


1. Open a previous 3ds Max project or create a new object.

2. Press M to open the material editor. Check that the mode is set to Slate. Modes ⇒ Slate Material Editor. (See Fig. 15.4.) 


Figure 15-4. The Standard material is located under Materials ⇒ Standard.
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3. Locate the Standard Material in the Material/Map Browser window. If the window is not visible, press O or go to Tools ⇒ Material/Map Browser to view the window. Within the Materials rollout, there is a Standard rollout. Expand both of these, then click and drag the Standard material into the View window.

4. Double-click the Material in the View window to view its parameters in the Parameter Editor window. Again, if the Parameter Editor is not visible, press P or Tools ⇒ Parameter Editor.

5. Under the Shader Basic Parameters rollout, select a type of shader. Each one will alter the parameters available. We will keep the default Blinn shader for now. Note the options on the left side, especially Wire and 2-Sided. 

6. Under Blinn Basic Parameters, the Diffuse, Ambient, Specular, Specular Highlights, and Opacity parameters can be changed to create different colors, hues, and translucency. 

7. Click and drag the output node to the object in the model to apply the material. To see the material in the model, click the Show Standard Map in Viewport button located under the menu bar. If your scene contains many objects, you can bring up the Select From Scene dialog H, select the object, and click the Assign Material to Selection button also located under the menu bar.

8. Click the Render Production button or press Shift+Q to render the scene with default settings to see the result of the material adjustments. (See Fig. 15.5.)






Figure 15-5. Output node, Show Standard Map in Viewport, Assign Material to Scene button, and Render Production button.
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Photometric Materials

Modern renderers are available that go beyond the techniques of scanline renderers to generate more realistic-looking images. These include mental ray (officially styled without capitals), which is included by default with 3ds Max, V-Ray, and, in 3ds Max 2012, iray.

These renderers are capable of physically modeling light and, thus, are referred to as photometric. In conjunction with these renderers, photometric lights and photometric materials are specifically designed to be used together. Contemporary, photorealistic renderings typically use a photometric renderer, lights, and materials.

3ds Max includes a very robust photometric material called the Arch & Design material (see Fig. 15.6), which is used in conjunction with the mental ray renderer. This material has an extremely wide array of attributes, which may be customized to mimic most any physical material. Also included are Autodesk Materials, which are specific configurations of the Arch & Design material designed to mimic a particular group of materials, such as metals, plastics, and different types of water.


Figure 15-6. Arch & Design material in 3ds Max.
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Tutorial 15.2 Applying Photometric Materials to Objects


1. Open a previous 3ds Max project or create a new object.

2. Press M to open the material editor. Check that the mode is set to Slate: Modes ⇒ Slate Material Editor.

3. To use mental ray materials, the mental ray renderer must be activated (see Fig. 15.7). Go to Rendering ⇒ Render Setup to bring up the Render Setup dialog. In the Common tab, scroll down to the Assign Renderer rollout. Expand the rollout and click the button across from Production to select the mental ray renderer. Click OK and close the Render Setup dialog.


Figure 15-7. Enable the mental ray renderer to view the mental ray materials.
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4. In the material editor, locate the mental ray materials in the Material/Map Browser window. Within the Materials rollout is the mental ray rollout. Expand both of these; click and drag the Arch & Design material into the View window (see Fig. 15.8).


Figure 15-8. Arch & Design material is located under the mental ray rollout.
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5. Double-click the Material in the View window to view its parameters in the Parameter Editor window.

6. Adjust the parameters.

7. Click and drag the output node to the object in the model to apply the material. To see the material in the model, click the Show Standard Map in Viewport button located under the menu bar. If your scene contains many objects, you can bring up the Select From Scene dialog H, select the object, and click the Assign Material to Selection button also located under the menu bar.

8. Click the Render Production button or press Shift+Q to render the scene.






Special-Purpose Materials

In addition to these commonly used materials, 3D modeling applications often include a variety of other materials for use in particular situations.

The Matte/Shadow/Reflection material in 3ds Max is used for capturing shadows and reflections on a surface while not rendering the surface itself (see Fig. 15.9). This is useful when rendering partial images in 3ds Max and completing them in a raster graphics editor such as Photoshop.


Figure 15-9. Matte/Shadow/Reflection material.
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Some materials are used to combine multiple materials into one. In 3ds Max, the Blend material controls a mix of two other materials, which can be animated over time, while the Composite material allows a more nuanced combination of up to 10 materials. 

The Multi/Sub-Object material is used to group multiple materials, allowing them to be more easily assigned to multiple objects or subobjects. After the Multi/Sub-Object material is assigned to an object or group, the material each object or subobject receives can be set or changed by changing the Material ID attribute of that object or subobject. (See Fig. 15.10.)


Figure 15-10. Blend, Composite, and Multi/Sub-Object materials.
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Tutorial 15.3 Animating a Material


1. Open a previous model or create a new scene in 3ds Max.

2. Create a standard material. Double-click Diffuse Color to open parameters. Under the Blinn Basic Parameters rollouts, click on the color bar next to Diffuse to open the color selector. Select a color and click OK. Drag a wire from the output node to an object in the scene. Resize the material editor window as necessary so that both the scene and the editor can be seen. 

3. Turn on Auto Key and move the time slider to a different position.

4. Click on the color bar next to Diffuse again and choose a different color. Notice that two controller floats appear in the view window connected to the material. Click the Auto Key button to turn off Auto Key. Notice that there is a new key in the timeline. (See Fig. 15.11.)


Figure 15-11. Use Auto Key and adjust the material along the timeline.
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5. Click the Play button at the bottom to see the material change over time (see Fig. 15.12).




Figure 15-12. Material change sequence.
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Relationship of Material to Surface

A material is basically a two-dimensional image projected onto a three-dimensional object. A material as color will be applied uniformly across surfaces; however, if we are using a map image within the material, we need to be able to control how the map appears on the surface with respect to orientation and scale. By assigning a material UVW coordinates, we can align the orientation of the map to the object surface and control the scale of the texture so that it is consistent with the scale of the object. Material UVW coordinates relate the image to the object’s XYZ geometry coordinates, respectively. 

There are different types of UVW mapping, which specify how a map is projected onto an object’s surface. The object’s geometry in addition to the desired effect determines which mapping should be used. Three basic types of mapping are planar, box, and spherical.

Planar mapping projects the material from a flat plane onto the surface. Box mapping projects the material from six flat planes, like those of a box. (See Fig. 15.13.) Spherical mapping curves the projection over the surface as if projecting from a surrounding sphere. (See Fig. 15.14.)


Figure 15-13. Planar and box UVW mapping. Planar mapping projects the material from a single plane and, if used on a box, has the effect of smearing the material on the perpendicular edges. Box mapping projects from six planes, projecting onto each side of the box primitive.
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Figure 15-14. Box and spherical UVW mapping on a sphere primitive. Box mapping projects the material to the closest oriented face. To wrap the map around an object, use spherical mapping.
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The basic type of mapping determines whether the projection comes from a single source or multiple sources, which axis the projection is oriented around, and where the center of the projection is located. In 3ds Max, there are two options for adjusting the appearance of a map using UVW coordinates: either within the material parameters or through an object modifier. 

When a map is added to a channel of a material, the coordinates and bitmap parameters become available to adjust that map within the material browser. These coordinate parameters include offset, tiling, mirror, and angle rotation, and they apply to any object to which the material is applied unless a UVW map modifier overrides them.

Instead of adjusting the bitmap coordinates, the UVW map modifier can be added to any polygonal or patch object. (See Fig. 15.15.) Additionally, the modifier can be added at the subobject level for even more control. The UVW map modifier signifies the extent of the map projection with a Gizmo that can be resized, moved, and rotated. (See Fig. 15.16.)


Figure 15-15. UVW coordinate parameters in the material editor.
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Figure 15-16. UVW Map modifier Gizmo and parameters.
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Adjusting the map projection not only affects how the projection is oriented in respect to the object, it also affects the placement and the size of the map in relation to the object. This is important to be able to scale and tile textures realistically. (See Fig. 15.17.)


Figure 15-17. Scale and tiling.
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In 3ds Max, the real-world mapping function is included to simplify the scaling of textures, especially the supplied Arch & Design materials. When building a model to real-world scale, in nongeneric units, the material map coordinates can be specified to relate to the real-world scale. For instance, the brick tile pattern can be specified to correspond so that each brick is a standard size in real-life, or 8" × 4". For real-world mapping to be used, it has to be enabled either globally through Customize ⇒ Preferences ⇒ General tab ⇒ Texture Coordinates: Use Real-World Texture Coordinates or by enabling Real-World Map Size in the object parameters and Use Real-World Scale in the material map parameters. (See Fig. 15.18.)


Figure 15-18. To use real-world mapping, it must be enabled in both the material and the object parameters.

[image: 902943c15f018.tif]




Tutorial 15.4 Adjusting UVW Mapping in 3ds Max


1. Create a box with the following dimensions: 36⇒0⇒ length, 0⇒2.25⇒ width, 8⇒0⇒ height, with one segment for each. Turn the box into an editable poly: right-click the box convert to: editable poly.

2. Create a standard material to contain a brick pattern to apply to the box. In the material editor, drag a standard material into the view window. Double-click on it to open it in the parameter editor window. (See Fig. 15.19.)


Figure 15-19. Map editor.
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3. Drag the image of the brick pattern from Windows to the view window. Click and drag the output node of the bitmap to connect with the Diffuse Color on the material. Notice that the box next to the Diffuse Color bar in the parameter editor window changes to an M. This indicates that the Diffuse channel has a map. Double-click the bitmap floater in the view window to open its parameters (you can also click on the M in the Diffuse box).

4. To see how the material looks at this point, drag a wire from the output node on the material to the box in the scene and click the Show Standard Map in Viewport button under the menu bar. Adjust the view in the scene and render a frame to check the material.

5. Right now the brick looks stretched out and out of scale. We know that a standard brick is 8" × 4" × 2.25", so we can calculate that, for an 8' × 36' wall, we would need 24 bricks high and 54 bricks long. The tile we are using has 24 bricks in the Y/V direction and 8 bricks in the U/X direction, so the map will need to be repeated +/– six times along the length of the wall (mortar adds dimension as well). (See Fig. 15.20.)


Figure 15-20. The brick is stretched out along the surface, but we can adjust the mapping to resize.
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6. Under the map parameters, in the Coordinates rollout, adjust the U Tiling to 6. The material will be updated in the scene and the bricks along the length should look in scale with the geometry of the wall.

7. If we look closely at the thin sides of the wall, we can see that the mapping is not right. We will use a UVW modifier to adjust the projection (see Fig. 15.21).


Figure 15-21. The brick is projected correctly along the length of the wall, but the side is compressed. Instead of adjusting the mapping, use the UVW map modifier to adjust the projection.
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8. Select the wall object, pull down the Modifier List drop-down, and select the UVW map modifier. This adds the modifier to the selected object.

Figure 15-22. 

9. The default setting for the UVW map modifier is planar. Change it to box. Under Alignment, make sure the axis is set to Z. (See Fig. 15.22.) If the box projection is not automatically formed to the geometry, press the Fit button under alignment. The length, width, and height of the Gizmo will change to equal the geometry. Since we know that we need the length to repeat, adjust the length to 6'0" (36'/6 = 6'0").


Figure 15-22. The UVW map modifier parameters.
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10. The side map is still compressed. We want to use only a portion of the map along the short side, so adjust the width of the Gizmo to be larger than the geometry. (See Fig. 15.23.)




Figure 15-23. The wall after adjusting the UVW map modifier.
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Part 4

Terrain





Chapter 16

Terrain . Surface

The terrain or base that structures the ground plane and contains all of the objects and processes of an environment is extremely important when modeling sites. Terrain is the lower portion of the environmental intersection of ground and sky that creates the horizon, placing the viewer or user at a specific vantage point. The terrain model expresses the field condition that all other elements interact with and provides cues to location, ecologies, and environment processes. Development of a terrain model requires careful planning in order to evolve throughout and illustrate several stages in the design process from discovery to analysis to final design. Forethought about desired uses is essential to integrate the existing and designed terrain throughout the representation process.

The construction of a 3D terrain model should be planned as an extension of design drawings, incorporating methods from sketching to grading to physical modeling, and it should be interoperable with these processes. A terrain model can serve in a variety of capacities. In the discovery and analysis phases, an accurate terrain model can be a base for exploring natural processes, such as water flow and lighting conditions. It can also be a working model for testing and evaluating design ideas from view potentials to sculpting landforms. In the final stages of design, an accurate terrain model serves as a container and context for all populating objects, materials, textures, and dynamic systems. 

Throughout all of the stages, a 3D terrain model in various representation modes can serve as a base for drawings and diagrams. Linework and surface generation can provide structure for diagrams as well as enhancements for plan drawings; view captures can provide perspectival imagery. Perpendicular slices provide bases for sections and elevation drawings, and, of course, dynamic systems can be animated and viewed over time. With many options for digital to physical output, a terrain model can be exported into a physical model through 3D printing, milling, or laser cutting.

Scale of Surfaces

Terrain is perceived differently depending on the vantage point from which it is being observed. Several factors, including coarseness, point of view, texture, and feature objects, determine the scale of the terrain and how it is understood. (See Fig. 16.1.) This is evident when examining two views of the same surface, a view from a human perspective (5 to 6’ elevated above the surface) and a view from an aerial perspective. The human perspective places the terrain as a part of the environment; it is something we occupy and does not have a starting and ending point. The aerial perspective objectifies the terrain and often flattens topographic features. 


Figure 16-1. Perceived scales based on view.
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Understanding the role of scale allows designers to effectively work with terrain representations. In a human perspective view, the terrain requires definitions that explain its materiality, from textures applied to the surface, displacements to the surface itself, and/or objects distributed across the surface. Without these cues, the surface represents topology alone, which is difficult to perceive at the personal scale. The aforementioned issues change at a higher vantage point, where the surface features begin to blend together and it is necessary to highlight the surface topology or allow larger site features to designate changes in the topography. This may be done diagrammatically with overlaid contour lines or elevation color mapping or through the mapping of photography and/or site features such as the massing of vegetation. (See Fig. 16.2.)


Figure 16-2. Diagrammatic surface.
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Beyond perception and aesthetics, scale is important when determining the data set we will use to build a surface. The information necessary to accurately represent a terrain model is extremely complex; therefore, it is necessary to determine how the information will be viewed. Two types of models are usually created, depending on how the model will be used in the design process. If the model must represent a large expanse, the detail of the surface will be reduced, using larger contour intervals or a greater interval in a grid mesh. This is the opposite for models that represent smaller areas, which allow for the model to be highly detailed and may even be refined to a level of detail greater than the original data to show site features that are observed on-site or proposed site information. (See Fig. 16.3.)


Figure 16-3. Terrain model as base for phasing diagrams.
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Data and Surface Framework

Terrain models can be created from many different types of data and can be generated from scratch or from surveyed data. Most modeling software is designed to interoperate with a range of digital formats, which can provide us with more simple, effective, and accurate methods for modeling terrain. Both CAD data and satellite data can be incorporated into 3D modeling, allowing the designer to craft complex forms that can easily be manipulated throughout the design process. 

Inputs: Generated, Supplied, and Collected

The process for creating a terrain model can include several steps, from gathering the information to generate a surface to generating the surface structure, then deriving the terrain from a surface structure. In some cases, designers are supplied with a survey or topographical mapping of existing terrain. In these cases, the process is simply about getting the data into a program and the interoperability of the data between programs. In other cases, we must locate information, which then needs to be prepared before we can generate a terrain model. There are multiple combinations possible within the process.

It is possible to derive terrain data from satellite imagery, which is commonly translated through GPS (global positioning system) and GIS (geographic information system) applications. Raster elevation data is a common source for terrain creation. The data is formatted as a rectangular array of numbers, each representing an elevation, or Z value, at a specified point on a Cartesian plane, or X-Y value, projected to the earth’s surface. 

A DEM, or digital elevation model, represents this regular array of elevation points and can be visualized as a digital 2D image representation of the earth’s surface. DEMs employ a particular raster grid format and are typically used by the U.S. Geological Survey (USGS). (See Fig. 16.4.) A DTM, or digital terrain model, is a more generic format of DEM and can provide similar elevation data. DEMs and DTMs can be found through a variety of sources on the Internet, both free and for purchase. 


Figure 16-4. Processed DEM of Missouri; original data available from U.S. Geological Survey.
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DEMs and DTMs are useful for large areas of terrain and come in multiple levels of quality, or resolutions. In general, the greater the resolution, the smaller the area and the more detail is available. LIDAR (light detection and ranging)–derived DEMs provide the highest-quality spatial resolution, although they are not as widely available. 

Another source of terrain data can come from TIFFs and GeoTIFFs. A TIFF, or Tagged Image File Format, is a popular and versatile raster data format used to store map and geographic data. A GeoTIFF differs from a TIFF in that it includes cartographic tags that allow it to be correctly located in GIS. Both formats are open source, and many organizations, including NASA, ESRI, ERDAS, and SPOT, use these formats for interchangeable data development. 

The coordinate elevation values stored within this type of file can be used to generate a 3D surface structure through different methods: surface generation in GIS applications; TIN (triangulated irregular network, grid mesh, contour generation in AutoCAD; or displacement mapping in 3D software. The method used depends largely on the desired output and drawings derived throughout the design process.

Surface generation techniques in GIS can use DEMs to create contours or a TIN that can be exported for use in both AutoCAD and 3D programs such as 3ds Max and Rhino. AutoCAD Map 3D, AutoCAD Civil 3D, and AutoCAD Land Desktop can also generate linework and surfaces by importing DEM data, which can then be imported into the 3D program. The 3D program can use DEM data for generating a terrain model. Add-ons, such as RhinoTerrain for Rhino or Vue Xstream for 3ds Max or Maya, allow 3D programs to import DEM files directly to generate a terrain object. Also, most 3D programs can use an image file as a displacement map to deform a surface, creating a terrain object; however, the DEM would need to be converted into a suitable format. Both of these methods are useful, although they can sometimes be unpredictable and limited in the scope of design drawing production. Generating a surface structure or linework in AutoCAD may be more flexible in the end.

Surface Structures: Contours, TINs, and Grid Meshes

Contours, TINs, and grid meshes are different types of data structures used to represent 3D surfaces from which terrain models can be generated. These structures are usually developed from one of the previous methods of input. Contour data can come in 2D form, such as a grading plan drawing, which is then input into 3D structure, or it can be 3D from the outset, such as a CAD or GIS linework. TINs and grid meshes are both 3D data structures.

Contours, also known as isolines, are a typical way that designers work with elevation data. The contour line represents a single continuous elevation as a line through the landscape. Contours may be at any predetermined intervals, but typically they are at whole-unit intervals such as 1’, 2’, 5’, or 10’. Contour data is often supplemented by spot elevations to mark known elevations that are less than the contour interval. (See Fig. 16.5.)


Figure 16-5. Contour and spot elevation data.
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Contour linework, or splines, are generally imported from CAD. When generating a terrain model, the underlying geometry is automatically transformed into a TIN or mesh.

TINs are also commonly used to generate terrain models. TINs are composed of splines and formed from regular or irregularly spaced spot elevations that are connected by edges, with at least three edges per point. TINs can be generated from multiple sources, including contour lines, spot elevations, or some combination of the two. Both AutoCAD and ArcGIS can generate TINs from imported data, which can then be exported for use in 3ds Max. As mentioned, 3ds Max can also generate a TIN from contours.

TINs are scalable representations of surface data that are well suited for a range of uses, including analytical maps, sections cuts, and/or illustrative purposes. (See Fig. 16.6.) Due to their faceted surfaces, TINs fall short in terms of their ability to represent true curves. The data structure used to describe TINs is also fairly complex, which can be a problem when creating large models. 


Figure 16-6. TIN surface generated from contours.
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A grid mesh is another method of representing terrain, in which an array or grid of cells is connected with varying heights to approximate a surface. The grid mesh is an extremely efficient method for representing a surface and can also be displayed at varying levels of resolution. (See Fig. 16.7.) The grid mesh also relates directly to methods of data collection that are raster based; therefore, it provides exact translations between data formats (in most instances).


Figure 16-7. Grid mesh.
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All of these types of structures can be generated within the 3D program or imported from other sources. It should be mentioned that, as with any other object, terrain can be crafted completely within the 3D program without importing data, using methods mentioned in previous sections (this is the subject of Chapter 18). Importing data, however, often allows for greater accuracy and portability among various design tools, especially in the initial construction of the contextual site. It can also speed up the process of modeling and is easily manipulated to incorporate proposed changes.

The type of underlying structure and resulting terrain model depend on a trade-off between processing and levels of detail required. Highlighting contrasting areas of large expanses better represents certain terrain typologies, whereas others may be best perceived through minute detail of smaller areas. These shifts depend largely upon the scale of the site, with larger areas tending to exemplify a range of typologies, yet possibly requiring less detail. Much like the entire design process, hybrids or composites may be more efficient than an overarching strategy; therefore, it should be noted that it is possible to combine methods and models.

Typologies

Terrain typologies, or landforms, provide informational cues that go beyond visual perception. They can provide information about the underlying structure beneath the ground plane, drainage conditions, weathering processes, potential for vegetation, and limitations to design solutions. They are the containers for our designs, enabling and restraining the variety of objects and processes that occur within. 

Terrain typologies can be defined in a multitude of ways and broken down infinitely into smaller classifications. For the purpose of introducing terrain modeling, we have defined six typologies that can be combined to make a wide variety of terrain forms. Within these typologies, we have considered the relationships created by the characteristic shape and form, elevation transitions, drainage characteristics, and perceptual scale. Beyond the stated typologies, the basic methods used to create each can be extrapolated and expanded to imagine and create more intricate typologies.

Hills . Highlands

Hills or highlands represent a large-scale, protruding topography that ranges from rolling hills to mountainous terrain (see Fig. 16.8). The forms and boundaries are easy to discern, with mostly irregular geometries and widely perceivable shifts in elevation. As a result of the larger scale, hills or highlands may be represented by a DEM used to drive a displace modifier in 3ds Max, as described in Chapter 18. It is also possible to generate a similar topography using contours. Since the form of hills or highlands is easy to discern, less detail is generally needed, with the possible exception of spot areas of focused concentration.


Figure 16-8. Hills: highlands examples.
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Flats . Lowlands

Lowlands represent a large-scale, planar terrain typology with minimal change in elevation across a surface (see Fig. 16.9). This lack of change produces few boundaries and makes it extremely difficult to perceive shifts in topography, requiring strategies that focus on highlighting contrast. Lowlands require shifting levels of detail; while some areas require high refinement to reveal variation, other areas require very little detail, due to the absence of diversity. The large scale and lack of variation make lowlands easy to derive from most any creation method. The essential moments where small changes take place can be accomplished through localized tessellation done manually or through optimization modifiers. 


Figure 16-9. Flats: lowlands examples.
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Slopes . Ramps

Slopes and ramps represent a medium- to small-scale, protruding typology that is primarily planar and often geometric, requiring an even amount of detail (see Fig. 16.10). Elevation shift is perceivable yet smooth, producing occasional boundaries. Polygon editing, derived from either contours or manual input, is a very efficient manner of creating this form of terrain and is often combined with other typologies, particularly when marrying existing topography with proposed topography. Often, the proposed topography will have many elements that are designed slopes, which are, therefore, easily represented with a minimal amount of geometry.


Figure 16-10. Slopes: ramps example.
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Channels . Swales

Channels and/or swales represent a small-scale, linear, depressed terrain typology that is predicated on the movement of water or other materials (see Fig. 16.11). Elevation change is perceivable, creating moments of necessary detail to emphasize discernible boundaries. One method for building this type of terrain is to connect sectional profiles through cross sections or lofting to create a larger terrain. Crafting the topography in this manner creates a terrain that is easily manipulated through the original loft path or profiles or through cross-section profiles.


Figure 16-11. Channels: swales example.

[image: 902943c16f011.tif]


Basins . Depressions

Basins or depressions refer to a large- to small-scale typology that represents a mostly regular indentation or a moment in the landscape where the earth pushes down in a discernible manner (see Fig. 16.12). Elevation change is perceivable yet smooth, making it important to highlight moments of contrast. It is possible to represent this typology in multiple ways, alternating between high and low levels of detail. At smaller scale, contours or sculpting of a mesh in a free-form manner are effective. At larger scales, basins or containers may also be built using displacements.


Figure 16-12. Basins: depressions example.

[image: 902943c16f012.tif]


Domes . Mounds

The dome or mound is the inverse of a basin or depression, protruding above the landscape in a regular curved geometry with discernible elevation change and boundaries (see Fig. 16.13). The dome or mound differs from a hill in that it is typically perceived at a smaller scale and is often a constructed form, thus representing an intentional human manipulation of the land. This general typology can be used to describe a broad variety of landforms and is easily constructed through the use of contours or polygonal mesh, or by manual methods.


Figure 16-13. Domes: mounds example.

[image: 902943c16f013.tif]


Representation

The data and construction methods provide a framework that requires careful consideration when representing terrain. The surface requires a materiality to express conditions that exist throughout the geomorphological strata. The materials and the relationship of one surface type to another express larger structural conditions. Relationships between each of the elements speak to both the surface and the ground below, as well as structures across the surface or field. The representation of the surface goes beyond the data model and specific date representation conditions but begins to connect the virtual terrain to the physical world. We are able to represent thickness, weight, and spatial relationships.

When representing topography, two narratives typically arise: an analytical story and an experiential story. The analytical story is diagrammatic, annotating complex information through notational languages tying the data model to the representation. The experiential story is illustrative and plays on our visual sense through narratives that are at a human scale. This leans on the representation of materiality and the way terrain creates spaces that we occupy and live within. It is possible to find hybrids that begin to pull forward the data that creates a surface and illustrates the experiences that come from this technical information.





Chapter 17

Terrain Construction

Using Contour Data

The contour data is one of the first things needed for a given site. The source for this can usually be a proposed grading plan, survey linework, or GIS data that has been converted to AutoCAD. The linework should be at the correct elevation in CAD and works best if polylines are joined and closed and/or drawn as 3D polylines. (See Fig. 17.1.)


Figure 17-1. Contour and spot elevations in a grading plan

[image: 902943c17f001.tif]




Tutorial 17.1 Creating Terrain from Contour Data


1. Open 3ds Max and set up the workspace. To import the CAD data, select File ⇒ Import and navigate to your AutoCAD contour file. Click Open. (See Fig. 17.2.)


Figure 17-2. DWG import dialog boxes.

[image: 902943c17f002.tif]


2. The AutoCAD DWG/DXF Import Options dialog opens. Generally, you will not have to rescale the data; however, the option to do so is available. The default settings will usually suffice, but be aware of the following settings: 

Geometry tab: “Derive AutoCAD Primitives by” rollout. In this rollout, you can choose how you want objects to be created in 3ds Max from the AutoCAD linework (or geometry). Typically, you can choose Layer, Blocks as Node Hierarchy, Split by Material, which uses your layers to define objects and blocks to create object instances. If you experience problems with the import, you may want to simplify things by using the Layer option, which ignores most of the other AutoCAD definitions. Many of the other “derive by” settings are useful in case you want to make single lines objects or even import all of the CAD linework as a single object.

Geometry tab: Geometry Options. Here you have the ability to weld vertices, which is useful for importing contours because it takes broken lines/polylines and welds them into single lines. This works the way Weld usually does in 3ds Max, with a Weld threshold setting.

Geometry tab: Curve steps. This setting defines the segments used to represent curves in 3ds Max. 

Geometry tab: Include. This can be very useful if your AutoCAD file has extra entities, such as lights, cameras, or hatches, that you want to be able to include or exclude upon import. When importing contours, it is recommended that you turn off all the check boxes to prevent any unnecessary data from being imported.

Layers tab: This set of options gives you the ability to import specific layers as needed. You can also skip frozen AutoCAD layers if necessary. 

Spline Rendering tab: Spline rendering allows us to designate whether or not splines will render as meshes. It is possible to force splines to render as radial or rectangular meshes of specific radii or lengths and widths. If you have complex linework, such as with contours, rendering the splines can create an unusually large file that is very difficult to work with. 

3. After making the selections and clicking OK, the contour linework is imported into the current 3ds Max scene. 

If you did not specify elevations or Z values for the linework in the AutoCAD drawing, you need to select the lines and set their elevation via the Z axis. If all of the linework is on a single layer in AutoCAD, then this requires that you select the subobject splines to move them. This can be done by detaching each spline to create new objects (shapes)or just manipulating the subobject splines directly. If all of the linework is separated, you can press H to open the selection window and select a contour, and then, using the Move tool (W), specify the desired height in the Coordinates type-in at the bottom of the interface. Repeat this process for all of the contour lines to place them at the correct elevation. (See Fig. 17.3.)


Figure 17-3. AutoCAD contour data imported into 3ds Max.

[image: 902943c17f003.tif]


4. Create a terrain model from the selected contours. Click on the Create/Geometry button and choose Compound Objects from the rollout menu (see Fig. 17.4).


Figure 17-4. Compound Objects rollout.

[image: 902943c17f004.tif]


5. Select one of the contour lines, or all of them, and click on the Terrain button in the command panel. This will create a surface from the selected contours using the default settings including the splines name. If there are more splines that need to be added to finish the surface, this can be accomplished by clicking on the Pick Operand button and then selecting the splines in the viewport or by pressing H and using the Select by Name dialog.

6. After adding the splines, there are several options in the Modify panel with which to alter the appearance and performance of the terrain model (see Fig. 17.5).


Figure 17-5. Terrain options.

[image: 902943c17f005.tif]


Pick Operand allows for the addition of splines as either reference, copy, moves, or instances. It is also possible to introduce linework that acts as an override; linework added with the override option selected ignores other linework that it crosses over. This allows for linework to be introduced that can be used as proposed elements that are then integrated into other linework.

Parameters/Operands allows for the selection of individual operands for subobject editing or for deletion.

Form gives the option to represent a TIN surface in three different ways. Graded Surface creates a smooth surface that is infinitely thin—typically, the easiest to work with. Graded Solid creates a similar surface but with a base. Layered Solid creates a step model similar to layered chipboard or foam core. (See Fig. 17.6.) Each of these modes is a different representation of the same linework, and it is possible to switch among them. The graded surface is the simplest and, therefore, easiest to work, but, after setting all of the options, one of the other two representations may be preferred to present the model or to export the model for fabrication purposes.


Figure 17-6. Terrain surface types: graded surface, graded solid, layered solid.

[image: 902943c17f006.tif]


Stitch Border suppresses the creation of edge triangles when splines are open. It is typically recommended that you do not enable this feature. 

Retriangulate follows the contours more closely but takes more time to calculate. Sometimes this is recommended for particularly complex or detailed areas.

Display toggles the view to display either terrain (surface) or contours, or both. 

If you have a particularly large model, it might be best not to have the terrain update manually; otherwise, the performance of 3ds Max might be very poor when you are trying to perform edits.

Depending on the model, it may require that portions be simplified or interpolated (see Fig. 17.7). It is possible to use 1/2 or 1/4 points horizontally or to interpolate up to 4 times the number of points. The linework can be interpolated only in the horizontal direction but may be simplified in both horizontal and vertical directions.


Figure 17-7. Interpolated and simplified linework.

[image: 902943c17f007.tif]


Color by Elevation works by creating a series of zones (elevations) that can be assigned colors, which will then blend from zone to zone. This is a successful way to create a shaded elevation map. The settings allow you to specify a base elevation and a color. By setting up a series of elevations, it is possible to then allow the colors to blend between the zones or to have them work as solid bands. The bottom buttons also allow us to select a zone and modify or delete it.

7. After creating the elevation model, it is possible to begin editing the model through the addition of linework. This could be accomplished with linework imported from a proposed grading plan in AutoCAD or by creating splines in 3ds Max. It is also possible to apply an Edit Poly modifier and begin directly modifying the surface vertices, edges, and faces. (See Fig. 17.8.)




Figure 17-8. Terrain model surface with elevation zones.
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Splines . Sections

This method for terrain creation differs slightly from our normal paradigm of creating a terrain model. Rather than working with contour lines that are then used to build sections to visualize site elevations, the model begins working directly in sections as the start for the terrain surface.

The five sections created are the basis for the generation of the first surface. This surface will be created using attached splines, cross-section splines, and an edit patch modifier. (See Fig. 17.9.)


Figure 17-9. Spline sections.

[image: 902943c17f009.tif]




Tutorial 17.2 Creating Terrain from Spline Sections


1. Select the spline called section 01, and in the Modify panel use Attach to create a single object by selecting each spline. This creates a single spline with the name of the spline originally selected, “section 01.” (See Fig. 17.10.)


Figure 17-10. Editable spline attach.

[image: 902943c17f010.tif]


2. Make sure the section vertices are numbered properly before creating a cross section across the splines. For the cross section to work properly, all of the splines vertices need to be ordered in the same direction. The easiest way to do this is to select the object and then go into vertex subobject mode and turn on Show Vertex Numbers in the Selection rollout (see Fig. 17.11). At this point, it will be apparent where the section lines’ first vertices are. You can then switch them by selecting the vertex that you want to be first and clicking Make First in the Geometry rollout. (See Fig. 17.12.)


Figure 17-11. Show Vertex Numbers.

[image: 902943c17f011.tif]



Figure 17-12. Splines showing vertex numbering.

[image: 902943c17f012.tif]


3. To create the cross sections, go to the Geometry rollout and select Cross Section. Click on the first section, then the next, and so on, to create the cross-section splines. Continue through all of the section lines until splines are created between all of them. (See Fig. 17.13.) This essentially creates sections in the opposite direction through each of the vertices; the final product is called a spline cage.


Figure 17-13. Surface cross sections.

[image: 902943c17f013.tif]


4. To create the surface, use an edit patch modifier. Select Edit Patch from the modifier list. It may be necessary to select all of the patches and Flip the Normals in the Surface Properties rollout. At this stage, you will have a surface that has been created between each of the section lines and all of the edit patch tools can be employed to modify and refine the surface. (See Fig. 17.14.) 




Figure 17-14. Surface built from network of sections and cross sections.
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Chapter 18

Terrain Modeling . Meshes

Meshes

Similar to the way you would sculpt a terrain model with clay or construct topography with other modeling materials, it is possible to build surfaces using the mesh editing tools in 3ds Max. Mesh editing can be performed using subobject edits through the Editable Poly modifier and through the expanded Graphite Modeling Tools ribbon (see Fig. 18.1). The Graphite Modeling Tools ribbon displays a symbol-based interface that relates to similar features within the Modify panel. Each subobject mode (Vertex, Edge, Border, Polygon, Element) has a specific interface ribbon that corresponds to the operations that can be performed on the surface. (See Fig. 18.2.)


Figure 18-1. Editable Poly subobjects.
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Figure 18-2. Graphite Modeling Tool subobjects on an object converted or modified as an Editable Poly.
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Tutorial 18.1 Creating a Landform Using Soft Selection

This first operation shows how to transform the surface using Soft Selections and the Move transform.


1. Create a plane with the following parameters: length, 20; width, 20; length segments, 20; width segments, 20.

2. Convert the plane to an Editable Poly. Select the plane, right-click, Convert to: Convert to Editable Poly. (See Fig. 18.3.)


Figure 18-3. Plane and conversion to Editable Poly.

[image: 902943c18f003.tif]


3. Enter Vertex subobject mode; with the plane selected, press the number 1. Using the selection tool (Paint Selection Region option; see Fig. 18.4) with Use Soft Selection and Ignore Backfacing checked in the Modify tab, highlight the vertices on the top face of the box that will be used to create the shape of the berm/landform. The Shrink and Grow option under Selection, as well as the Falloff in Soft Selection can be used to increase or decrease the number of vertices selected. (See Fig. 18.5.)


Figure 18-4. Paint Selection Region.

[image: 902943c18f004.tif]



Figure 18-5. Vertices selected using the selection tool with Paint Selection Region.

[image: 902943c18f005.tif]


4. The Soft Selection parameters, located in the Modify panel under Editable Poly, allow for a selection to have a falloff. The distance of the falloff is adjusted under the Falloff parameter, and the Falloff profile is controlled by Pinch and Bubble. The selection is displayed on the surface of the object, with red vertices designating a 100% selection and blue vertices indicating a 0% selection, and a range in between from orange to yellow to green. It is also possible to modify the Soft Selection using Paint tools, which are found in the Modify panel below the Falloff profile.

In the latest versions of 3ds Max, it is also possible to make many of the adjustments available in the Modify panel interactively in the viewport using the Soft Selection floating tool palette. (See Figs. 18.6 and 18.7.)


Figure 18-6. Soft Selection rollout and parameters.

[image: 902943c18f006.tif]



Figure 18-7. Soft Selection rollout and parameters.

[image: 902943c18f007.tif]


5. With the vertices selected and the Soft Selection adjusted, use the Move transform to raise the vertices in the upward Z direction (see Fig. 18.8). This can be done in a free-form manner or precisely, using the transform type-in dialog. 




Figure 18-8. Vertices and surface transformed using Soft Selection.
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Tutorial 18.2 Creating a Landform with the Graphite Modeling Tools Paint Deform

This operation explains a method similar to the Soft Selection and Move transform discussed previously, but it uses the new Paint Deform tool available in the Graphite Modeling Tools ribbon. 


1. Create a plane with the following parameters: length, 20; width, 20; length segments, 20; width segments, 20. 

2. Convert the plane to an Editable Poly. Select the plane, right-click, Convert to: Convert to Editable Poly.

3. With the plane selected, go to the Graphite Modeling Tools ribbon ⇒ Freeform ⇒ Paint Deform tool, and then select Push/Pull. After selecting Push/Pull, there are options that can adjust the size of the brush, the strength of the transform, and the offset. (See Fig. 18.9.)


Figure 18-9. Paint Deform tool.
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4. With the Paint Deform tool active, it is possible to click and drag the cursor across the surface and deform the polygons. The default action of the Push/Pull deformation is to pull the surface upward in the amount of the Strength setting. (See Fig. 18.10.) It is possible to push the surface by holding down the Alt key while clicking and dragging across the surface. 


Figure 18-10. Surface sculpted using the Push/Pull Paint Deform tool.
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5. It is possible to use the other Paint Deform modes to further transform the surface. A useful tool is the Relax/Soften mode of Paint Deform, which smooths the Push/Pull transformation.

6. Using the Polygon Sub-Object mode and Tessellate, it is possible to add more detail to the surface if there is a need for further refinement. First, make sure that Polygon Sub-Object mode is on, and press 4, or this can be selected in the Modify panel or the Graphite Modeling Tools Polygon Modeling tab. Next, select the polygons that need further detail, which can be accomplished using the selection tool and the Marquee or Paint Selection mode. After selecting the polygons, click Graphite Modeling Tools ⇒ Subdivision ⇒ Tessellate. (See Fig. 18.11.) This divides the polygons and can be done in succession to further divide the selection. (See Fig. 18.12.)




Figure 18-11. Tessellate under Graphite Modeling Tools subdivision.
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Figure 18-12. Tessellate further divides the selected polygons.

[image: 902943c18f012.tif]


After tessellating the surface, it is possible to further sculpt and transform the mesh to add detail to the topography. (See Fig. 18.13.)


Figure 18-13. Refined surface with sculpted details.

[image: 902943c18f013.tif]






Tutorial 18.3 Creating Contours from the Sculpted Mesh

After creating the mesh, it is possible to generate contours using two methods within 3ds Max. This can be accomplished using Slice when in Edge Sub-Object mode or using a Section Shape. The Section Shape method is discussed in the following example.


1. Starting with a sculpted mesh, create a Section Shape. (See Fig. 18.14.) Go to the Create tab on the Command panel, select Shapes ⇒ Splines ⇒ Section. In the Top viewport, create a Section Shape slightly larger than the mesh that will be used to create the contours. (See Fig. 18.15.)


Figure 18-14. Sculpted mesh.

[image: 902943c18f014.tif]



Figure 18-15. Section Shape created over existing mesh.

[image: 902943c18f015.tif]


2. The Section Shape creates a yellow line across the mesh through the plane of the Section Shape. The Section Shape should be placed at the elevation where the contour line will be cut. If the contour lines will be cut at 1' intervals, the section is placed at the lowest elevation. In this model, it is placed at 0' on the Z axis. To create the first contour, select the Section Shape, and then select Create Shape on the Modify panel. (See Fig. 18.16.)


Figure 18-16. Section Shape parameters and Create Shape button.

[image: 902943c18f016.tif]


3. After clicking Create Shape, it is necessary to give the shape a name such as “contour 0.” (See Fig. 18.17.)


Figure 18-17. Name Section Shape dialog.
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4. After creating the first contour, move the Section Shape up 1’, or the desired contour interval, and repeat the process. Continue moving the section shape up the desired interval and creating the shape to finish the contours up to the top of the mesh. (See Fig. 18.18.)


Figure 18-18. Shapes used to create the contours representing the mesh’s topography.

[image: 902943c18f018.tif]


5. The shapes (editable splines) can be selected and exported to a .dwg file using File ⇒ Export ⇒ Export Selected






Displacement

Similar to other types of maps, such as opacity or bump maps, that are used to create effects for materials, images can be used to drive elevation or displacement values for a surface. This method is often used to create highly detailed or textured surfaces similar to bump maps, but instead of faking textures based on lighting effects the way bump maps do, the displacement map actually transforms the mesh. This works by mapping an image to a surface and using the values to assign amounts of displacement, where white pixels are 100% displaced and black pixels are 0% displaced. Based on this idea, if the displacement value is 200, then white pixels represent an elevation of 200 and black pixels represent an elevation of 0. (See Fig. 18.19.)


Figure 18-19. Relationship between displacement map pixel values and the mesh surface displacements.
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Tutorial 18.4 Creating a Terrain using DEM Data and the Displace Modifier

Data can be obtained from USGS Geographic Data Download, USGS National Map Seamless Server, USDA/NRCS Geospatial Data Gateway http://datagateway.nrcs.usda.gov/.

The displacement image will be created from a DEM GeoTIFF, and a second aerial photo (orthoimagery) will be used to map onto the surface to give the displaced mesh added detail. (See Fig. 18.20.)


Figure 18-20. DEM GeoTIFF for displacement and orthoimagery used to map the surface.

[image: 902943c18f020.tif]



1. Once DEM GeoTIFF/TIFF files have been obtained, the DEM GeoTIFF needs to be converted from a 32-bit/channel file into a 16-bit/channel file.

2. Using Photoshop, open the GeoTIFF/TIFF. Some DEMs may not have an embedded grayscale profile, and the user may be prompted to assign one: Choose Assign Profile: Generic Gray Profile ⇒ OK. 

3. Next, convert the TIFF to a 16-bit/channel gray image: Image ⇒ Mode ⇒ 16Bits/channel ⇒ OK. The image should now be visible.

4. Save the image file.

5. Create a new file in 3ds Max. Create a plane with the same dimensions as your TIFF file. If your TIFF file has a width of 10,000 meters and height of 10,000 meters, then the plane should also be 10,000 meters x 10,000 meters. 

6. Change the default length and width segments of the plane to something like 200x200. (See Fig. 18.21.)


Figure 18-21. 10,000 meter x 10,000 meter plane with 200 length and width segments.
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7. Add the Displace modifier to the plane.

8. Inside the Displace modifier, choose Image and select the grayscale TIFF image that was converted earlier in Photoshop.

9. In the Map section of the Displace modifier, choose the same TIFF file. (See Fig. 18.22.)


Figure 18-22. Displace modifier settings.
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10. In the Displacement modifier settings, enter a strength value that represents the height of the highest point in your terrain. (See Fig. 18.23)


Figure 18-23. Displaced surface, wireframe and shaded.

[image: 902943c18f023.tif]


11. To apply an aerial photo material to the terrain, open the material editor and create a new material, then connect the bitmap of the orthoimage into the Diffuse slot of the material. Drag the image onto the Slate Material Editor and connect it to the Diffuse slot of a standard material. (See Fig. 18.24.) It is possible to use other material types as well, depending on the representation.


Figure 18-24. Slate Material Editor material.
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12. Once the material has been created, apply a UVW Map modifier to the plane. Make sure Planar is selected in the UVW Map modifier properties, and then click on the Fit button. (See Fig. 18.25.)


Figure 18-25. UVW map modifier properties.
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13. Once the UVW Map has been applied, apply the new material that was created.

14. If more resolution is needed in the mesh, it is possible to increase the number of width and length segments of the plane. (See Fig. 18.26.)




Figure 18-26. Rendered and displaced surface with orthoimage.
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Chapter 19

Surface Materials

As discussed in previous chapters, materials use and application are extremely significant to the development of a coherent and compelling 3D model. The materials on a surface define the weight, composition, perceived structure, and implied subsurface through visual cues. Representation naturally favors visual perception; therefore, the scale of textures, amount of detail, organization of characteristics, and interaction with light and shadow are fundamental to our understanding of the terrain and the systems operating within it. (See Fig. 19.1.)


Figure 19-1. Materials applied to a model are fundamental to our understanding of the illustrated environment.
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Displacement and Bump Mapping

Displacement and bump maps are grayscale images with which the amount of white in the image is used to displace the surface of an object. 

Within the material editor, there are Map slots to add both displacement and bump maps. As demonstrated in the previous terrain chapters, displacement changes the mesh, displacing the vertices, edges, and polygons to create a new form. Bump mapping works in a similar manner without actually changing the mesh’s surface; instead, it creates shading based on the scene lights to make the surface appear as though it has relief. Because bump mapping does not actually transform the mesh, it works best for small textural effects.

In both bump and displacement mapping, an image is used to generate the effect. The effect is applied based on the value of the pixels; white pixels deliver 100% of the effect, whereas black pixels deliver 0% of the effect. 

Tutorial 19.1 uses a material with a grass image in the Diffuse slot and a noise map in the Displace slot to create a grass effect. (See Fig. 19.2.)


Figure 19-2. Grass texture (www.skibek.pl).
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Tutorial 19.1 Using a Noise Map for Displacement


1. There are several grass bitmaps available with the default installation of 3ds Max. Alternatively, it is possible to download textures from a Google image search. The texture should be tileable; if there are discernible seams, it will be evident in the final rendering, as the texture will be used to add color to each grass blade. 

2. Create a plane with a length of 20 and width of 20. Change the length and width segments to 30. Increasing the number of segments creates a greater amount of detail on the surface, but it also increases the file size and rendering times.


Figure 19-3. Scene created for grass material.
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3. Create a box and place it on the surface of the plane (see Fig. 19.3). The box is used as a prop to help in the calibration of the displacement of the grass texture.

4. Open the material editor (press M) and create a new Arch & Design material. In the Diffuse slot, add a bitmap image of the grass texture. It is also possible to add a mixed image in the Diffuse slot by adding the Mix Map. (See Fig. 19.4.) The Mix Map combines two different texture images to create a unique texture. In this example, three different texture materials and two different Mix Maps are used.


Figure 19-4. Base material with Mix Map.
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5. Next, we’ll add a Noise Map to the Displacement Map channel. By double-clicking on the Noise Map, we can edit the Noise parameters. The Noise Size parameter allows us to change the size of each displacement point. Smaller sizes give us more finely detailed displacement points, thus rendering finer blades of grass. (See Fig. 19.5.) This parameter should be adjusted to suit the grass look that you’re trying to achieve.


Figure 19-5. Noise Map added for Displacement and Noise parameters.

[image: 902943c19f005.tif]


6. Apply this material to the plane.

7. Add a UVW Map modifier to the plane.

8. Adjust the scale of the UVW Map in the length and width area of the UVW Map modifier.

9. A daylight system using a mental ray sun and sky were added before rendering. Render the scene. (See Fig. 19.6.) Grass height can be adjusted by increasing or decreasing the Displacement amount found in the Special Purpose Maps rollout (insert: displacement.jpg). Grass width can be adjusted by increasing or decreasing the Noise Size under the Noise parameters. This is a very quick way to generate grass that gives texture to the ground plane. It is a technique that works well to create a uniform, manicured look.




Figure 19-6. Rendered scene.
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Water

In Tutorial 19.2, two methods to create water with materials and modifiers are examined. In the following examples, the tutorial uses a box to illustrate the possibilities of refraction with a water material. If a water volume is not needed, then a simple plane can be used to create a reflective water surface.



Tutorial 19.2 Creating a Basic Water Material 


1. Create a box with length and width dimensions of 100 and height equal to 20, with 25 length and width segments and 5 height segments. 

2. Open the Slate Material Editor and create a new Arch & Design material. 

3. Under the Template rollout of the new Arch & Design material, choose Water, Reflective Surface. (See Fig. 19.7.) Make sure that the Show Standard Map in Viewport button is depressed, and apply the material to the box. (insert: water_template.jpg)


Figure 19-7. Arch & Design Material with water template.
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4. Look at the Arch & Design material that was created and notice that the Ocean bump map is applied to the Bump channel.

5. Double-click the Ocean Bump map, and the Ocean Parameters layout opens. (See Fig. 19.8.) The Ocean Parameters allow for adjustments to how the surface of the object is transformed by the bump map.


Figure 19-8. Ocean map parameters.
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6. By default, the Refraction Transparency is set to 0. With this setting, no light is allowed to pass through the object. Change the Refraction Transparency to 0.5.

7. This adjustment creates a box that is somewhat transparent. If the material needs to act only as a reflective water surface, then leave the Transparency in the default settings. (See Fig. 19.9.)


Figure 19-9. Refraction settings.

[image: 902943c19f009.tif]


8. A daylight system with a mental ray sun and a mental ray sky is added before rendering.



There are several options for creating waves on the water’s surface. It is possible to adjust or animate the Ocean Bump Map’s parameters to create waves. One thing to notice is that the bump map works by faking a lighting effect across the surface. The surface looks as though it has relief, but it can be seen on the edges that the actual box mesh is not deformed. (See Fig. 19.10.)


Figure 19-10. Rendered box with water material applied.
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Noise Modifier

The Ocean map just affected the surface’s bump and did not transform the geometry. It is possible to apply a Noise modifier in subobject mode to create waves on the surface of the box. Again, if a water volume is not needed, the Noise modifier can be applied to a plane to create the same effect. It is also possible to use the Ocean map in the displacement of the material, which is similar to the method used to create the grass. 



Tutorial 19.3 Creating Water Motion with a Noise Modifier


1. Select the box from the previous exercise and add an Edit Poly modifier. Click on the Modify panel, and select Polygon (4) from the Selection rollout. (See Fig. 19.11.)


Figure 19-11. Polygon subobject mode.
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2. In the viewport, press T to change to Top view.

3. Now select all of the polygons on the top of the box. Under the Selection rollout of the Modify panel, check the box next to Ignore Backfacing. (See Fig. 19.12.) This ensures that only the top polygons of the box are selected when selecting from the Top view.


Figure 19-12. Ignore Backfacing option in Modify panel.
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4. Press Q to enter Selection mode. Next, use the Paint Selection Region and paint-select all of the polygons on the top of the box. With the top polygons selected, select Noise from the Modifier List. (See Fig. 19.13.) Because the polygons are selected, the Noise modifier is applied only to these polygons. (See Fig. 19.14.)


Figure 19-13. Top polygons selected.

[image: 902943c19f013.tif]



Figure 19-14. Noise parameters from the Modifier List.
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5. Change the Z Strength to 2. Notice how the surface of the box top now has the effect of turbulence. The Z Strength value increases or decreases the amount of turbulence on the surface of the object. (See Fig. 19.15.)


Figure 19-15. Surface transformed using the Noise modifier.
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6. By default, the Noise Scale is set to 100, but it is possible cut this to 50. Notice that the scale of the turbulence has decreased. This may also require adding more detail to the polygons, as the Noise Modifier is now altering the surface at a higher level of detail (smaller scale). This can be done by adding a Tessellate modifier between the Edit Poly and Noise modifiers. (See Fig. 19.16.)




Figure 19-16. Rendered box with water material applied and Noise modifier transforming surface.
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Chapter 20

Distributions

Beyond using materials to define a surface, it is also possible to distribute objects across a surface. This could be individual blades of grass, tree massing, or other features such as rocks. Distributions are examined using two tools and a feature: Scatter, Paint Objects, and Hair/Fur. Distributions are a great way to quickly populate a surface, but because there are so many objects being distributed it can quickly eat up resources. Often, high-resolution distributions such as grass may be used in the foreground, whereas lower-res distributions such as billboard trees may be used as context. 

Scatter

The Scatter command can be used to distribute objects over a surface or within a volume. For example, if a scene requires distant forested hills, you could use the Scatter function to distribute a tree model across the hillsides. You might also use the Scatter function to distribute grass across a terrain surface. This function is useful to quickly populate a scene, although there are drawbacks with the limited controls and accuracy of placement of the scattered objects.

In the following example, Scatter is used to create a forested hillside. The Scatter Compound Object distributes several billboard trees across a distant hillside terrain. In this example, the tree models are the Scatter Objects and the terrain acts as the Distribution Object. 



Tutorial 20.1 Using Scatter to Distribute Vegetation


1. Create a large plane with length and width equal to 1,000’, and with length and width segments equal to 100. Add an Edit Poly modifier to the plane. This will be used to create the terrain and will serve as the Distribution Object.

2. Enter subobject mode by pressing 1 to select vertices.

3. Press Q to scroll through the selection methods until Paint Selection Region is chosen. Now select all of the vertices in the area where the hills will be created. You can modify the selection by using Soft Selection or Grow or Shrink, or by using Ctrl and Alt to add to or subtract from the selection.

4. Switch to the move command by pressing W. Either manually move the vertices up or down or use the Z-axis scroll wheel to create a hillside terrain. In this scene, a second plane is used to create a water surface, and a material that resembles grass and dirt is added to the hillside. (See Fig. 20.1.)


Figure 20-1. Transformed terrain and plane of water.
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5. Next, create several billboard trees. (The process to create billboard models is discussed in Chapter 7.) The planes used to create the trees should have only one segment each to minimize the production of extra polygons. The trees should also have their pivot points aligned to the center and the bottom of each model. (See Fig. 20.2.) After creating the trees and moving the pivot points, it is typically necessary to reset the transform, which will use the current position, scale, and rotation as the new base transform. To reset the transform, go to the Utility tab in the command panel and select Reset Xform.


Figure 20-2. Billboard trees.
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6. Add a Mesh Select modifier to the surface, where it will serve as the Distribution Object, and select vertices or polygons where the models will be scattered. (See Fig. 20.3.)


Figure 20-3. Selected polygons.
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7. Select any Plant or Billboard mode ⇒ Create Panel ⇒ (geometry) ⇒ Compound Object ⇒ Object Type Rollout ⇒ Scatter.

8. Under Scatter Object choose Use Distribution Object.

9. Under Distribution Object Parameter, we have the option Use Selected Faces Only. Checking this option distributes the models across only the selected faces of the terrain. This can be selected before choosing the Distribution Object or after. We could

 also choose Distribute Using Area, Even, Skip Number, Random Faces, Along Edges, All Vertices, All Edge Midpoints, All Face Centers, or Volume. For this exercise, choose Use Selected Faces Only. It is also possible to specify whether or not the objects are aligned perpendicular to the surface. (See Fig. 20.4.)


Figure 20-4. Scatter options.
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In the Source Object Parameters, it is possible to specify the number of objects that will be distributed.

It is also possible to add small amounts of randomness under the Transforms rollout. Rotation, translation, and scaling can all be altered.

Under the Display rollout, select Proxy and check Hide Distribution Object. By checking this feature, we will display only the distributed objects and the original mesh. If there are a lot of objects being distributed, it is also possible to display a percentage of those objects in the viewport, which can speed things up when working with the model. The full amount specified in the Duplicates parameter will be rendered.

10. Repeat steps 7 through 9 for each of the objects that will be distributed across the surface. This allows us to create a scene with multiple objects scattered over a mesh. (See Fig. 20.5.) It is possible to return to the original surface and adjust the selected polygons under the mesh select to alter the scatter distribution. (See Fig. 20.6.)




Figure 20-5. Objects scattered on the surface.
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Figure 20-6. Rendered billboard trees scattered across the surface.
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Paint Objects

In the previous section, Scatter was used to distribute objects across a surface. In Tutorial 20.2, a similar tool, called Object Paint, is used. 

Object Paint works in a way that is similar to Scatter, by allowing a user to paint or place objects across a surface. Unlike Scatter, where objects are distributed randomly across a surface, Object Paint allows for more precision in distributing objects. Another advantage of Object Paint is that each painted object can be selected and edited, allowing for more flexibility and control over the distributed objects. 

There are several components of Object Paint that can be helpful to understand. The Paint icon toggles Object Paint mode on and off. The Edit Objects List button and the Pick Objects button allow us to pick the objects we will paint into the scene. The Paint On drop-down gives us three options for a painting surface: Grid, Selected Objects, and Scene. The Offset spinner sets the value for offsetting a painted object from a surface, where positive values offset the object in the upward Z direction and negative values move the painted object in the downward Z direction. (See Fig. 20.7.)


Figure 20-7. Paint Objects options.
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The Align drop-down has two options: Align to Normal and Follow Stroke. With the Align to Normal option checked, all objects painted onto a surface align perpendicularly to the surface. If, for instance, you would like to paint tree models onto a hillside and have the trees remain vertical, then unchecking the Align to Normal option would yield this result. Conversely, if Align to Normal were checked, then the trees painted on a slope would be set to the same angle as the slope. Under the Align options, you can also set the paint objects to align to the X, Y, or Z axis of the pivot point of that object. The Flip Axis button does just that: It flips the axis of the pivot point of the object. The Spacing spinner sets the value of distance in world units between objects in the stroke. The higher the spacing value, the lower the number of painted objects, and vice versa. The Scatter setting applies a random offset from the painted stroke for each paint object. The Rotate settings set the values of rotation based around the pivot point of each object. The Scale settings set the scaling options for the painted objects. The Brush Settings drop-down gives the user options to save the current settings, load saved settings, and set the current settings as the default. (See Fig. 20.8.)


Figure 20-8. Brush settings.
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Tutorial 20.2 Using Object Paint to Distribute Vegetation

In this tutorial, Object Paint will be used to distribute several billboard tree models across a hillside terrain. The tutorial uses the same billboard trees and terrain surface created in Tutorial 20.1.


1. Using Pick Objects under Object Paint, select one of the tree billboard models. If there are multiple objects, it is also possible to create an object list that will paint multiple objects.

2. In the viewport, select the terrain surface and then click the Paint On drop-down. Under the Paint On drop-down, Choosing the Selected Objects options ensure that the tree billboards are painted only onto the hillside surface.

3. Click the Align drop-down and uncheck Align to Normal, which allows the trees to be upright; otherwise, they will be aligned perpendicular to the surface normals.

4. Under Align, select the upward axis of the tree model, either X, Y, or Z.

5. Under the Brush Settings, choose a spacing that is appropriate.

6. Press the Paint button and begin painting onto the terrain surface. (See Fig. 20.9.)




Figure 20-9. Objects painted on surface.
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To create a bit of diversity, use the scaling and rotation adjustments to create a canopy of trees with varying sizes and orientation. Each object painted during one paint session is controlled by the object parameters. For example, if you painted 10 tree models, each of those 10 models would be affected by adjusting the Scale, Rotation, or Scatter setting. To create other varying objects, press the Paint button to end the session, press it again to begin a new session, and adjust the object parameters as needed for the newly painted objects.




Hair

The Hair and Fur modifier is a feature of 3ds Max that can be used to create representations of grass on a surface. The Hair and Fur system is a fully dynamic system that can respond to other forces such as wind and gravity.



Tutorial 20.3 Using Hair and Fur to Create Grass on a Surface 


1. Create a plane with length and width equal to 100, and set the length and width segments to 10. This plane will be used as the surface to generate the hair. It is possible for the surface to be transformed with topography or in other ways.

2. Create a ground color material and apply it to the ground surface. This serves as the dirt or ground that the grass (hair) is growing out of.

3. Select the surface and add the Hair and Fur World Space Modifier (WSM). (See Fig. 20.10.)


Figure 20-10. Hair and Fur general parameters.
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4. In the Tools rollout of the Hair and Fur (WSM), press the Load button under Presets. Choose the “tall grass (breeze)” preset. (See Fig. 20.11.)


Figure 20-11. Hair and Fur presets.
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5. It is possible to adjust some of the General Parameters of the Hair and Fur. Start with the settings for Scale, Cut Length, Root Thick, and Tip Thick. 

6. Click the Material Parameters Rollout (see Fig. 20.12). Here it is possible to adjust the color as well as other settings, including Specular Tint and Glossiness settings.




Figure 20-12. Hair and Fur Material Parameters.
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The hair is rendered after all other objects are rendered. (See Fig. 20.13.) Large amounts of hair will slow render times down tremendously; therefore, the effect should be used sparingly and works best in the foreground.


Figure 20-13. Hair and fur rendered.
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Part 5

Atmosphere





Chapter 21

Lighting . Atmosphere

When we consider how environments are constructed, objects, surfaces, and materials create a model that is viewed within a specified lighting and atmosphere. The composite of all of these elements creates a legible and compelling environment that serves as a site context for the models. 

In photography, theater, and film, lighting and atmospheric cues affect the setting, color, tone, and mood of the narrative. In both static and dynamic imagery, lighting and atmosphere establish the time of day, season of the year, weather conditions, and environmental circumstances. In dynamic imagery, the changing of these cues relays a sense of time passage and development. All of these contribute to the comprehensive experience of an environment.

Through the lens of environment illustration and modeling as a tool to be used throughout the design process, lighting and atmosphere can be used in different ways. In some instances, it may be used as a research method to test and evaluate a proposal under realistic conditions. In other instances, it can be used as a design aesthetic to guide the perception of the viewer by establishing a tone or mood. Digital environments allow designers the persuasive ability to realistically construct scenes as well as the flexibility to create original and compelling representations. (See Fig. 21.1.)


Figure 21-1. Panoramic image showing atmospheric conditions.
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Lighting

Lighting is one of the most important aspects in establishing an environmental context. In the physical world, light is inseparable from form and space as it shapes the way we perceive our surroundings. The importance of lighting is understood within a broad range of disciplines including animation, architecture, and film, and the topic can be the subject of multiple volumes. 

Generally, lighting in environmental scenes has two main components: a direct shadow-casting sky and a diffused sky. This provides the overall lighting in an environment, and the combination of the two is used to create the tone and mood of the illustration. The diffused sky sets the overall tone by casting diffused, bounced light throughout the environment, and its intensity and color are important in conveying time of day, season, and location. The sun provides a direct vector of light at varying intensities. This light casts discernible shadows, and its height in the sky and location in relation to the objects speaks to the environment’s location. 

Time of Day

The time of day creates cues that express an innate understanding of how a site may be used. The rituals associated with moments within the day help to expand that understanding. Illustrating a site through different times of day can articulate the richness of the proposed spaces. It is important to pay attention to all of the factors that speak to time of day and make sure that they are working together.

Lighting is a large factor in how we perceive the time of day. It communicates through the location of the sun, the formation of shadows, and the quality or color of the light (see Fig. 21.2). Long, light shadows convey early morning or late evening; short, dark shadows show that it is near noon. A pinkish diffused light and horizon that is colored from pink to white conveys dawn. A low layer of fog across the terrain shows that the rising sun is heating the earth. Each of these factors alone speaks to a time of day, but the combination of all paints a definitive picture of when the illustration is occurring. 


Figure 21-2. Shadows and ambient lighting express different times of day.
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Weather

Weather plays a role in the illustration of environments, as it speaks to events that are specific to particular regions (see Fig. 21.3). Often, illustrations are created on the perfect day; clouds are positioned in a pleasing composition with blue skies and warm, irradiating sun. It is possible to address the way a site functions in multiple weather conditions through the representation of particular weather events such as heavy rainfall or extreme weather. This helps to create illustrations that reflect the tolerances of a proposed environment and provide the stage to show how systems may respond.


Figure 21-3. The representation of the sky and atmosphere can speak to weather conditions.
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Similarly to weather and the time of day, seasons express the change of time and how a site may evolve. Seasonal change is larger in scale and can show considerable transformations in the site’s evolution. The sun’s position in the sky is a factor to consider in the seasons. When the sun is in a high position, particularly at noon, it conveys summer; if it is low in the sky throughout the day, it conveys winter. 

The overall tone of the imagery rendered by specific elements is one of the greatest factors (see Fig. 21.4). Because the bounced light in a scene changes based on the environment, an illustration with snow would likely have cool overtones and a lush summer image may have bounced greens. It is important that these tones also be conveyed in the site elements. For example, fall needs to have warm tones as well as changing leaf colors and brown-orange vegetation in areas. 


Figure 21-4. Vegetation, changes in light quality, and atmospheric conditions signal seasonal shifts.
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Artificial Light and Pollution

There are many factors beyond the sky and the sun that contribute to how lighting conveys information in a scene. Human settlement plays heavily into many of the issues that contribute to unusual lighting conditions. Pollution can play a role in the appearance of atmospheric conditions. Creating a haze of particulate matter floating in the sky affects not only the quality of light but also the clarity of the horizon. 

Artificial lighting in environments is also an important aspect, particularly when illustrating constructed sites. This can be used to great effect when illustrating scenes that are at dawn, at dusk, or at night, to show the lighting infrastructure and how it defines the environment (see Fig. 21.5). Artificial lights lack the energy of a simulated sun and, therefore, must be represented as lights that emanate from a source and then dissipate within the environment. The color and energy of the lights come from how they are manufactured and how they are simulated through the lighting controls.


Figure 21-5. Artificial lighting from event at dusk.
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Chapter 22

Rendering and Lighting Systems

mental ray

3ds Max offers multiple renderers to create imagery from the scenes that are created. The latest version (2012) has three production renderers: scanline, mental ray, and iray. Each renderer has its place, but in most cases mental ray is the most versatile and complete solution for creating high-quality, physically accurate lighting and atmospheric solutions. 

Assign the renderer and adjust its associated properties through the Render Setup dialog, which can be accessed from the main toolbar under Rendering ⇒ Render Setup. (See Fig. 22.1.) The default shortcut is F10.


Figure 22-1. Render Setup, rendered frame window, and render production.
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To set up mental ray as the default renderer, click on the Common tab and scroll to the bottom to find the Assign Renderer rollout (see Fig. 22.2). Select mental ray as the default production renderer, and then click on the Save as Defaults button. It is possible to switch between each of the renderers and to assign different renderers to Production, the Material Editor, and ActiveShade. Production is the renderer that produces any graphic output such as rendered frames and sequences for animation. The Material Editor renderer is used to show the samples in the Material Editor Sample slots. ActiveShade refers to the preview in the viewports; 3ds Max comes packaged solely with the default scanline renderer for ActiveShade.


Figure 22-2. Render Setup ⇒ Common tab ⇒ Assign Renderer.
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After assigning the mental ray renderer as the default renderer, the tabs specific to mental ray appear in the Render Setup dialog. There are five tabs: Common, Renderer, Indirect Illumination, Processing, and Render Elements.

The Common tab contains all of the settings that are similar across all the renderers. This is where settings such as Render Size, Frames, and Output are designated. 

The Renderer tab contains settings specific to the mental ray renderer and allows for adjustment of sampling, reflections, and refractions, as well as camera effects for contour rendering, depth of field, and motion blur. (See Fig. 22.3.)


Figure 22-3. Render Setup ⇒ Renderer tab.
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The Indirect Illumination tab contains very important settings that are used to adjust how Final Gather, Global Illumination, and Caustics are implemented. (See Fig. 22.4.) These settings make it possible to adjust the accuracy of the Final Gather solution, which can greatly effect rendering times and image quality. These are discussed further at the end of this chapter.


Figure 22-4. Render Setup ⇒ Indirect Illumination tab.
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The last two tabs, Processing and Render Elements, are used less frequently. Processing controls how the renderer functions, and Render Elements is used to set up the rendering of separate elements, or parts of an image, to be used in compositing or image-editing software. Render Elements can be used to render specific data such as a scene’s depth information, shadows, or even the UVW mapping of objects. (See Fig. 22.5.)


Figure 22-5. Z Depth added to render elements.
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When rendering with mental ray, Exposure Control is used to control the levels and color ranges of a rendering. In mental ray, this is referred to as mr Photographic Exposure Control. To adjust the settings for Exposure Control, go to Rendering ⇒ Exposure Control. Set the Exposure Control type to mr Photographic Exposure Control; this adds the mr Photographic Exposure Control rollout. There are two main areas under the mr Photographic Exposure Control rollout: Exposure and Image Control. Exposure provides settings that control parameters for adjusting imagery similar to camera controls such as f-stop, shutter speed, and ISO. The image control group provides fine-tuning for Highlights, Midtones, Shadows, Whitepoint, and Color Saturation. It is possible to use the Templates rollout, found in the Preset drop-down, to create appropriate settings for different lighting conditions. (See Fig. 22.6.)


Figure 22-6. Exposure Control settings.
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Lights

Within 3ds Max, mental ray can be used with either standard or photometric lights. Standard lights are virtual lights that are not based on real-world light intensities or performance. In most cases, photometric lights are preferred because they implement a physically based lighting model. This creates a model in which surfaces are illuminated with physically accurate energy calculations, computed with a radiosity renderer. This is accomplished with mental ray to deliver global illumination results when photometric lights are translated to a comparable physically accurate radiosity solution.

There are two main photometric light types: targeted and free. (See Fig. 22.7.) Similar to cameras in 3ds Max, Free Light is a single point that is placed within the scene. Target Light has one point from which light is being emitted and a second point that specifies the direction or vector of the emitted light.


Figure 22-7. Create tab, Photometric lights.
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When creating either Free Lights or Target Lights, you can select templates that make the light behave with the physical properties of a real-world light. The templates adjust properties in the distribution and intensity/color/attenuation rollouts. After applying the template, small adjustments can be made to fine-tune the lights. (See Fig. 22.8.)


Figure 22-8. Photometric light templates.
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Because photometric lights are working with real-world attributes, it is important that the scene uses real-world units and the model is scaled appropriately. If the model is not built at a 1:1 ratio, then the lighting properties will not work as they are intended. Photometric lights are computationally accurate, but the visual representation may not be accurate within the rendered image. This means that the amount of energy and behavior of the light is mathematically correct, but the representation of features such as shadows may not behave with the same complexity as in the physical world.

Creating lights is similar to creating other objects; a Free Light requires a single click, and a Target Light requires a click and drag to define the source of light and the direction in which the light casts. Lights can then be moved within the scene using all of the transform tools. Each light thus affects the scene based on its properties. (See Fig. 22.9.) When creating a photometric light, a dialog appears asking if mr Photographic Exposure Control should be enabled. In most cases you will want to use the exposure control.


Figure 22-9. Lights placed within scene.
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Figures 22.10, 22.11, and 22.12 show the same lights placed within the scene but with different lighting templates applied. Notice the changes in intensities, light distribution, and light color in each rendering. The scenes are rendered with mental ray and medium Final Gather settings.


Figure 22-10. 100W Bulb template.
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Figure 22-11. Recessed 75W Lamp template.
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Figure 22-12. Street 400W Lamp template.
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Shadows

Shadows are extremely important in determining how a scene is perceived. To enable Shadows for a light, check the box next to the On button in the Shadows rollout, and then select the Shadow type from the rollout. As with most features in 3ds Max, there are several ways to generate shadows, but there are three specifically that can be used with the mental ray renderer. 

Shadow Maps are the default Shadow type when creating a light; they can produce soft shadows that render quickly. The accuracy of Shadow Maps is determined by the size of the Shadow Map generated. This can be adjusted in the Shadow Map Parameters rollout in the light settings. The higher the Shadow Map size, the crisper the shadow will be; however, it will also use more memory. The other setting that may need adjusting is the Bias. Increasing the Bias moves the shadow away from an object, and decreasing it moves it close to an object. (See Fig. 22.13.)


Figure 22-13. Shadow Map settings: bias 0.5 and shadow map settings at 128, 256, 512, 1024, and 2048.
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Shadow Maps in mental ray are similar to these Shadow Maps, but they provide more accuracy and control. The mental ray Shadow Maps are not as efficient as Shadow Maps; however, the added accuracy and the ability to create transparent shadows is an advantage.

Ray Traced Shadows are very accurate but are much slower to render than either Shadow Map method. The advantages of Ray Traced Shadows are accuracy and support for Transparent Shadows and Opacity Maps. (See Fig. 22.14.)


Figure 22-14. Ray Traced Shadows support Opacity Mapping, and Shadow Maps do not.
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Daylight Systems

Daylight systems are a combination of objects and controllers that work as a single system. In this case, a direct light and a skylight are controlled by a solar date/time controller that creates a daylight solution. A daylight system can be created from the Create tab under Systems. When creating the daylight system, the first click and drag creates the compass rose. After letting go of the mouse button, a direct light appears that can be pulled back from the compass rose and set with a second click. This creates the daylight system. (See Fig. 22.15.) The size of the compass rose and distance of the light are not important; they are only representations of the way the system functions.


Figure 22-15. Daylight system.
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Once the daylight system has been created, there are several options that can be adjusted. Selecting the compass rose enables you to adjust the radius of the rose in the Modify panel. This can helpful if initially the rose was created at a size that is too small or too large to manipulate. It is also possible to use the Rotate tool to change the direction of north for the compass rose, which may be necessary if north is in a direction other than the direction in which the rose was initially created.

To adjust the properties of the daylight system, select the light. By default, this is called “daylight001.” After selecting daylight001, the first adjustment is to change the Sunlight and Skylight types in the Daylight Parameters rollout to mr Sun and mr Sky. 

When changing the sky to mr Sky, 3ds Max asks to change the environment map to mr Physical Sky. This is a dynamic map that generates a sky based on the time of day. This map is placed in the Environment Map slot under Render ⇒ Environment. To edit this map, drag it from the Environment dialog into the material editor as an instance. From there, it is possible to adjust the Disk Intensity, Glow Intensity, and Scale. (See Fig. 22.16.)


Figure 22-16. Daylight rollout, Sunlight and Skylight selection, and additional parameters.
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In the Modify panel, there are several options that can be adjusted to control the intensity of the sun and sky, as well as how the daylight system functions. For most situations, the default settings are appropriate.

The mr Sun, mr Sky, and mr Physical Sky map are all controlled by a date, time, and location controller that can be accessed by pressing the Setup button in the Modify panel under the Position rollout, which brings up the Control tab, displaying the Control Parameters. Control Parameters allow you to specify the time, month, day, and year, as well as choose a location or enter a specific latitude and longitude. (See Figs. 22.17 and 22.18.)


Figure 22-17. Date, Time, and Location Controller properties.
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Figure 22-18. Daylight system set up to render at 6:30 a.m., noon, and 6:30 p.m.
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While Daylight systems light scenes very effectively, it may be necessary to additionally use a Sky Portal to push light into spaces that do not receive direct light. The Sky Portal can be an effective tool to put light into hard-to-reach areas without having to crank up the Global Illumination (GI) or Final Gather bounces. A Sky Portal is another type of photometric light, which can be created from the Create Tab ⇒ Lights ⇒ Photometric.

Final Gather and Global Illumination

Global Illumination (GI) is the consideration of how light is bounced throughout a scene. Using mental ray, GI is implemented using Photon Tracing or Final Gather. Photon Tracing traces the light from the source to the final target, and Final Gather traces in the opposite direction. 

GI Photo Tracing is enabled in Rendering ⇒ Render Setup ⇒ Indirect Illumination tab ⇒ Caustics and Global Illumination rollout ⇒ Global Illumination (GI). Here it is possible to adjust settings for the Global Illumination calculations.

A key parameter that affects quality and rendering time are the photon samples. More photon samples create less noise but longer render times. The second parameter is the sampling radius. By default, the sampling radius is 1/10 the radius of the scene. The default value often works well but may be adjusted to help create natural caustics.

Objects render with GI by default, but it is possible to exclude objects from the GI calculations by selecting the object, right-clicking, selecting Object Properties, and then navigating to the mental ray tab. (See Fig. 22.19.)


Figure 22-19. Global Illumination settings.
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Final Gather (FG) is an approximation of Global Illumination that computes bounced light from a series of points. It is not possible to compute every light point; therefore, Final Gather creates a solution from a fraction of those points. The higher the number of points, the more refined the lighting solution. Final Gather can be used with or without Photon Tracing. When it is used with Photon Tracing, it provides an extremely refined lighting solution. If Final Gather is used alone, it can provide an accurate solution that is particularly suited to novice 3D artists. 

Final Gather picks up the colors of objects and reflects them in shadows. The number of Final Gather bounces is equal to the number of times reflected light will bounce off the surface of objects. The Final Gather settings can be found at Render Setup ⇒ Indirect Illumination ⇒ Final Gather rollout. There are several Final Gather parameters that are important to understand. (See Fig. 22.20.)


Figure 22-20. Final Gather settings.

[image: 902943c22f020.tif]


Initial FG Point Density controls the number of initial points that are sampled. Rays Per FG Point specifies, for each sample taken, the number of rays to send to that point. Interpolate Over Num. [Number of] FG Points applies a smoothing factor to the render and blends points together. Diffuse Bounces determines whether a Final Gather ray will generate additional Final Gather rays. By adjusting the number of bounces, it is possible to send light farther into areas where direct light does not reach. These settings can be adjusted independently or through the slider that allows you to choose between draft, low, medium, high, and very high quality (the slider does not add bounces). 

Final Gather is view dependent, meaning that each camera view yields different rendering results. Final Gather may need to be adjusted for each view rendered within a scene. If Final Gather is used to render animations, users may notice flickering within the rendered scene. To fix this issue: Render Settings ⇒ Final Gather rollout ⇒ set the Final Gather drop-down to Project Point From Positions Along Camera Path. This causes 3ds Max to take additional samples as the camera moves frames. A setting value of 9 should be sufficient. You will notice during rendering that nine squares appear; these are the nine different sample areas for Final Gather.

See Figures 22.21 through 22.24. The Sponza Atrium model was created by Marko Dabrovic and has been used as a lighting test by the CG community. It is readily available at many sites in formats usable within most modeling and animation software.


Figure 22-21. Sponza Atrium, Final Gather draft settings, bounces = 1, render time = 0:16.
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Figure 22-22. Sponza Atrium, Final Gather draft settings, bounces = 1, render time = 0:24.
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Figure 22-23. Sponza Atrium, Final Gather medium settings, bounces = 5, render time = 5:15.
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Figure 22-24. Figure 22-24. Sponza Atrium, Final Gather high settings, bounces = 10, render time = 33:13.
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Chapter 23

Atmospheric Conditions

Haze and Fog

Haze and fog are atmospheric conditions that add informational cues about a place. In the background, haze can add a sense of depth, suggesting the continuation of context beyond the local scene. In the foreground and middle ground, haze and fog can provide information about time of day or the environmental health and condition of a place by suggesting nearby water, sunrise or sunset, or pollution. 

Haze is caused when sunlight encounters particles in the air. Light is absorbed and scattered by particles, obscuring the visibility of the sky. The more particles that are suspended in the air, the more scattering and absorption of light will occur. Under certain conditions of weather or when pollutants and smoke are not able to disperse, they cling together to form a hazy cloud at a low level. Fog is similar to haze, occurring when moisture in the air obscures light, creating a low-lying cloud or mist.

There are three types of sky models in 3ds Max that can be used to generate atmospheric cues: Haze Driven, Perez All-Weather, and CIE.

The Haze Driven model should work well for most situations, although it is not true for physical accuracy. (See Fig. 23.1.) The Haze Driven model is the only choice for sunrise/sunset or nighttime renderings.


Figure 23-1. Aerial perspective showing use of haze in rendering to create receding background.
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The Perez All-Weather is an industry-standard, physically accurate model. This model works well for daylight scenes but does not work for twilight or nighttime scenes. It is calibrated to work with the lighting analysis tools.

The CIE sky model is capable of representing a clear or diffuse sky and is another industry-standard sky model. This model is also a daylight-only model and does not work with dawn, dusk, or nighttime renderings.



Tutorial 23.1 Haze Driven Sky Model

With a daylight system, it is possible to adjust haze settings in the Haze Driven sky model. 


1. Create a daylight system. Choose mr Sun for Sunlight and mr Sky for Skylight.

2. With the daylight system selected, in the Modify tab under the mr Sky Parameters rollout, choose Haze Driven. (See Fig. 23.2.)


Figure 23-2. Haze Driven sky parameters.

[image: 902943c23f002.tif]


3. Adjust the amount of haze under the mr Sky: Haze Driven (mr Sky) rollout, Haze spinner. A value of 0 represents a clear day, and a value of 15 represents a particulate-filled environment similar to a sandstorm. (See Fig. 23.3.)




Figure 23-3. Haze Driven sky values of 0, 7, 15.
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Tutorial 23.2 Generating Environment Fog

Distinct from haze, fog can be generated using an environment fog effect, which allows control over the fog color and near and far distances. 


1. To add fog, navigate to Rendering ⇒ Environment. In the Environment and Effects tab, under the Atmosphere rollout, click Add and choose Fog. 

2. Below the Atmosphere rollout, a Fog Parameters rollout appears. Adjust the Near % and Far % parameters and the Color parameter. (See Fig. 23.4.)


Figure 23-4. Environment Fog Parameters.

[image: 902943c23f004.tif]


3. If transparent objects or opacity maps are used, be sure to select the Exponential option. This changes the fog’s behavior from linear to exponential as it recedes from the view.

4. It is also necessary to adjust the Physical Scale in the mr Photographic Exposure Control rollout above the Fog Parameters, if mr Photographic Exposure Control is used. Change the Physical Scale to Unitless and set it to a value of 30,000. 

5. Under the Fog Parameters rollout, you can change the type of fog from Standard to Layered, which allows for adjustments in the vertical placement and thickness of the fog. (See Figs. 23.5 and 23.6.)




Figure 23-5. Environment Fog, near fog 0%, far fog 80%.

[image: 902943c23f005.tif]



Figure 23-6. Layered Environment Fog, bottom 0', top 15', 45% density.
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Clouds

Clouds are collections of water vapor that are suspended in the atmosphere. The water vapor may consist of suspended water droplets or frozen water and typically is represented as either a single element or an entire atmosphere. Clouds typically form a mass; therefore, they are rarely represented as single objects. In many cases, clouds can be represented through imagery placed on the horizon or composited into final renderings. It may be necessary to create cloud objects or surfaces for animations or shadow-casting purposes. Clouds can be created in multiple ways in 3ds Max.



Tutorial 23.3 Creating Clouds Using Opacity Mapping

The first method is to create a material with an opacity map that is applied to a plane, which then becomes the cloud layer.


1. Create a plane that is large enough to cover the entire sky of the model. We will use a 6000' × 6000' plane. The plane should have only one segment so as not to create extra geometry. 

2. Move the plane in the Z axis to the desired height for the cloud layer. 

3. At this point, the plane will cast shadows; however, it is recommended that you turn off shadow casting, as the results can be unrealistic. Right-click on the plane and select Object Properties. Uncheck the Cast Shadows option.

4. In the Slate Material Editor, create a new Standard material and change the Diffuse Color to pure white. Make sure the 2-Sided box is checked under the Shader Basic Parameters rollout.

5. In the Material/Map Browser, under the Maps/Standard rollout, find and drag the Noise map into the view window. Adjust the Additional Parameters/Noise Size to 50. To make the clouds more defined by creating more contrast in the Noise map, adjust the Noise Thresholds to high value = 0.75 and the low value = 0.3. Change the Noise Type from Regular to Fractal.

6. Drag a gradient map onto the slate editor and change the gradient type to radial. This is used to fade the Noise map on the edge of the plane. 

7. Drag a Mask map onto the slate editor. 

8. Assign the relationship of the maps to the material. Drag a wire from the Mask map to the Standard material’s Opacity channel. Wire the Noise map into the Map channel of the Mask map and the Gradient map into the Mask channel of the Mask map.

9. Assign the material to the plane and make adjustments as necessary. (See Fig. 23.7.)




Figure 23-7. Cloud material.
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Copying the cloud planes and shifting or rotating them so that they are not perfectly aligned creates multiple layers of clouds. Animating the phase value over time can create movement in the clouds. (See Fig. 23.8.)


Figure 23-8. Rendered clouds.
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It is also possible to use this method with smaller objects to create more strategically distributed clouds or, by using images of clouds mapped to planes, with an associated opacity map.





Tutorial 23.4 Creating Clouds Using Volume Fog

A second method to create clouds uses an atmospheric Box Gizmo with a Volume Fog applied.


1. From the Create panel, click Helpers: Atmospheric Apparatus ⇒ Box Gizmo. Create a Box Gizmo the size of the cloud to be rendered; something around 120' × 60' × 20' will work. 

2. Place the Box Gizmo within the 3D scene at a Z elevation to work with the scene.

3. Under Rendering ⇒ Environment ⇒ Environment tab: Atmosphere rollout, click Add and choose Volume Fog, then click OK. 

4. Underneath the Atmosphere rollout, the Volume Fog Parameters rollout will appear. (See Fig. 23.9.) Click Pick Gizmo and select the Box Gizmo created previously. To create the cloud, choose the following settings:




Figure 23-9. Volume Fog Properties.
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Exponential: on

Density: 75

Step Size: 50

Max Steps: 75

Fog Background: on

Noise type: turbulence

Noise threshold: high 1 and low 0

Uniformity: 0

Levels: 3

Size: 300

Phase: 0

These settings serve as a starting point, and you should experiment with them to achieve the desired effect. (See Fig. 23.10.) Note: If using mr Photographic Exposure Control, be sure to set the physical scale to 30,000.


Figure 23-10. Multiple Volume Fog clouds.
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Sunset/Sunrise

Sunset and sunrise are illustrated almost exclusively through lighting conditions. Two effects discussed previously can be combined to create convincing sunset and sunrise conditions. A daylight system in combination with the Haze Driven sky model is extremely effective at generating a sunrise or sunset. It may also be necessary to slightly increase the Haze value to 5 and/or add a light Volume Fog effect.



Tutorial 23.5 Using the Daylight System to Create Sunrise/Sunset


1. Create a daylight system and select it in the scene.

2. Select Haze Driven sky model and adjust the Haze value to 5 in the Modify panel.

3. Under the Daylight Parameters rollout, click Setup. This opens the Daylight Parameters in the Motion panel. Select a time of day early in the morning or late in the evening. The light quality generated from the daylight model helps to create the perception of sunrise or sunset even without seeing the horizon. When the horizon is visible, the effect is magnified. (See Figs. 23.11 and 23.12.) Note that these parameters can be animated, as will be further discussed in Chapter 25.




Figure 23-11. Sponza Atrium, 7:30 a.m.
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Figure 23-12. Boxes 6:30 a.m.
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Chapter 24

Advanced and Real-Time Lighting Systems

Caustics

Caustics are effects of light reflected from or refracted through surfaces, which in 3ds Max are computed using photon mapping. A visible form of caustics is the pattern light makes as it is reflected from the surface of water or refracted through to the bottom of a pool. It is also noticeable when light shines through glass or other transparent materials that refract light.

Enable Caustics in 3ds Max through Rendering ⇒ Render Setup ⇒ Indirect Illumination tab: Caustics and Global Illumination (GI) rollout. Each object that will generate or receive Caustics, including lights, must also be specified. This can be done by selecting the object, right-clicking, selecting Object Properties ⇒ mental ray tab: Caustics and Global Illumination (GI). Check the appropriate boxes to exclude, generate, or receive Caustics. (See Fig. 24.1.)


Figure 24-1. Object Properties dialog and Caustics rollout in Render Setup.
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Caustics can be used in conjunction with Global Illumination. Caustics should be used only when the effect is necessary for the rendering. (See Fig. 24.2.) In most cases, the effect adds significantly to the render time and can therefore be prohibitive in large scenes.


Figure 24-2. Water surface rendered with and without Caustics.
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HDR Imagery

HDR (or HDRI) stands for High Dynamic Range (Image). The higher dynamic range allows the imagery to store greater luminance values, from the lightest to the darkest areas of the image. This information goes beyond the abilities of standard digital imaging techniques and more accurately represents the range of light in the real world.

HDR images can be used to light scenes in 3ds Max using a self-illumination method. It is also possible to use an HDRI image with a skylight where the HDR image is placed in the Map slot.



Tutorial 24.1 Using an HDR Image to Light a Scene 


1. Create a new scene with a ground plane and several objects that will sit on the ground plane—in this case, several spheres. Plane: 50' x 50', Spheres: 1' radius.

2. Create a camera that is focused on the objects and ground plane. (See Fig. 24.3.)


Figure 24-3. Spheres and plane within view of the camera.
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3. Create a sphere that will encompass the ground plane, camera, and any objects on the plane. This sphere will use a standard material with an HDR bitmap image to illuminate the scene.

4. To ensure that the HDR image will be applied to the inside of the sphere, add an Edit Mesh modifier, select all of the polygons, and flip the normals in the Modify panel. 

5. Next, we will create a standard material and add an HDR image to the self-illumination channel to use for lighting the scene. HDRI can be obtained from many sources, such as stock collections, or it is possible to create your own HDR imagery. The image used here has been provided by Aversis (see Fig. 24.4.). A diverse set of HDRI sets can be found at www.aversis.be/hdri/.


Figure 24-4. Aversis HDR image.
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6. Press M to open the material browser, and drag a new standard material into the editor; change the Diffuse Color to black. 

7. Drag a bitmap to the editor and navigate to the HDR image that will be used to illuminate the scene. After selecting the .hdr image in the HDR Load Settings under Internal Storage, select Real Pixels (32bpp), and click OK. 

8. Connect the bitmap to the Self-Illumination channel of the standard material. 

9. Under the Shader Basic Parameters of the standard material, check the box for 2-Sided. With the material selected, enable Show Standard Map in Viewport, and apply the material to the large sphere. (See Fig. 24.5.)


Figure 24-5. Standard material with HDR image in the Self-Illumination channel.
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10. Ensure that Final Gather is on in the Render Setup dialog.

11. Create an omni light to produce shadows within the scene. Once the light is created, set the Intensity value to properly light the scene. Try values between 0.01 and 1.0, adjusting to suit.

12. Open Rendering ⇒ Environment. Under the Exposure Control rollout, select mr Photographic Exposure Control from the drop-down and check the box next to Process Background and Environment Maps. Under the mr Photographic Exposure Control rollout, set the Shutter Speed and Aperture values to 1.0. 

13. Press the Render Preview button under Exposure Control to get a preview of the render. If the image does not appear to render correctly, adjust the Shutter Speed and Aperture (f-stop), again press Render Preview, and continue adjusting until the image is rendered correctly (Fig. 24.6).




Figure 24-6. Rendering utilizing HDR imagery for lighting.
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Tutorial 24.2 Using an HDR Image with a Daylight System


1. Using the same sphere and plane setup as in Tutorial 24.1, create a daylight system. In the Daylight properties, change Sun to mr Sun and Sky to Skylight. 

2. Make sure Exposure Control is set to mr Photographic Exposure Control and Final Gather is enabled on low setting. (See Fig. 24.7.)


Figure 24-7. Spheres rendered without the HDRI image in place.
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3. Under the Daylight parameters in the Modify panel, under the Skylight Parameters rollout, click the Map button (marked NONE) and add a bitmap. Browse to the HDRI that will be used to provide lighting. The HDRI Load Settings dialog box will open. In the HDR Load Settings under Internal Storage, select Real Pixels (32bpp), and click OK.

4. In the material browser, double-click on the HDR image to open the Material Parameter Editor; under Coordinates, choose Environ, and under the Mapping drop-down, choose Spherical Environment.

5. Open Rendering ⇒ Environment, and drag the map from the Skylight Map slot to the Environment Map slot. Be sure it is instanced. 

6. Render the view to see the results. (See Fig. 24.8.)




Figure 24-8. Spheres rendered with the HDRI image in place.
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It is possible to change the sun to use a manual position, which allows for more precise adjustment to match the light sources in the HDRI image. It may also be necessary to adjust the RGB output in the HDRI image. This can be accomplished in the material editor within the bitmap properties in the Output rollout. (See Fig. 24.9.)


Figure 24-9. Output rollout.
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iray

The iray renderer is an addition to 3ds Max 2012 and is a physically accurate renderer that takes advantage of advances in graphics processing units (GPU)—specifically, the Compute Unified Device Architecture (CUDA) programming model developed by NVIDIA. Unlike mental ray, iray does not use Render Specific Shaders to approximate Global Illumination but instead uses a full, physically accurate model. When setting up iray, there are very few settings because iray simulates the physical behavior of light. This means there are no settings for GI accuracy or Final Gather refinement; instead, iray renders for a specific amount of time, number of iterations, or unlimited, and attempts to calculate a final solution for a rendering. 

This rendering method allows the user to immediately see the results and then refine the solution over time. (See Fig. 24.10.) Because iray renders a physically accurate solution, it consumes a vast amount of resources in the process. Without a powerful NVIDIA graphics card that supports CUDA, rendering can be very slow. 


Figure 24-10. Example of rendering using iray.
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Alternative Renderers

Several alternative renderers exist for 3ds Max that can be used for production or active shade rendering. Vray, Brazil, and Maxwell are the most common and widely used alternative render engines, with Vray being the most common among the group. These render engines are often on the bleeding edge in terms of speed and features and can provide users with amazing results. Obviously, the disadvantage is the additional cost associated with purchasing another rendering engine. Interoperability can also be an issue if multiple users work on files, as each workstation will need a license and outside consultants will also need to have the render engine to use the files.





Chapter 25

Temporal Atmospheres

Perception of Time

Several different techniques are possible to illustrate scenes that portray a sense of time that can function on various time scales. One of the most common techniques is to animate the daylight time/date, haze, and/or fog to convey passage of time. In this chapter, we explain this technique; however, animation in general is discussed in further detail in Part 6, Chapters 26 through 28.



Tutorial 25.1 Animating the Passage of Time

Animating the daylight systems time and/or date requires adjustment of the time/date settings and setting keyframes throughout the animation sequence, as covered in Part 2, Chapter 9. In this animation, the time is animated over the course of a day from 5 a.m. to 8 p.m. in the span of 30 seconds. 


1. Begin by setting the animation length to 900 frames: 30 frames per second x 30 frames. Open the Time Configuration dialog by clicking on the Time Configuration button in the Status toolbar, which is generally located at the bottom of the screen. Under Animation, set Length: 900, and click OK. (See Fig. 25.1.)


Figure 25-1. Time Configuration.
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2. Select the daylight system. In the Modify panel under the Daylight Parameters rollout, select Date, Time and Location for the Position and press the Setup button. This opens the Date, Time and Location controller in the Motion panel. Ensure that the time slider is at 0, and set the initial time of day: 5 a.m.

3. Move the time slider to frame 900. Press Auto Key, and change the time of day to the final time: 8 p.m. 

4. After setting the times, the spinners will appear red in the Modify panel. Press the Auto Key button again to turn off Auto Key. Move the timeline back and forth to see the daylight system animate from 5 a.m. to 8 p.m. (See Fig. 25.2.)


Figure 25-2.  Date, Time and Location controller with Time parameter animated.
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5. Next, we will animate a layered fog that is present in the morning and disappears by 8 a.m. Open Rendering ⇒ Environment, and add Fog to the Atmosphere rollout. In the Fog Parameters rollout, change the Fog type to Layered and set the vertical height and density. (See Fig. 25.3.) If mr Photographic Exposure Control is used, set the physical scale to 30,000. 


Figure 25-3.  Fog Parameters.
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6. Using the Density parameter in the Fog Parameters, animate the fog dissipating from 5 a.m. to 8 a.m. Set the initial density at 5 a.m. (0 on the timeline) at 50%; move the time slider to approximately 180 (when the daylight system is at 8 a.m.). Turn on Auto Key and change the density parameter to 0%. Turn off Auto Key. The fog is now animated from 5 a.m. to 8 a.m., changing from 50% to 0%. (See Fig. 25.4.) Similarly, the top and bottom heights can be animated to make the fog appear as though it is lifting in the atmosphere. (See Fig. 25.5.)




Figure 25-4.  Fog animating from 5 a.m. to 6:30 a.m. to 8 a.m.
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Figure 25-5.  Frames from animated sequence showing daylight system change from 5 a.m. to 8 p.m. with morning fog layer.

[image: 902943c25f005.tif]


Based on the preceding steps, it should be apparent that many of the environmental and atmospheric properties can be animated. These methods can be used in a variety of ways not only to relate the passage of time, but also to craft mood, tone, and style.

Figure 25-5. 




Wind

Wind is a dynamic atmospheric effect that also affects the way environments are perceived. In 3ds Max, wind is simulated using particle systems and the wind force, which will be discussed in Section 6 in Chapters 29 and 30. 

In most cases, wind is apparent in the movement of objects and the change in surfaces. This effect can often be faked by animating maps or by animating repetitive motion. 

The noise in the form of modifiers, maps, or controllers can be animated through its phase value. (See Fig. 25.6.) This can create an oscillating effect that resembles a disturbance such as wind.


Figure 25-6.  Noise phase.
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Part 6

Simulation





Chapter 26

Animation

Motion and Keyframing

Animation allows designers to create time-based representations focusing on movement within space and/or evolving site conditions. Animation is created through a series of frames that are viewed at the rate of 30 frames per second (fps) to create the illusion of a continuous moving picture. In 3ds Max, it is possible to animate objects and render images for each frame that can then be assembled into animations. Rather than rendering single frames, as we have done in past chapters, 3ds Max renders each frame within a specified time sequence and saves the file to individual images or a compiled movie file.

3ds Max uses keyframing to create animation for objects and properties. Keyframes store information about an object or properties state at points in time. It is possible to create keyframes for nearly every property in 3ds Max, generating a limitless amount of possibilities when building an animation. Animation occurs as properties change from one keyframe to the next. For example, a sphere that is located at 0,0 with a keyframe at frame 0 can move 30’ in the X axis over 60 frames by creating a second keyframe at frame 60 with the sphere at 60,0. (See Fig. 26.1.)


Figure 26-1. Sphere moving between two locations over 60 frames with two keyframes that specify the sphere’s location.
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The concept of keyframing dates back to the early days of animation when the senior artist would draw the keyframes that would be used for prototyping motion. Once approved, the assistants would draw the motion in between the keyframes. In 3ds Max, you are the senior artist and 3ds Max fills in the frames between the keyframes that you define. You have the ability to define not only the keyframes but also the behavior of the change through curves that express changing motion. (See Fig. 26.2.)


Figure 26-2. Curve Editor showing frame 30 of 60-frame animation of sphere moving 30' along the X axis.
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Animation Tools

3ds Max has a robust set of animation tools for creating and editing animations. (See Fig. 26.3.) The tools discussed in the animation section are located in the toolbars, the motion panel, the playback controls, and the timeline. 


Figure 26-3. Animation tools.
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The timeline and playback controls at the bottom of the interface are where the tools reside to do basic keyframe creation and editing. (See Fig. 26.4.) The timeline displays the current length of animation. When creating an animation, keyframes can extend beyond the current length of the timeline in either the positive or the negative direction. 


Figure 26-4. Timeline and playback controls.
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This is important for very long animations, as it may be necessary to shorten the length of time that is being worked with to see the details of the keyframes, but this will not delete the keyframes that fall off the timeline. The length of the animation can be adjusted in the Time Configuration dialog along with several other options, including frame rate, time display, and playback. (See Fig. 26.5.) By default, the animation will attempt to play back in real time in the active viewport, but it is possible to force the animation to slow down or speed up in its playback. Often, animations play back more slowly than the real-time frame rate when viewed in the viewport due to the performance of the video card. 


Figure 26-5. Time Configuration dialog.
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When creating animations in 3ds Max, we work with frames in the timeline that translate to time when we are producing the final animation. Typically, we use 30 frames per second; therefore, the timeline translates to 1 second of animation for every 30 frames. When we play back the animation, it is possible to view the current frame rate by pulling up the statistics in the viewport. Click on the + in the upper-left corner of the active viewport, navigate to xView ⇒ Show Statistics (7). When playing an animation, the current frame rate is displayed; as long as the frame rate displayed is greater than the current frame rate (30 fps), you will know that the animation is playing in real time. If the frame rate drops below the current frame rate, then you will experience stuttering and skipping in the animation. This should be considered when trying to use the viewport as a preview for an animation’s behavior, as it may not always be reliable.

Creating keyframes is at the heart of animation in 3ds Max and can be accomplished using two main methods: Auto Key and Set Key. In general, Set Key offers more control than Auto Key in that transformations are tested and keys are then committed once they work. When Auto Key is enabled, transformations are automatically keyed until Auto Key is turned off.



Tutorial 26.1 Using Set Key to Create Animation

Set Key works using two buttons: the toggle Set Key mode and the Set Keys button. (See Fig. 26.6.) The work flow for Set Key keyframing works by transforming an object and then setting a key for that transformation at the intended point in time. 


Figure 26-6. Set Keys, toggle Set Key mode, and Auto Key.
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1. Create a sphere (~5' radius) at 0,0,0 to test how to use Set Key. 

2. In Time Configuration, set the Animation Length to 60 frames. 

3. Select the sphere and enable the Set Key mode (button below Auto Key). A red outline should appear around the screen to let you know that Set Key mode is enabled. 

4. To create a keyframe for the current position at frame 0, move the time slider to frame 0 and click on the Set Keys button. A key marker will appear at frame 0. 

5. Move the time slider to frame 60 and move the sphere 30' in the positive X direction (type in 30' in the X value of the transform dialog at the bottom of the timeline). 

6. Press the Set Key button again to turn off the Set Key mode; the red outline on the screen should disappear at this point.

7. If you move the time slider back to frame 0 and click Play on the playback controls, you will see that the sphere starts at frame 0 at 0,0,0 and moves to 30',0,0 by frame 60. 



Set Key has placed a key in the timeline for each property at frame 0 and then again for each property at frame 60. 3ds Max fills in the movements in between to create motion between the two points. The properties that are keyed are based on the settings in the Key Filters, which is located between the playback controls and the key buttons. By default, keys are created for Position, Rotation, Scale, and Inverse Kinematics (IK) Parameters. 

Each time the Set Key button is pressed, a key is created for each one of the parameters specified in the key filters. It is possible to set keys for every property, but if only some properties are being changed it can become unwieldy to attempt to edit an object’s animation if every parameter has keyframes on it. In this case, we have created keyframes for the X,Y,Z values for Position, Rotation, and Scale, while we have changed only the X value for the position. You will notice in Set Key Filters that it is also possible to set keys for properties such as Modifiers, Object Parameters, and Materials. (See Fig. 26.7.)


Figure 26-7. Set Key Filters.
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The animation created moves the sphere 30' over 2 seconds (60 frames/30 fps = 2 seconds). Edit the animation by selecting the keyframes in the timeline and moving them. Simply click on the keyframe and then drag it to a new location. If the keyframes are moved closer to each other, the animation moves faster; for example, if the keyframe at frame 60 is moved to frame 30, the same movement over 30' in the X direction now occurs in 1 second rather than the previous 2 seconds. More time can be added to the animation in the Time Configuration dialog to stretch the animation out over a greater number of frames, slowing the animation down. 





Tutorial 26.2 Using Auto Key to Create Animation

Auto Key works through a slightly different paradigm than Set Key. To understand how Auto Key works, move the timeline to frame 0, select the keyframes just made with Set Key, and press the Delete key. It is possible to select them individually or drag a selection across the timeline to select everything at once.


1. Press the Auto Key button. A red frame should appear around the viewport similar to when Set Key is enabled.

2. Move the time slider to frame 60.

3. Move the sphere 30' on the X axis using the transform type-in dialog.

4. Turn Auto Key off. 



Notice that 3ds Max creates a keyframe at frame 60 automatically for the transformation to the new position at 30',0,0. (See Fig. 26.8.) It also creates a keyframe at frame 0 for the initial state of the sphere at 0,0,0. This keyframe is automatically generated at frame 0 because there was no keyframe for the initial state. 


Figure 26-8. Auto Key enabled with keys created at frame 0 and frame 60.
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The keyframes look slightly different from the keys created using Set Key because Auto Key creates keys only for the attribute that changes. In this case, keys were created only for the X,Y,Z position values. This has implications for further animation because there is no key information at frame 0 or frame 60 for Rotation or Scale. This is a significant difference between Auto Key and Set Key that must be recognized. Something we do not have control over in Auto Key, however, can be controlled with Set Key.

At this point, experiment with adding animation to the sphere, moving keys to change speed, and adding other transformations to change the sphere’s motion. The technique used to animate the sphere’s movement can be used to animate modifier properties. Turn Auto Key on, move the time slider, and change the parameter in the modifier to create keyframes that will animate parameter change. (See Fig. 26.9.)


Figure 26-9. Cylinder (5' radius, 100' tall, 20 height segments) with Bend modifier applied and animated to bend 180 degrees over 100 frames.
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After creating keyframes, there are several methods that can be used to edit the keyframes. The most basic editing occurs directly in the timeline, where it is possible to move keyframes, delete them, and even copy them, by selecting a keyframe and holding Shift before moving the keyframe.

For more advanced editing, use the Curve Editor (see Fig. 26.10), which can edit not only the keyframes but also how the change between the keyframes is determined. The Curve Editor is accessible from the main toolbar or Graph Editors ⇒ Track View—Curve Editor.


Figure 26-10. Curve Editor.
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The Curve Editor represents animation as keyframes through a series of curves drawn between keyframes. The main view in the Curve Editor shows time across the horizontal axis and the parameter values along the vertical axis. Each keyframe in the Curve Editor is represented by a white dot, which can be selected and moved with the Move tool, or new values can be specified in the type-in boxes at the top. The Controller box on the left can be used to filter animated parameters. Selected parameters appear in the curves to the right. This makes it possible to show only one or more parameters if necessary.

The curve represents how the object changes between each of the keyframes; steep curves represent fast change; shallow curves represent slow change. The curves make it easy to visualize the changing animation. Change the curve type by selecting a keyframe and choosing one of the different types at the top. (See Fig. 26.11.) The curve type created in the sphere animation accelerates from frame 0–10, then becomes a constant straight line from frames 15–45, and then decelerates from frames 45–60. Select the keyframe at frames 0 and 60, and change the curve type to linear. You will notice that there is no acceleration or deceleration, but instead the sphere moves with a constant velocity.


Figure 26-11. Smooth and linear curves.
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Output Methods



Tutorial 26.3 Rendering an Animation Sequence

To render the animation, there are a few options that must be considered. 


1. Open the Render Setup dialog. Rendering ⇒ Render Setup ⇒ Common tab.

2. Determine the length of the animation that will be rendered. Under the Common Parameters rollout, in Time Output, select Active Time Segment. This renders every frame in the current timeline. It is possible to also render a range of frames or even select specific frames or ranges. If, for example, we wanted to render frames 15–25, we could select Range and choose 15 as the starting frame and 25 as the ending frame. If we wanted to render frames 15, 26, and 29–60, we could select Frames and enter 15,26,29–60. It is also possible to tell the renderer to render, for example, only every fifth frame, or any other Nth frame we would like to use. This can be useful when you

 want to see how an effect or transformation happens over time but do not want to render every frame in the sequence. (See Fig. 26.12.)


Figure 26-12. Render settings.
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3. It is necessary to choose a size for each frame that will be rendered. Under the Common Parameters tab: Output Size, choose a template or indicate a custom width and height. 

4. Indicate to 3ds Max where to save the rendered frames. (If this step is not performed, the frames will render; however, they will not be saved and will, therefore, be lost.) Under the Common Parameters tab: Render Output, click the Files button and choose a location for the frames. Browse to the location/folder you are using to store the frames. Keep in mind that 3ds Max creates an image file for every frame of the animation. Create a file name and choose a file format. We are using .jpg in this example. Click Save, and make any format adjustments needed. Click OK. (See Fig. 26.13.)


Figure 26-13. Render file output.
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5. The file path will be updated in the Render Output box and Save File will now be checked.

6. Click the Render button to begin rendering the images in the animation.



In most cases, it is ideal to render the sequence as a series of images that will then be assembled into a movie file after the rendering. It is possible to render the animation directly to a movie file; however, with longer animations this can become problematic. Rendering to an image sequence keeps the image files intact without compression, except for the image compression from file formats such as .jpg, so that they can be used in other illustrations and/or compositing software. If the animation is long, it is also possible that the computer won’t be able to compress the movie and can crash during the rendering process. If any crashes occur and a movie file is the output, then the entire rendering is lost. When rendering single image files, only the frame currently rendering during the crash is lost.





Tutorial 26.4 Viewing Rendered Images in the RAM Player and Saving as a Movie File

After rendering the animation, you will have a folder with 60 .jpg image files with a numerical sequence appended to each file. For example, if the file name specified were “sphere_animation.jpg,” then each file would be called “sphere_animation0000.jpg, sphere_animation_0001.jpg . . .”

To view the animation as a movie, you can use the RAM (random access memory) player (see Fig. 26.14). The RAM player uses the computer’s RAM to load the image sequence and then preview the images as a movie. The RAM player is a good way to preview your animations but is limited in terms of final output. If your computer is low on RAM, it may not be possible to load large sequences or large image files such as .tif or .tga sequences.


Figure 26-14. RFrames loaded into the RAM Player.
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1. To open the RAM player, go to Rendering ⇒ RAM Player.

2. The RAM player has two channels. Each channel can be loaded with multiple still images or sequences for comparative purposes. Click on the Open Folder icon on Channel A to load the previously rendering .jpg sequence. Select the first image in the sequence and make sure that the check box for the sequence is selected. Click Open. (See Fig. 26.15.)


Figure 26-15. Open File, Channel A.
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3. The settings for the sequence are saved in a small text file called an Image File List Control (.ifl file), which is saved in the directory with the images. (See Fig. 26.16.) The next dialog allows you to determine how the sequence behaves, which is then stored within this .ifl file. It is possible to load a portion of the sequence and to choose whether or not you load every Nth frame; you can also add a multiplier to the frames.


Figure 26-16. Image File List Control.
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4. After this dialog, RAM Player Configuration appears (see Fig. 26.17), which allows you to specify the amount of RAM that will be used, the size of the frames, and which frames to load.


Figure 26-17. RAM Player Configuration.
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5. The image sequence loads into the RAM player. When finished, press Play to view the rendered sequence. In the pulldown, you can choose a frame rate; with the playback controls, you can also advance frame by frame. 

6. If desired, save the RAM player sequence by clicking on the Save icon for Channel A, select a movie file format, and enter a name for the animation. Click Save.









Chapter 27

Linking . Controllers

Hierarchy and Linking

Hierarchies and linking allow objects to control other objects, making animating complex objects easier. You can create hierarchies by setting up a parent/child relationship, whereby the parent controls the motion of the child. This relationship is created using the Select and Link tool. Select the child, and then, using Select and Link, click and drag to link the child to the parent. It is possible to then build a hierarchy from object to object. (See Fig. 27.1.)


Figure 27-1. Select and Link, Unlink, and Bind to Space Warp tools.
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In this example, the blades and wind meter are children to the body. The body is then a child to the base. This creates a relationship whereby it is possible to animate the rotation of the blades so that they spin, then animate the rotation of the body and the wind meter. The animated rotating blades will subsequently move with the body. Those objects will then follow the base whenever it is moved to adjust the position of the overall structure. 

For each of these objects, the pivot points are moved to make sure they are aligned with the axis of rotation for each object. This means that for the blades the pivot point is centered in the middle of the blades and for the body the pivot point is centered over the base. (See Fig. 27.2.)


Figure 27-2. Wind turbine hierarchy and Schematic View.
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To view the hierarchy and easily select each component, use Schematic View (see Fig. 27.3). You can select and link objects in the Schematic View as well as break links.


Figure 27-3. Schematic View button.
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Parameter Curve Out of Range

Using the following example, we will discuss an animation feature called Parameter Curve Out of Range (PCOR) types. PCOR allows us to define the behavior of a keyframe in the pre- and post-time within the timeline. By default, keyframes maintain their value when time moves past the keyframe. This means that if there is not a keyframe to which the animation is attempting to change, then the value stays the same. To create repeating animations, it is possible to tell 3ds Max to continue changing forever.



Tutorial 27.1 Animating Repetitive Motion Using Parameter Curve Out of Range 

In the case of the windmill, we can animate the blades to rotate 90 degrees over 30 frames (1 second), then use a repeat PCOR to make the animation continue forever. 


1. Set up the windmill model and hierarchy. Animate the blades to rotate 90 degrees over 30 frames.

2. Select the blades and open the Curve Editor. The current animation goes from frame 0 to frame 30, rotates 90 degrees, and then stops rotating. (See Fig. 27.4.)


Figure 27-4. 90-degree rotation over 30 frames.
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3. Select the last keyframe (at frame 30), and in the Curve Editor file menu, click on Controllers ⇒ Out-of-Range Types. Choose Relative Repeat and click on the arrow to the right, which defines the Relative Repeat leaving the selected keyframe. (See Fig. 27.5.)


Figure 27-5. Parameter Curve Out-of-Range Types Relative Repeat.
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4. The animation now repeats into infinity. However, the repetition includes the deceleration and acceleration going into and out of the keyframe. To fix this issue, select the keyframes at frame 0 and frame 30 and make them both a linear tangent by clicking on the linear curve type. If you zoom out in the Curve Editor, you will see a straight dotted line continuing upward as the animation repeats. (See Fig. 27.6.)




Figure 27-6. 90-degree rotation continuing to infinity, creating a constant velocity rotation of the wind turbine.

[image: 902943c27f006.tif]


This feature allows us to set up two keyframes, then have 3ds Max handle the rest of the animation. There are several different PCOR types available to create most types of repeating animations. In this instance, it is possible to use another PCOR type, Ping Pong, to create an oscillating animation for the wind turbine body so that it appears to move from side to side over time. This is accomplished by rotating the body 30 degrees over 100 frames, then adding a Ping Pong PCOR to the keyframe at frame 100. This creates a slow oscillating movement.




Controllers and Constraints

Controllers in 3ds Max are used to handle animation tasks and can be accessed from the Track View Curve Editor and the motion panel. Controllers can handle single or multiple parameters or combine multiple controllers into a compound controller. By default, a sphere has a Position/Rotation/Scale controller applied to its transform, which is a compound controller handling the Position: Position XYZ, which is in turn a compound controller handling the X Position: Bezier Float controller. (See Fig. 27.7.) These controllers make it possible to animate each value of the X,Y,Z position of the object as well as the other transforms such as Rotation and Scale. The intricacies of these controllers and animation data can be controlled through the motion panel.


Figure 27-7. Motion panel and default controllers.
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Tutorial 27.2 Adding a Noise Controller

A simple example of a controller that can be added to an object that affects its behavior is the addition of a Noise Controller to the Position parameter.


1. Select the sphere and click the Motion panel. Select the Position parameter under the Assign Controller rollout.

2. Click on the Assign Controller button directly above the parameter window. Choose the Noise Position controller and click OK. (See Fig. 27.8.)


Figure 27-8. Assign Position Controller.
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3. The Noise Controller dialog will appear. Within the dialog, set the X,Y,Z strength, as well as other parameters such as speed and frequency. If you scrub the timeline, you will notice that the spheres position is now controlled by the noise, giving it a random position within the set parameters for each frame. (See Fig. 27.9.) It is possible to animate all of these values to control the Noise Controller over time.




Figure 27-9. Motion panel and Noise Position Controller handling animation of spheres position.
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This controller can be used to add shake to a camera or to simulate rustling of vegetation and does not require animating every movement of the camera to make it appear random.

Constraints are applied similarly to a controller. A constraint controls animation but uses another parameter as the control mechanism. This was explored in Chapter 9, when the path constraint was used to control the movement of the camera. Another example of this is the LookAt constraint.





Tutorial 27.3 Using a LookAt Constraint


1. To use the LookAt constraint, we will create an object: a plane and a target camera (see Fig. 27.10). The plane was created in the Front view and the pivot point is centered on the bottom edge of the plane, as that is the point that will be used to rotate the plane.


Figure 27-10. Camera and plane.
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2. Select the plane, and in the Motion panel click on Assign Controller to add a LookAt constraint to the Rotation parameter. 

3. In the LookAt Constraint rollout, press Add LookAt Target and choose the camera, then change the Select LookAt axis to Z and the Aligned to Upnode Axis to Z. Deselect the Add LookAt Target button. Notice that when the camera moves, the plane now rotates to look at the camera. Fine-tune the orientation by pressing the Set Orientation button and then further rotating the camera to determine how the plane looks at the camera. (See Fig. 27.11.)




Figure 27-11. Animated camera and constrained plane.
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When you are creating billboard trees, this controller can be particularly useful to keep the trees aligned with the current camera view.







Chapter 28

Animation Techniques

Animating Component Construction

We have examined the basic tools and ideas behind animation in 3ds Max and understand that nearly every property and parameter can be animated. We will look at a few options for using animation to illustrate representational components and how those pieces come together to create an understanding of the environment. Similar to an exploded axonometric, a scene can be assembled or disassembled in order to illustrate how the individual pieces relate to one another. 

Terrain Animation

We will use the animation tools in 3ds Max to illustrate the key features of a terrain model using the Slice modifier and by animating the motion of the Slice plane. The animation uses a camera view beginning in a plan view and then moves into a bird’s-eye view that focuses on the sectional character of the terrain. The animation takes place over 300 frames (10 seconds).



Tutorial 28.1 Using Slice Plane in Animation


1. Create or import the terrain model. Set frames to 300. (See Fig. 28.1.)


Figure 28-1. Terrain model created from contour lines.

[image: 902943c28f001.tif]


2. Set up the camera motion, moving from a plan view to an aerial perspective. The transition occurs over the first 200 frames. Position the camera above the terrain model (see Fig. 28.2.), select the camera and camera target, enable Set Key, and press the Set Keys button. Disable Set Key after you have created the keyframes for the camera and the camera target.


Figure 28-2. Camera view above the terrain model.
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3. Next, move the time slider to frame 200 and enable Auto Key. Select the camera and move it into position to view the model from an aerial perspective. After moving the camera, disable Auto Key. The camera should now be animated between frames 0 and 200, moving from a plan view to an aerial perspective. (See Fig. 28.3.)


Figure 28-3. Camera view from aerial perspective.
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4. The model has two pieces of geometry. First are the splines (polylines imported from AutoCAD) that have been used to create the terrain model, and second is the terrain model itself. The splines have been attached using the tools in the Modify panel for Editable Spline, creating a single object. Add a Slice modifier to each object.

For the terrain model, select the subobject Slice plane of the Slice modifier, and rotate the Slice plane 90 degrees. Then, click on the Remove Top option under Slice Parameters. 

This creates a slice that exposes the terrain section cut toward the camera; if the cut is on the opposite side, you can click on the Remove Bottom option or rotate the plane 180 degrees to reverse the effect. Slide the Slice plane all the way to the far edge of the terrain model. When finished, move the Slice plane to the far edge of the model so that the terrain is no longer visible. You will only be able to select the terrain using Select by Name (H) at this point. (See Fig. 28.4.)


Figure 28-4. Slice plane through the sectional cut of the terrain model.
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5. Select the splines (contour lines) and add the Slice modifier. Click on the Remove Top option, go into the Slice modifier subobject mode, and move the Slice plane just below the bottom contour. The contour lines will not be visible at this point. (See Fig. 28.5.)


Figure 28-5. Slice plane through the contour lines.
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6. Animate the Slice plane for the contour lines to move up through the contour lines over 90 frames (3 seconds). With the Slice plane still selected, move to frame 90, enable Auto Key, and move the Slice plane up to just above the top contour. Turn Auto Key off and click on the Slice modifier to exit subobject mode. 

7. The Slice plane should now be animated to move from the bottom contour up to the top contour over the first 90 frames of the animation. 

8. To make the contour lines visible in the viewport, spline rendering has to be enabled. In the Modify panel under the Editable Spline parameters, navigate to the Rendering rollout and click Enable In Renderer and Enable In Viewport. Click on Renderer and select an appropriate thickness for the splines. (See Fig. 28.6.) This makes the splines into mesh objects that can be rendered and viewed in the viewport.


Figure 28-6. Enable spline rendering.
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9. We now have the camera moving from plan to aerial perspective over 200 frames and the contour lines appearing from the lowest elevation to the highest over 90 frames. The animation begins with the camera moving, which can be offsetting. In order to change this, we will allow the camera to be still for the first 60 frames (2 seconds). Select the camera and the camera target. In the timeline, move the keyframes from 0 to frame 60 (see Fig. 28.7). This creates a pause in the first 60 frames, as the position values remain constant, and then the camera begins to move at frame 60.


Figure 28-7. Keyframes moved from frame 0 to frame 60.
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10. Next, animate the terrain model Slice plane using Auto Key so that it moves from one side of the model to the other side of the model, from frame 150 to frame 250. Move the timeline to frame 250 and enable Auto Key. Move the Slice plane to the opposite side of the model using the Move tool. This creates an animation from frame 0 to frame 250 of the Slice plane, revealing the terrain model. Select the keyframe at frame 0 and move it to frame 150.



We now have an animation that reveals the contours while the camera is in plan view. The camera then moves down to an aerial perspective as the contour reveal finishes. At this point, the terrain model is revealed as the camera comes to rest in the aerial perspective. (See Fig. 28.8.)


Figure 28-8. Sequence showing the slice plane revealing the terrain surface.
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Construction

Animating the construction of an element can seem like a difficult task, but in reality it is animating the deconstruction in reverse. We will work from a fully assembled model and then disassemble the model. To animate the construction, set the final position keyframe and then work backward.



Tutorial 28.2 Construction/Deconstruction


1. Select all of the parts that will be animated, and move the time slider to the final frame of the animation. 

2. Set a key for all properties at the final frame of the animation. Press the Key Filters button near the playback controls and ensure that Position, Rotation, Scale, Modifiers, and Materials are all selected. (See Fig. 28.9.)


Figure 28-9. Key Filters options.
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3. Enable Set Key mode and click the Set Key button. This creates a keyframe that the animation will use to know what the final model will look like. 

4. We can now use Auto Key to reposition, change modifier parameters, and/or change material properties anywhere earlier in the animation to create our construction. For example, if we would like objects to come into the view horizontally, we would position the time slider at the appropriate keyframe, enable Auto Key, and then move the elements outside the view. Disable Auto Key and then play the animation. The new keyframe will keep the objects in their position out of the view and then move the objects back to their original position before the final frame of animation. (See Fig. 28.10.)


Figure 28-10. Objects moving in from right to left.
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5. If we want a portion of the scene to be in its final form before the final frame of the animation, we simply select the object and move the final keyframe forward in time. (See Fig. 28.11.)




Figure 28-11. Animated construction sequence.
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Chapter 29

Simulation . Rigid Bodies

Introduction

A simulation is a tool or model used to make determinations through similar attributes that can be linked between the model and an entity or phenomenon. A simulation is similar to an object of study in particular ways, and it allows us to learn about the object of study by virtue of these similarities. The act of simulation can refer to the creation or the use of such a tool or model.

To be useful, a simulation must be similar in some respect to the thing being simulated. Exactly how similar it must be, and in what ways, depends on what is being modeled, the resources available, the type of outcome data required, and the level of accuracy expected.

Given that it must have at least some properties in common with the entity it is modeling, a simulation can be considered a type of representation. Where some models are used only to represent an entity, simulations are used to learn about the processes that formulate an entity or phenomenon. It is possible for nonessential attributes of the subject being simulated to be modeled to a lesser degree of accuracy or not at all.

Simulations can be physical, virtual, or a combination of both. Likewise, simulations may simulate entities or occurrences that are physical, nonphysical, or a combination of both. Simulations may be run in isolation, in combination with other simulations, or in combination with real-world (nonsimulated) entities or occurrences. (See Fig. 29.1.)


Figure 29-1. Erosion model simulating river meandering.
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A flight simulator serves as a good demonstration of the range of attributes a simulation may have. Some flight simulators are entirely software based. Though such programs are run on computers composed of physical components, the programs themselves are entirely nonphysical. The software may entail automatic and arbitrary generation of input data and thus be capable of being run entirely in isolation. Other nonphysical flight simulators may allow the input of user data (e.g., destination and cruising altitude) via a keyboard. In this scenario, the operator of the program and the data he or she inputs are considered part of the simulation.

Another type of flight simulator involves a physical model of a portion (e.g., cockpit) of the airplane being simulated. A human user can interact with the physical components, such as the control stick and throttle, and thereby affect the virtual component of the simulation. Such simulations can be run simultaneously with other flight simulations, sharing a virtual world, and thus forming a larger simulation.

For the past 100 years, the Mississippi River has been the subject of simulation modeling, ranging from rudimentary physical models to complex physical models to virtual digital models. This range of modeling has produced a deep understanding of the fluid dynamics of the river system and has resulted in the engineering of flood control and navigation systems throughout the entire watershed. The modeling of the river has occurred through large-scale tangible models such as the Mississippi Basin Model located in Clinton, Mississippi, which occupies over 100 acres and represents the Mississippi watershed at a scale of 1:1,000. The model represented the river visually, but, more important, it simulated the complex fluid dynamics of the river system. (See Fig. 29.2.)


Figure 29-2. Image of the Mississippi Basin Model.
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The Mississippi Basin Model was replaced by more accurate Hydraulic Engineering Center (HEC) computer modeling in the 1970s. The accuracy, reliability, and speed of HEC modeling were huge advantages, but the tangible or visual representation of the data is minimized. This is important to understand because these two aspects of simulation and representation—visual complexity and simulation accuracy—are continually competing for hardware resources. It is necessary to find a balance between accurate simulation and accurate representation.

Rigid Body Simulation

One type of dynamic simulation is called a rigid body simulation. Rigid bodies are objects whose surfaces do not deform during a simulation. Rigid body simulations have three main types of components: the rigid bodies themselves, constraints, and scene settings.

Rigid bodies are used to simulate solid objects, which we generally consider to be hard, such as a wooden board or a concrete block. In a typical scene, the majority of objects modeled can be considered solid bodies. This distinction becomes important during simulation.

In the real world, these objects are composed of particles. However, since we typically do not desire these objects to change shape or otherwise degrade during a simulation, only their outer surfaces are modeled. Rigid bodies can interact with each other and can be affected by gravity. They can fall, slide, roll, and bounce, but their size and shape remain unchanged by the simulation.

Constraints are another important part of most solid-body simulations. Constraints impose a set of limits on one or more solid bodies. They control where a body is permitted to move, in relation to another object or a point in space. For instance, an object may be limited to rotation around a given point at a given distance, or it may be permitted to move only along a particular path.

The third component of rigid body simulations is the set of parameters, which defines simulation properties for an entire scene. These parameters include the direction and strength of gravity, the speed of a simulation, and rules that determine how rigid bodies interact during a collision.

MRigids

In 3ds Max 2012, a new simulation system called MassFX has been added. MassFX replaces the previous Reactor simulation system. The first module of MassFX to be released is the MRigids rigid body dynamics system.

In MassFX, a rigid body can be one of three types: dynamic, kinematic, or static. Dynamic objects are those whose motion is defined by the simulation. Their movements are created either by interaction with other objects or by gravity. Kinematic objects can affect dynamic objects but are not themselves affected by the simulation. They can be animated through nonsimulation methods or they may remain stationary. Static objects cannot be animated, but they may serve as a wall or container for dynamic objects.

MassFX actions and options can be accessed using the MassFX Toolbar (see Fig. 29.3). This toolbar is not visible by default but can be opened by right-clicking in a blank portion of the toolbar area, then clicking on MassFX Toolbar. The toolbar may then be docked or left floating in a desired location.


Figure 29-3. MassFX Toolbar.
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The toolbar has six buttons. The first button, farthest to the left, is the Show MassFX Tools button. It opens the MassFX Tools dialog, from which a variety of parameters and actions can be accessed.

The second button is the Rigid Bodies flyout. This is used to define a scene object as a type of rigid body. A single click selects the current default body type; holding the button down brings up a list from which you may select Dynamic, Kinematic, or Static Rigid Body.

The third button is the Constraints flyout. A single click enables the creation of the current default constraint. Holding the button down brings up a list of constraint types: Rigid, Slide, Hinge, Twist, Universal, and Ball & Socket. 

The remaining three buttons on the MassFX Toolbar are simulation controls. The first, Reset Simulation, moves the simulation to its first frame and puts all dynamic rigid bodies in their starting positions. The second button, Start Simulation, runs the simulation as well as the main animation. When the button is held down, a flyout opens with the option to run the simulation without the rest of the animation.

In addition to the toolbar, many MassFX options are available through the MassFX Submenu. The submenu is accessible through the menu bar under Animation ⇒ Simulation ⇒ MassFX. 

Pressing the MassFX Tools button in the MassFX Toolbar accesses the MassFX Tools dialog. The dialog has four panels: World, Tools, Edit, and Display. (See Fig. 29.4.)


Figure 29-4. MassFX Tools dialog.

[image: 902943c29f004.tif]


The World panel contains settings that affect simulation parameters for the entire scene. It may be used to add or remove an invisible ground plane or change the direction and strength of gravity. Other options include adjustment of the number of substeps in the simulation, which affects accuracy, and the option to turn on multithreading, which can speed up performance for computers with multiple processor cores.

The Tools panel provides playback controls for the simulation, as well as the ability to bake the simulation. Baking turns the simulation into keyframe animation that can then be manipulated using other animation tools. 

The Edit panel contains the properties to edit the currently selected object’s simulation properties. This includes the rigid-body type, the physical material, and the simulation mesh.

The Display tab provides controls that allow us to tweak the behavior of the simulation in the viewport.



Tutorial 29.1 Rigid Body Simulation 

In this tutorial, we will use rigid body simulation to break apart the trellis model from Chapter 11 (see Fig. 29.5) as a simple and discrete explanation of the dynamics engine.


Figure 29-5. Trellis model.

[image: 902943c29f005.tif]



1. Convert the trellis components to rigid bodies. Using Select by Name (H), select all of the rafters. Using the MassFX Toolbar, set the selected objects to dynamic rigid bodies (see Fig. 29.6).


Figure 29-6. Set selected objects to dynamic rigid bodies.

[image: 902943c29f006.tif]


2. In the Modify panel, set Physical Material to Cardboard to load the presets. Next, set the preset back to None so that you can edit the settings. Change the density to 3. 

3. Using Select by Name, select all of the posts and beams. Using the MassFX Toolbar, set the selected objects to static rigid bodies. (See Fig. 29.7.)


Figure 29-7. Set selected objects to static rigid bodies.

[image: 902943c29f007.tif]


This creates two types of rigid bodies: the top rails that will be affected dynamically by collisions and the post and beams that will collide with objects but will not be affected by the colliding force other than to provide resistance.

4. Use a sphere to fall into the trellis. Create a sphere that has a 2' radius and position it directly over the trellis. Convert the sphere to a dynamic rigid body and use the Steel preset to define its material in the MassFX Modify panel. (See Fig. 29.8.)


Figure 29-8. Sphere created above the trellis that will be used to interact with the geometry.

[image: 902943c29f008.tif]


5. In the MassFX Tools panel, navigate to the Tools tab and press the Play button (gray arrow). Notice that the sphere falls through the rails, knocking them off in either direction (see Fig. 29.9). Reset the simulation in the MassFX Toolbar and try different densities for the sphere to alter the simulation.


Figure 29-9. Sphere falling through trellis structure.

[image: 902943c29f009.tif]


6. Next, create a constraint to control the sphere’s movement. Move the sphere down into the middle of the trellis rails and, with the sphere still selected, apply a Hinge Constraint from the MassFX Toolbar (see Fig. 29.10).


Figure 29-10. Hinge Constraint.

[image: 902943c29f010.tif]


7. Rotate the Hinge Constraint to align it lengthwise with the trellis, vertical above the sphere. Move the sphere so that it is positioned at the top corner of the constraint (see Fig. 29.11). The arc is the path of travel that the sphere will follow; ensure that it intersects with the top rails of the trellis. Press Play to see the simulation.


Figure 29-11. Sphere positioned above the Hinge Constraint.

[image: 902943c29f011.tif]


8. Finally, create an object for the sphere to roll from. Create a thin box big enough for the sphere to rest upon, and center it below the sphere. Position the box so it does not intersect with the sphere but instead sits directly below (see Fig. 29.12). Convert the box to a kinematic rigid box.


Figure 29-12. Sphere positioned above animated box.

[image: 902943c29f012.tif]


9. Animate the box so that it moves slowly out of the way or rotates to allow the sphere to roll off. 

10. Below the playback controls in the MassFX Tools panel, click the Bake All button. This turns the current simulation into keyframe animation over the current timeline. If you need more time for the simulation to complete, add more time in the Time Configuration dialog. 

11. Once the simulation is baked (see Fig. 29.13), the object can be further manipulated through keyframes.




Figure 29-13. Baked animation.

[image: 902943c29f013.tif]


This tutorial demonstrates a few aspects of the way the MassFX rigid body dynamics function. The possibilities as a design and representation tool are limitless. You can create entire dynamic systems that affect one another. The tool requires experimentation, and the component quality creates a virtual physics playground that can be used to experiment with an array of systems.







Chapter 30

Simulation . Particles and Soft Bodies

Particle Systems

Particle systems are used to create a variety of effects, which require randomized elements that are generated and interact by means of procedural methods. These effects are used to create representations of smoke, water, fire, and other amorphous effects not easily created using other modeling and animation methods. The term “particle system” is broadly defined and can mean something slightly different within the context of each different software package. It may also have different meanings in other professions. In 3D modeling and animation, it refers to a system whereby points (particles) are generated by an emitter; the points (particles) then react with one another and with other objects and forces within the virtual environment.

3ds Max implements particle systems through two methods: event-driven particles and non-event-driven particles. The event-driven system generates a particle, checks its current state, and then moves the particle to the next event, creating a series of checks that govern a particle’s life span. The non-event-driven system typically generates particles that do not change over their life span. (See Fig. 30.1.)


Figure 30-1. Particle simulation.

[image: 902943c30f001.tif]


Particle Flow

Particle flow is the event-driven particle system implemented in 3ds Max, which can be accessed through Particle View (see Fig. 30.2). To bring up Particle View, click Graph Editors ⇒ Particle View.


Figure 30-2. Particle View.

[image: 902943c30f002.tif]


Particle View provides the main user interface for creating and modifying particle systems in Particle Flow. The main window, known as the event display, contains the particle diagram, which describes the particle system. A particle system consists of one or more events wired together, each of which contains a list of one or more operators and tests. Operators and tests are known collectively as actions. 

The first event is called the global event, because any operators it contains can affect the entire particle system. The global event always has the same name as the Particle Flow icon; by default, this is PF Source ## (starting with 01 and counting upward). Following this is the birth event, which must contain a Birth operator if the system is to generate particles. By default, the birth event contains this operator as well as several others that define the system’s initial properties. You can add any number of subsequent events to a particle system; collectively, the birth event and additional events are called local events. They’re called this because a local event’s actions typically affect only particles currently in the event. 

Use tests to determine when particles are eligible to leave the current event and enter a different one. To indicate where they should go next, wire the test to another event. This wiring defines the schematic, or flow, of the particle system. 

By default, the name of each operator and test in an event is followed by its most important setting or settings in parentheses. Above the event display is a menu bar, and below is the depot, containing all actions available for use in the particle system, as well as a selection of default particle systems. 

Flowing Water

Flowing water simulation in an animation can add to the sense of time and realism in a scene. There are a variety of methods and techniques that can be explored and modified to craft water flow. The following tutorials use a particle flow and BlobMesh to create a flowing water particle system.



Tutorial 30.1 Flowing Water, Part I: Particle Simulation

The particle system interacts with a surface to simulate gravity pulling water to create a flow. First, we will build the surface and particle system; then we will look at how to craft the water material.


1. Start with a surface. Keep in mind that the particles are affected by gravity and flow downward, so the surface should reflect a terrain that has at least a partial slope at some points. (See Fig. 30.3.)


Figure 30-3. Swale model.

[image: 902943c30f003.tif]


2. From the Create panel ⇒ Geometry: Particle Systems, create a PF Source object and position it on the uphill portion of your surface. Rotate the PF source so that the arrow is pointing in the direction in which you would like the particles to emit. Press Play on the animation timeline to view the default particle emission. Rewind the timeline back to frame 0 after viewing the default particle flow.

3. Two space warps will define the behavior of the system. Create a gravity space warp. Create panel ⇒ Space Warps: Forces ⇒ Gravity force.

4. Create a deflector. Create panel ⇒ Space Warps: Deflectors ⇒ UDeflector. Both space warps can be created to the side of the model; their position and size are irrelevant other than to make them easy to select as you are working on the particle system.

5. Select the UDeflector and in the Modify panel add the surface by clicking Pick Object under the Basic Parameters rollout: Object-Based Deflector group. (See Fig. 30.4.)


Figure 30-4. PF Source, gravity, and UDeflector.

[image: 902943c30f004.tif]


6. Select the PF Source object and in the Modify panel press Particle View to bring up the Particle View dialog. You will see the current PFSource (global event) and Event 001, which defines the particle Birth, Position Icon, Speed, Rotation, Shape, and Display. If you click on each of these under Event 001, the properties are displayed in the parameters panel to the right. 

7. Add a Force operator to Event 001. Drag the Force operator and drop it between the Rotation 001 operator and the Shape 001 operator. Select the Force operator and in the parameters panel add the Gravity force. This can be done using the Add button and then clicking on the force in the viewport or by clicking By List and selecting the Gravity force from the list.

8. Below the Force operator that was just added, drag a Collision operator. Select the Collision operator and add the UDeflector to the Deflectors list in the parameters panel. (See Fig. 30.5.)


Figure 30-5. Particle View with Collision and Force operators added to Event 001.

[image: 902943c30f005.tif]


9. Press Play; the particles will emit, drop downward, and deflect from the surface. The interaction needs refinement to make it behave more like a liquid.

10. Select the UDeflector. In the Modify panel ⇒ Basic Parameters rollout: Particle Bounce, adjust the bounce to 0.5 and increase the variation and chaos to 15%. It is also possible to increase the friction, but for now we will leave it at 0. 

11. In Particle View (6), select the Birth operator in Event 001. We will increase the range of emission for the particle system, set Emit Stop to 100, and increase the Amount to 500. If necessary, you can also select the PF Source in the viewport and adjust the size of the PF Source in the Modify panel to change the emission area of the particle system.

12. Currently, the particle system behaves like water but renders as a series of cubes. (See Fig. 30.6.) The Shape operator located in Event 001 controls the rendered form; adjust the size and form to make it 2D or 3D with a variety of geometries. 


Figure 30-6. Particle system flowing across surface.
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The Display operator controls what the particles look like in the viewport; you can adjust their appearance from ticks to circles, which can make it easier to visualize in the viewport.

13. Next, make the particle system more robust by adding a Deflector at the end of the surface so that when the particles move off the surface they are no longer part of the simulation. Create a Deflector and place it so that the particles must go through the Deflector to leave the surface.

14. Create a new Collision operator in Particle View and add it to the bottom of Event 001 (see Fig. 30.7). Drag a Delete operator onto the Event view, creating a new event. Connect the wire from Collision 002 to the top of the new event. Now, when any particles collide with the Deflector, they will be deleted. This makes the simulation more efficient because 3ds Max is not calculating a particle’s behavior after it leaves the surface. 


Figure 30-7. Collision operator attached to new event that deletes particles.
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15. It is possible now to change the rate in the Birth operator in Event 001 so that it is a constant rate rather than a finite amount. If the particles continually emit over the course of the timeline, they will now be deleted as they come in contact with the Deflector.



This simulation can work as a way to visualize how the surface reacts to a flow across it. It is possible to adjust the rate of emission, size of the emitter, gravity, or any other property to begin experimenting with the simulation. If the surface geometry is updated, the particle flow updates the simulation to flow across the new surface.





Tutorial 30.2 Flowing Water, Part II: Consistency Simulation

It is possible to force the particles to render as a mesh that more closely resembles water. This is accomplished using a BlobMesh.


1. Create panel ⇒ Geometry: Compound Objects ⇒ BlobMesh. Click anywhere in the scene to create the object; this will be a reference object and won’t be part of the scene.

2. With the BlobMesh selected, in the Modify panel Pick Blob Objects and add the PF Source. Once the PF Source is designated as the Blob Object, the size parameter in the Modify tab is no longer used—in its place, the size/geometry under the Shape operator in Particle View is used. Tension and evaluation coarseness are still applicable, however. 

3. Render to see the current state of the scene. Both the BlobMesh and the shape can be seen in the particles. Make the shape invisible and just render the blobs by selecting the Render operator and adjusting the visibility to 0%.

4. Add a water material to the BlobMesh if desired. (See Fig. 30.8.)


Figure 30-8. BlobMesh attached to particle system.

[image: 902943c30f008.tif]


5. Adjust the rate of particles in the Birth operator and the size in the Shape operator to get the water to behave in a pseudo-realistic manner. The settings at this point depend on the scale of your surface and the number of particles emitted.



This particle system can be extremely taxing on many systems, and it is necessary that you change values in the simulation incrementally. Never ask the particle system to generate millions of particles across extremely complex surfaces, as it will most likely bring the system to a crawl and eventually it will crash.

It is possible to add a Cache operator to the global event in Particle View below the Render 001 operator. This caches the particle simulation into RAM, making it play back much faster. It requires you to run the particle simulation through one time fully, and after that it should run much more quickly. If you make changes, you need to update the cache. Settings in the Parameters panel for the Cache operator allow you to specify the amount of memory used, how many frames to cache, and when to update. (see Fig. 30.9)


Figure 30-9. Rendered water flow with hair and fur to create grass.
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Blowing Leaves 

Non-event-driven systems can be used to create particle simulations as well. In this tutorial, we will use a Super Spray emitter with forces to create a blowing leaf effect.



Tutorial 30.3 Using a Particle System to Create Blowing Leaves


1. Start with a leaf mapped to a plane. In this example, we are using a 4" × 4" plane with an arch and design material. The material uses a leaf image in the Diffuse channel and is using the Alpha channel from the same image to define the Cutout channel. (See Fig. 30.10.)


Figure 30-10. Plane with leaf texture attached.
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2. Create the particle system. Create panel ⇒ Geometry: Particle Systems ⇒ Super Spray emitter. Place it approximately 30’ above the ground, pointing down.

3. Adjust the Super Spray parameters. Under the Particle Generation rollout: Particle Timing, set Emit Start to –100; this makes the particles part of the environment. You should see particles at frame 0 now. It may be necessary to set the value lower to have more leaves in the initial view. Set the Emit Stop to the final frame of the animation—in this case, frame 300. Set Display Until to 300, set Life to 400, and set Variation to 500. (See Fig. 30.11.)


Figure 30-11. Super Spray emitter.
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4. In the Basic Parameters rollout: Viewport Display, change the percentage of particles to 100% to view all of the particles.

5. Under the Basic Parameters rollout: Particle Formation, adjust the off-axis and off-plane settings to create a good distribution of leaves.

6. Under the Particle Type rollout, set Type to Instanced Geometry. (See Fig. 30.12.) Using the Pick Button under Instancing Parameters, choose the plane with the leaf image mapped to it. Under Basic Parameters, the viewport display is set to Mesh. Apply the standard material that was applied to the plane to the Super Spray.

7. In the Particle Generation rollout: Particle Size, set the Size to 6" and set Variation to 25%.


Figure 30-12. Instanced Geometry attached to particles.
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8. Under the Rotation and Collision rollout, set the Spin time to 100, with 50% variation.

9. Create Gravity. Create panel ⇒ Space Warps: Forces ⇒ Gravity force. Using Bind to Space Warp, click and drag from the Gravity to the Super Spray icon to link the force and the emitter. (See Fig. 30.13.) Select the Gravity, and in the Modify panel adjust the strength to 0.2.


Figure 30-13. Bind to Space Warp.
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10. Create wind. Create panel ⇒ Space Warps: Forces ⇒ Wind force. Bind the Wind to the Super Spray icon using Bind to Space Warp.

11. Select the Wind and in the Modify panel set strength to 0.005, change to spherical, turbulence to 0.5, frequency to 10, and scale to 0.01. Place the Wind in the area to receive the center of the effect.

12. Make adjustments as necessary to achieve the desired effect. (See Fig. 30.14.)




Figure 30-14. Rendered leaf effect.

[image: 902943c30f014.tif]





Soft Body Systems

Soft body dynamics simulate meshes in which the surfaces change over the course of the simulation. This may be the simulation of cloth, water surfaces, or other surface types that require deformation. Soft bodies are implemented as a series of points or nodes that interact with one another through weightless virtual springs. 

3ds Max simulates soft bodies through cloth simulations and the Flex modifier. Both implementations of soft-body simulations can be used to simulate a range of dynamic mesh deformations.



Tutorial 30.4 Creating Water Ripple

This tutorial simulates a water surface rippling, using a Flex modifier applied to a plane. The plane in this model sits at the base of the topography, and a sphere rolls down the slope to disrupt the water surface.


1. Set up the model space, creating topography, a plane for the water, and a sphere.

2. Animate the sphere rolling using MassFX. The sphere is a dynamic rigid body, and the topography is a static rigid body. Bake the simulation to create the animation of the sphere rolling down the hill. (See Fig. 30.15.)


Figure 30-15. Animated sphere, topography, and water plane.
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3. Create a UDeflector and attach it to the animated sphere.

4. Add a Flex modifier to the water plane. Set the Strength and Sway settings to 0.1. Under Simple Soft Bodies, set the Stretch to 4 and the Stiffness to 6.5. 

5. Add the UDeflector to the Flex modifier under Deflectors. 

6. Expand the Flex modifier and activate the Weights and Springs subobject mode. Select all of the points (Ctrl+A) and give them an absolute weight of 0.1. (See Fig. 30.16.)


Figure 30-16. Flex modifier properties.
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7. Click on the Create Simple Soft Body button. 

8. To speed up the performance of the soft body, add a Point Cache Modifier to the top of the stack. Record the simulation and then disable the Flex modifier. (See Fig. 30.17.)




Figure 30-17. Sphere interacting with water plane soft body.
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Chapter 31

Scripting

Scripting

“Scripting” refers to the process of writing instructions that control an application. Scripting languages are common in computing to control most operating system processes (command.com, AppleScript), for completing actions in Web browsers (JavaScript or PHP), or embedded forms such as ActionScript in Adobe Flash. Most modeling and animation software uses some form of scripting to extend the tool set for designers. This allows designers to develop their own tools for specific processes that may not have been envisioned by the software’s development team. 

In Autodesk Maya, the scripting language is called MEL; in McNeel Rhino, it is called RhinoScript; and in 3ds Max, the scripting language is MAXScript. MAXScript is an extremely powerful scripting language with the ability to support entire plug-ins that can extend the features of 3ds Max. While most designers are not programmers, it is important for you to understand at least some very basic ideas about how MAXScript works. At a minimum, you should be able to download another user’s scripts from sites such as ScriptSpot (www.scriptspot.com) and run the script. The more you understand about scripting, the better you will begin to understand how 3ds Max or any other piece of software is performing its operations.

Where scripting is used to extend the features of particular software, it holds many possibilities as a generative and/or rule-based design tool. There are many individuals experimenting and implementing generative scripts to produce all types of site and architectural forms and contextual responses. One of the most promising ideas around scripting in design is the possibility of suggesting solutions that come from vast numbers of iterations. Beyond creating scripts that churn through design iterations, it is also possible to set up complex rules that will then generate form or analysis that is inherently parametric. These principles work by creating operations that repeat themselves, checking for specific conditions that then trigger new actions. The looping operations are stepped and, therefore, change in a linear or exponential fashion as they iterate through the instruction set. This concept can be expanded to search through design choices and build form that is a product of the code written to model or respond to a designer’s intent. 

The topic of scripting is broad, and the purpose of this chapter is to merely introduce it as a tool. The example from Fletcher Studio shows a series of design iterations generated through scripting (see Fig. 31.1).


Figure 31-1. Fletcher Studio xAirport San Jose wetland design iterations.

[image: 902943c31f001.tif]


Accessing the Scripting Tools

The MAXScript tools can be accessed from the file menu under the MAXScript heading. From this menu, you can create a new script, open an existing script, or run a script. Selecting New Script brings up the MAXScript Editor, which can be used to create scripts (see Fig. 31.2). This functions like a text editor, with features specific to MAXScript. 


Figure 31-2. MAXScript Editor.
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The MAXScript Listener is an interactive scripting window that allows for code to be typed and evaluated immediately. (See Fig. 31.3.) This makes it possible to see exactly what a piece of code does in the viewport. Notice that a miniature version of the Listener is also available in the bottom left corner of the 3ds Max interface. If you right-click on the mini Listener, you can see the most recent commands that have been executed, as well as having quick access to the Editor and the Listener.


Figure 31-3. MAXScript Listener.
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Likewise, you can enable the MacroRecorder from the MAXScript menu or directly within the Listener. (See Fig. 31.4.) The MacroRecorder echoes the actions in the viewport as commands in the Listener, which can be useful in interpreting code or recording an action that you will repeat many times.


Figure 31-4. MacroRecorder.
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The Visual MAXScript Editor is a WYSIWYG editor for creating and laying out MAXScript rollouts and windows. It is also possible to write scripts externally in text files and then save the files with a .ms extension. 

Fundamentals

Creating objects in MAXScript works with the following paradigm:

Box Length:20 Width:20 Height:10 LengthSegments:10 WidthSegments:10 HeightSegments:5

This creates the following box at 0,0,0 based on the parameters specified in the script. It is also possible to specify the location of the box in the same line by typing:

Box Length:20 Width:20 Height:10 LengthSegments:1 WidthSegments:1 HeightSegments:1 pos:[30,0,0]

This creates the same size box at 30,0,0 with one segment in each direction (See Fig. 31.5).


Figure 31-5. Boxes created through MAXScript Listener.

[image: 902943c31f005.tif]


The object type is called a class; in this case, the class is Box. The creation parameters that we can use correspond to the class of the object. We can write the parameters in any order, separated by a space, and most of them are optional. In most cases, the creation parameters are the same as the parameters in the Create tab. 

A quick way to get help in the MAXScript Listener is to highlight a command and press the F1 key; this brings up the parameters for that command by searching the MAXScript Help for the highlighted word.

We can transform these boxes using the following code:

move $box001 [0,30,0]

This moves box001 to 0,30,0. 

The Move action is called a function, which we then tell what to act upon (the box) and how to perform the action on the object (coordinates).

Another action to try is the Copy command.

copy $box001 pos:[0,0,0]

See Fig. 31.6.


Figure 31-6. Boxes moved and copied through MAXScript Listener.
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This code does exactly what we do in the interface, except in text form. The power of scripting comes from its ability to store information in arrays and repeat actions with loops. 

A loop can be built using the following methodology: 

for i in 1 to 15 do

box length:10 width:10 height:i pos:[0,0,i^2]

This statement loops 15 times and uses the count to change i over each loop. i is then used to drive the height and Z value to make 15 boxes that get taller and are distributed upward. (See Fig. 31.7.)


Figure 31-7. for loop, creating 15 boxes.
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An array can be populated with a script similar to this:

highPolyboxes = for obj in geometry

where classOf obj == box and obj.numVertices > 8

collect obj

This script looks through the scene, finds all boxes with vertices greater than 8, and then stores those objects in an array. If there are thousands of boxes with vertices greater than 8, we are then able to access these boxes and perform operations on them with loops.

Using Scripts

To run a script, you can open the script in the editor and press Ctrl+E, which evaluates the currently open script. It is also possible to run a script directly by opening it using MAXScript ⇒ Run Script…

You can select a script in either the Listener or the Editor and drag the script onto a toolbar to create a button. This is a quick way to create a button from code that you have written or downloaded from the Web.

You can create a new toolbar on which to place scripts from Customize ⇒ Customize User Interface. Then go to the Toolbars tab, click on New . . ., and give the toolbar a name. (See Fig. 31.8.)


Figure 31-8. Create new toolbar.
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You can use this new toolbar to store scripts for a particular purpose or a set of scripts for the current project. 





Part 7

Composite





Chapter 32

Composite Imagery

Compositing

Compositing refers to the process of collaging or combining imagery from multiple sources into a single image. In the past, compositing used techniques that employed physical models, glass plates, or multiple exposures. Models would be built to extend scenes and placed within the view so that they appeared to be extensions of the physical scene or set. Glass plates would be painted in some areas and left clear in others and then filmed through, in order to merge the painted areas with the areas that were filmed through the glass. It was also possible to use multiple exposures, masking portions of the film in one take, then masking the filmed portions in another take. The two films would then be merged without double-exposing the film.

Digital compositing works with many of the same principles but greatly simplifies and diversifies the process. Compositing tools in 3ds Max allow artists to render matted images, isolate image properties and render them to separate image files or channels, and combine live action and animation. (See Fig. 32.1.)


Figure 32-1. An example of compositing using 3D model rendering and imagery combined to create a single image.
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Alpha Channel

Alpha channels are used to store matte information for an image, where a value of 0 means the pixel is transparent and a value of 1 means the pixel is opaque. In 3ds Max, we commonly save renderings to either TIFF or Targa files to store alpha channels within an image. In both image formats, the alpha channel is saved as a fourth separate channel from the Red, Green, and Blue (RGB) channels, and designates transparency using grayscale values. White represents an opaque portion of the image, and black represents a transparent portion of the image, with the grays representing a gradient of transparency from 100% to 0% opacity. 

When rendering an image in 3ds Max, the Alpha channel can be viewed in the Render Frame window by toggling the Alpha button. (See Fig. 32.2.)


Figure 32-2. Render Frame window RGB channels and Alpha channel.
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Because the Alpha channel can store a range of information in each pixel, an object’s transparency derived from the applied materials is translated into the matte. (See Fig. 32.3.)


Figure 32-3. Material transparency information stored in Alpha channel.
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When saving an image file to either the TIFF or the Targa format, it is necessary to check the Store Alpha Channel option. (See Fig. 32.4.)


Figure 32-4. Store Alpha Channel.
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Many other applications support Alpha channels, including Adobe Photoshop, where we have direct access to the Alpha information through the Channels palette. (See Fig. 32.5.)


Figure 32-5. Channels palette.
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The Alpha channel can be used as a selection by Ctrl (Cmd) clicking on the Alpha channel thumbnail in the Channel palette. This selects the pixels based on the Alpha pixel information: white pixels are 100% selected, black pixels are 0% selected, and pixels in between are partially selected. This selection can then be used as a layer mask or to cut/copy the pixels to a new layer or file. (See Fig. 32.6.)


Figure 32-6. Selected pixels and layer mask.

[image: 902943c32f006.tif]


Viewport Background

The Viewport Background can be set to display an image, which can then be used to align a perspective view. To access the Viewport Background dialog, navigate to Views ⇒ Viewport Background ⇒ Viewport Background . . . or Alt+B. (See Fig. 32.7.) From here, we can load an image, image sequence, or movie file to use as a background image. 


Figure 32-7. Viewport Background dialog.

[image: 902943c32f007.tif]


If an image sequence is used, it is possible to sync the frames of the sequence with frames in the timeline, using the Animation Synchronization settings. 

Typically, you adjust the aspect ratio to match the rendering output. This places the image in the viewport within the rendered output aspect ratio. In this example, the Viewport Background is at a 16:9 HDTV aspect ratio, which is the same as the selected final render output (see Fig. 32.8). To display properly, safe frames (Shift+F) are also enabled in the viewport to show the renderable area of the viewport.


Figure 32-8. Image for background and image applied to the viewport.

[image: 902943c32f008.tif]


The Viewport Background does not render with the scene; it only provides a reference to work within. It is possible to align the grid to the image and then create a camera that maintains the view. 3ds Max provides an advanced set of camera matching tools that are useful for matching a site model with a site photo. The camera match works by aligning points on the model in 3D space to points specified on the photograph.

Matte/Shadow/Reflection

The Matte/Shadow/Reflection material turns the object into a matte- and/or a shadow/reflection-receiving surface. (See Fig. 32.9.) The material is used in conjunction with mental ray and, when applied to objects, can be tweaked to adjust the properties of all three modes.


Figure 32-9. Matte/Shadow/Reflection material properties.

[image: 902943c32f009.tif]


As a matte, the material blocks other objects from the camera view. This can be useful in order to separate imagery without overlaying information. It can also be used to model imagery that may appear in a background photo, which then mattes or masks the rendered model. In Fig. 32.10, the ground plane and foreground columns have the Matte/Shadow/Reflection material applied; therefore, they mask the columns behind them.


Figure 32-10. Objects in foreground functioning as a matte; viewport, rendered image, and Alpha channel.

[image: 902943c32f010.tif]


As a shadow-casting material, the Matte/Shadow/Reflection material receives shadows from objects in the scene. The shadow-casting surface does not render but receives the shadow; therefore, the rendered object and its shadow can be composited with other imagery. This is useful for generating entourage elements simply by rendering a model over a plane with the Matte/Shadow/Reflection material. The result is then an object with a transparent background and a shadow attached. (See Fig. 32.11.) If a daylight system is created, the model can be rendered for different situations, and, therefore, the lighting and shadows will be specific to the rendering being created.


Figure 32-11. Object casting shadow onto plane and composited into image.

[image: 902943c32f011.tif]


Just as shadows can be cast upon a surface, it is possible to cast reflections in a similar manner. (See Fig. 32.12.)


Figure 32-12. Object casting reflection onto plane and composited into image.

[image: 902943c32f012.tif]


Render Elements

Render Elements is a feature of 3ds Max that allows you to render different parts of a scene, such as shadows, atmosphere, or alpha, as separate elements. Render Elements can be accessed from the Render Setup dialog (see Fig. 32.13). To use Render Elements, simply add the type of information that you would like to render as an element, using the Add button, and then choose a format in which to save the information. 


Figure 32-13. Render Elements dialog.

[image: 902943c32f013.tif]


Typically, you will want to use TIFF or Targa, as either of these formats has the ability to save an Alpha channel, as previously mentioned. The rendered elements will be saved as separate files that can then be used as selections or as layers in Adobe Photoshop, Adobe After Effects, and/or Autodesk Composite. (See Fig. 32.14.)


Figure 32-14. Information rendered as elements; full composite image, Diffuse layer, Alpha layer, Atmosphere layer, Shadow layer, and Z-depth layer.

[image: 902943c32f014.tif]






Chapter 33

Composite . Scene States . Batch

Often, rendering in 3ds Max requires strategies for rendering single elements that are used to create larger illustrations, analytical diagrams, or mappings. This may require rendering several passes, done one at a time by isolating objects and rendering the single image, or by using multiple camera views, batch rendering, and Scene States.

Scene States

Scene States allow us to save the current condition of the scene and then recall it to set lighting conditions, materials, object properties, or cameras. In the example shown in Fig. 33.1, we have created a terrain model and several sections using the section shape. We want to set up several Scene States to display each of the sections from a camera and with all of the other objects in the scene turned off. 


Figure 33-1. Terrain model and section cut splines with cameras viewing each.

[image: 902943c33f001.tif]




Tutorial 33.1 Managing Scene States


1. Set the view to the first section camera and hide all objects in the scene except for the first section. 

2. To access Scene States, right-click in the viewport to bring up the quad menu and choose Manage Scene States. (See Fig. 33.2.)


Figure 33-2. Manage Scene states in the quad menu.

[image: 902943c33f002.tif]


3. The Manage Scene States dialog will appear. To save the current Scene State, click Save and then choose the properties you would like to save. It is possible to filter by specific properties; for example, if we can save only lighting information or object properties. Give the Scene State a name and then click Save. This creates a restorable Scene State. 

4. To test this, turn all of the objects back on, then select the Scene State and press Restore. Select the properties to restore; all of the objects should turn off and return to the restored Scene State. 

5. Repeat the process to set up a Scene State for every camera view in the scene. (See Fig. 33.3.)




Figure 33-3. Manage Scene State and Save Scene State dialog.

[image: 902943c33f003.tif]


Scene States are a powerful way to create multiple iterations of a drawing, and they can be used beyond just turning objects off or on. States can be set for multiple times of day for a daylight system or multiple camera lenses for a specific view. Multiple material options can be rendered by using saved Scene States, as well by saving material parameters. It is important to save only the properties needed to define that state rather than saving every property. 




Batch Rendering

In Tutorial 33.1, after we create all of the Scene States, we will want to render the section line at a very high resolution to use in section perspective illustrations. This can be accomplished by restoring each Scene State and then rendering, but it requires us to manually restore each Scene State and then render the scene. 

Using Batch Render, we can set up the parameters for each rendering, including the Scene State, and then send the entire batch to render. This allows us to send the batch at the end of the workday so that we can render overnight or through any other downtime when we won’t have to monitor the rendering process.



Tutorial 33.2 Using Batch Render


1. Set up the Render settings in the Render Setup dialog.

2. Navigate to Rendering ⇒ Batch Render. Add a new render job to the batch queue by clicking the Add button. Clicking the Add button creates a new job using the current settings in Render Setup; therefore, it is best to adjust the Render settings first, especially if there are custom parameters that need to be specified. (See Fig. 33.4.)


Figure 33-4. Batch Render setup.

[image: 902943c33f004.tif]


3. For each render job, we can specify to override the preset and then specify frames or resolutions that differ from the current Render Setup settings. We must specify an output path for the files to be rendered. This is similar to setting up the file output path in Render Setup. We also have the options to specify the camera to be used, the Scene State, and a Render preset. 

4. To start the batch render, click Render.



By default, Batch Render uses the current Render settings; however, it is also possible to specify saved presets. To create a Render preset, specify the Render settings in Render Setup and then click on the Preset rollout at the bottom of the Render Setup dialog. Click on Save Preset and specify a file name; the Render settings specified are now available to use in Batch Render or at any time to go back to the saved settings. Notice that several presets already exist; these can be a good place to start when exploring the Render settings. (See Fig. 33.5.)


Figure 33-5. Render Setup dialog and saved Render presets.

[image: 902943c33f005.tif]


Batch Render in combination with Render presets and Scene States provides a powerful set of tools for rendering multiple iterations of a model and scene settings for design reviews or as components for a composite illustration.







Chapter 34

Illustrative Composite

There are several ways to use the compositing tools in 3ds Max to create compelling illustrative images. While it is possible to create the entire model and render it in 3ds Max, this process is typically extremely tedious and difficult to edit. Therefore, techniques exist to pull together many elements and composite them in an image-editing application such as Adobe Photoshop. The following examples look at three types of illustrations created with 3ds Max as a part of the representation work flow.

Model as Base for Collage1

Often, models are constructed as a way to test proportions and options rather than as the basis for an illustration. This type of modeling is important to the design process, and it is important to have strategies to use this work in later stages of the design process. This illustration starts with a simple 3ds Max model that uses Arch and Design Materials and a Daylight system to render a view. The view is used as the starting point to add collage elements in Adobe Photoshop.

The model is constructed from AutoCAD linework that is separated into objects, and then the Extrude modifier is applied to create mesh objects. Chamfered cylinders are used in other areas. The gravel ground plane is tessellated and a noise modifier is applied to give the ground a disturbed look against the straight edges of the planters. (See Fig. 34.1.)


Figure 34-1. Model and tested camera views.

[image: 902943c34f001.tif]


The objects use Arch and Design material templates, and each object has a UVW Mapping modifier to specify texture coordinates and scale if necessary. The daylight system is positioned to point north, and the location is specified for Southeastern Louisiana. (See Fig. 34.2.)


Figure 34-2. Rendered view of 3ds Max model with materials applied and daylight system.

[image: 902943c34f002.tif]


The compositing process at this point uses Adobe Photoshop in combination with the rendered and lit model to create an environmental illustration. The environment is added and a layer mask is used to add atmosphere to the image, creating contrast between plant material that is closer and farther away from the viewer. Black is used in the mask to make areas completely transparent, gray is used to make portions 50% transparent, and white is used to make portions completely opaque. This gives the illusion that the image has more depth than it normally would. (See Fig. 34.3.)


Figure 34-3. Layer mask used to mask portions of context image.

[image: 902943c34f003.tif]


Vegetation is collaged into the planting beds, and masks are used to crop portions of the vegetation. A similar method is used whereby brushes paint black areas, making the vegetation cropping edges appear in such a way that they do not look as if they have been cut with straight edges. This is accomplished with brush presets that have patterned or noisy shapes. Small amounts of gray are used to make some portions of the vegetation appear transparent, blending those areas together in the rendering. Because we use layer masks, we are able to edit the mask at any point to readjust the vegetation as the illustration progresses. (See Fig. 34.4.)


Figure 34-4. Layer masks used to crop and blend collaged vegetation over the model.

[image: 902943c34f004.tif]


Layers are created above the model layer, where we use a dark color to paint in shading. This adds variation to the surfaces and grounds the collaged elements to the model. Using a normal brush that is rounded can leave artifacts that look like circles; we can scale the vertical dimension of the brush so that it matches the perspective, making the shading easier to apply. (See Fig. 34.5.)


Figure 34-5. Scaled brush used to shade ground plane.

[image: 902943c34f005.tif]


The shading layers are designated as multiple layers by using the screening mode pulldown, and the opacity is adjusted to a very low value. This allows us to paint on the surface with a very dark color and then adjust the opacity down to 5 to 10%, making it easy to see what we are painting. After the layer is created, it is possible to come back and fine-tune once we see exactly how the shading appears at the 5 to 10% level. (See Fig. 34.6.)


Figure 34-6. Shading applied to rendering.

[image: 902943c34f006.tif]


The final touch comes from the addition of entourage and shadows. The entourage is partially transparent, and layer masks are used to crop the images. (See Fig. 34.7.)


Figure 34-7. Rendered view with entourage.

[image: 902943c34f007.tif]


Model as Framework . Human Scale

Often, modeling plays a greater role in the illustration process. In this example, the model is a large part of the illustration work flow, comprising approximately 50% of the final image. The model serves as the structure for the drawing and therefore creates a faux perspective grid that can be used to guide the placement of collage elements, shading, and other features. 

The site sits within an urban context and is broken up into the urban context (background), the site boundary and structure (middleground), and the foreground market activity. The foreground is illustrated almost exclusively with collage elements and thus is not seen in the model. (See Fig. 34.8.)


Figure 34-8. Top and camera model views.

[image: 902943c34f008.tif]


The site context is rendered as a pass, and in early stages the illustration is composed of only the building massing. This provides reference as the image is being produced, and we do not waste time by illustrating details that are unnecessary. Often, large portions of the context are blocked from view; therefore, it is not necessary to add detail in those areas. (See Fig. 34.9.)


Figure 34-9. Model context rendered.

[image: 902943c34f009.tif]


The walkway and street trees are rendered as a pass, using the walkway as a shadow-casting surface. Adjustment layers are used to lower the saturation in the context and to adjust brightness in the middleground. (See Fig. 34.10.)


Figure 34-10. Middleground layer with adjustments.

[image: 902943c34f010.tif]


The market building is rendered as a pass and placed into the illustration. Adjustment layers are used to accentuate portions of the building, including the sign. This completes the modeled portion of the illustration. (See Fig. 34.11.)


Figure 34-11. Market building and adjustments.

[image: 902943c34f011.tif]


To add the collage elements, a framework of construction lines is created and a guide is used as a reference for the horizon line. (See Fig. 34.12.) These guides are very useful as you begin to place the collage elements into the illustration—without them, it is easy to make mistakes regarding the scale of elements.


Figure 34-12. Construction lines overlaid in illustration.

[image: 902943c34f012.tif]


Using the construction lines, collage elements are added to the rendering, starting in the areas closest to the viewer and moving back into the distance. (See Fig. 34.13.) The elements farther from the camera are less saturated and slightly transparent in areas. 


Figure 34-13. Collage elements applied in foreground.

[image: 902943c34f013.tif]


The entourage is added to the view (see Fig. 34.14.), and masks are used to hide portions of the images to make individuals appear to be behind other elements. It is important to pay close attention to the relationship of the horizon line and the height of each person. If the viewer is intended to be 5 to 6' in height, then anyone standing on the same elevation as the viewer should relate to the horizon line in a similar way. This means that each person added to the scene should have his or her eyes on the horizon line if he or she is the same height as the viewer.


Figure 34-14. Entourage added to the illustration.

[image: 902943c34f014.tif]


The final step of the illustration is to add several layers of shading in a manner similar to that used for the previous perspective. This includes shading on the ground plane and throughout the collage elements to integrate all of the images into a single composite view. (See Fig. 34.15.)


Figure 34-15. Composite illustration.

[image: 902943c34f015.tif]


Model as Framework . Aerial View2

The underlying base model is created from source material generated throughout the design process. This source material may consist of models, site plans (see Fig. 34.16), sections and conceptual diagrams, and media used to develop form and design aesthetic. 


Figure 34-16. Illustrative site plan by Fletcher Studio.

[image: 902943c34f016.tif]


The site model is integrated into a contextual model of the San Francisco Bay area, using aerial photography and Google Earth data (see Fig. 34.17). The topography is modeled with a low level of detail, particularly the hills of San Francisco that will be visible on the horizon. The topography is mapped with aerial photos, and models are acquired or created to mark major landmarks such as the Golden Gate Bridge. 


Figure 34-17. View of model in 3ds Max.

[image: 902943c34f017.tif]


The model devotes most of its detail to the proposed site area. Because it is created from an aerial perspective, the vegetation is modeled using billboards, as discussed in previous chapters. This creates the placement and scale of the plant material, and the billboards can be rendered as a separate pass in order to overlay them into the illustration. (See Fig. 34.18.)


Figure 34-18. Rendered model view used as the base for illustration.

[image: 902943c34f018.tif]


To facilitate the illustration process, meshes are isolated in 3ds Max. In Fig. 34.19, the mesh representing the grass areas is isolated and rendered. The resulting image is used for its Alpha channel to create a selection that is then applied as a layer mask in Photoshop. The layer mask is applied to a layer group, and everything added under that group is cropped to the grass areas. 


Figure 34-19. Layer mask used to crop shading and texturing that is applied to the grass areas.

[image: 902943c34f019.tif]


This technique is applied to the pathways, pools, and other types of surface-level vegetation. The key is to add irregularity to the surfaces and to accent the edges of objects. The rendered trees layer is used as a guide to add collage trees, creating variety in the planting. (See Fig. 34.20.)


Figure 34-20. Trees are added over the rendered billboards to provide variation within the illustration.

[image: 902943c34f020.tif]


Atmosphere is added to the model to create a hazy cyan context and a vivid, high-contrast foreground. This is accomplished using color overlays and adjustment layers (see Fig. 34.21). The bluish tones are masked using gradient masks so that they make a smooth transition from background to foreground. (See Fig. 34.22.)


Figure 34-21. Atmosphere layers.

[image: 902943c34f021.tif]



Figure 34-22. Final Illustration.

[image: 902943c34f022.tif]


[1] Model and Illustration by Katherine Tabor, Louisiana State University Robert Reich School of Landscape Architecture Master of Landscape Architecture 2011

[2] Model and Illustration by Nenad Katic for Fletcher Studio





Chapter 35

Animated Composite

Using compositing applications such as Adobe After Effects and Autodesk Composite, you can create composites that are animated, using the same tools that you have been using for static illustrations. The latest versions of 3ds Max include Autodesk Composite, which can be used to accomplish most compositing tasks. 

Composite

Autodesk Composite is a node-based compositor that has tools for color correction, camera mapping, motion blur, and depth of field, and the ability to extend functionality through plug-ins and Python scripting. 

The composite interface works with a user interface paradigm called the gate UI, which can be accessed by pressing the ~ key or the middle mouse button. The north gate displays the schematic view, the south gate brings up options for the current view, the east gate brings up the pick list, and the west gate brings up the composition browser. (See Fig. 35.1.)


Figure 35-1. Composition interface.

[image: 902943c35f001.tif]


Autodesk Composite offers a large range of tools for designers and illustrators. This section touches on the few that can be used to create animated composites.

Composite Animation . Static Background

Similar to compositing a static image, animated layers can be composited over static layers or backgrounds. If one of the layers does not move, this typically refers to a static camera that views an animation from a stationary position. In the following example, the model is composited over a background that is placed into 3ds Max as a viewport background. 

The terrain is modeled as a close approximation, and a water surface is created; both of these surfaces are used as shadow-casting and, in the case of the water, as a shadow- and reflection-casting surface. (See Fig. 35.2.)


Figure 35-2. Model aligned with background, terrain, and water surface with Matte/Shadow/Reflection material applied.

[image: 902943c35f002.tif]




Tutorial 35.1 Compositing Animation over Static Imagery

The model of the Gateshead Millennium Bridge is animated to move from a position as a pedestrian bridge to a position that allows for boat traffic to pass beneath. The camera remains stationary in the animation. The animation is rendered as a sequence of TIFF images, with the Alpha channel stored. (See Fig. 35.3.)


Figure 35-3. Frame 0 of TIFF sequence.

[image: 902943c35f003.tif]


To combine the two sequences, we will use Autodesk Composite.


1. The first step is to create a new composition. File ⇒ New, give the composition a name, and save the composition to the desired location.

2. Notice at the bottom of the screen that the Tool UI options appear to set up for the output node that was just created when you made a new composition. (See Fig. 35.4.) We will set the composition format, frame rate, and length based on the sequence we have rendered. 


Figure 35-4. Composite composition output node settings.

[image: 902943c35f004.tif]


3. Next, import sequence footage. File ⇒ Import, and browse to the location of the footage. Notice that the sequence shows up as single files. Import the background image and the TIFF image sequence; this creates two new nodes in the window with the previously created output node. (See Fig. 35.5.)


Figure 35-5. Footage nodes.

[image: 902943c35f005.tif]


4. Right-click in the viewport containing the nodes, and select Add from Pick List ⇒ Compositing ⇒ Blend & Comp. This adds a Blend & Comp node to the viewport. Click and drag from the right edge of the Background image node to the back input of the Blend & Comp node. Drag from the right edge of the rendered TIFF image sequence node to the front input of the Blend & Comp node. (See Fig. 35.6.)


Figure 35-6. Imported footage connected to front and back inputs of the Blend & Comp node.

[image: 902943c35f006.tif]


5. Connect the output of the Blend & Comp node to the input of the Output node. This will use the Blend & Comp node to composite the two layers and then output them as a single new image. Right-click in the player window and choose Display ⇒ Composition Output. Press the Play button to see the composited animation play in the player window. (See Fig. 35.7.) If necessary, adjust the time by inputting the start and end frame in the timeline area.


Figure 35-7. Blend & Comp connected to output and displayed in the player window.

[image: 902943c35f007.tif]


6. To render the sequence, select the output node and click on the Render tab in the Tools UI. Choose a file name and output path for the rendered composite sequence. Choose a file format; this renders a new composited image sequence. Go to File ⇒ Render and press the Start button. (See Fig. 35.8.)

7. You can now reassemble this sequence in the RAM player in 3ds Max to create a movie file.




Figure 35-8. Rendered sequence.

[image: 902943c35f008.tif]





Composite Animation

When compositing animation, it is conceivable that you could render multiple sequences from a single animated camera and composite them together. This creates the equivalent of an animated Adobe Photoshop file, where each layer is an image sequence. These layers are referred to as render passes and can be set up in Render Elements, as discussed previously, or by isolating objects for each render. The advantage of this is that each layer is rendered separately, often taking the burden off the computer rendering the composite, as it renders smaller amounts of objects or polygons per pass.



Tutorial 35.2 Compositing Multiple Animation Passes

The following example uses a background terrain, a middleground structure, and a foreground teapot that weaves through the middleground. (See Fig. 35.9.)


Figure 35-9. Image sequence layers.

[image: 902943c35f009.tif]



1. The teapot is rendered with the structure in place while it has a Matte/Shadow/Reflection material applied to allow the posts to be masked and for shadows and reflections to be rendered onto the surfaces. (See Fig. 35.10.) 


Figure 35-10. The middleground and teapot rendered together with Matte/Shadow/Reflection material applied to structure and water planes.

[image: 902943c35f010.tif]


2. In Composite, the node relationship is set up in a manner similar to that in the static imagery example; however, there are two Blend & Comp nodes feeding into an Output node. The terrain and background are in the first node, and the teapot is in the second node. (See Fig. 35.11.)




Figure 35-11. Composite nodes for animated sequence.
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